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Xcelsius 2008 Versions
Available

1



This user guide is applicable for all versions of Xcelsius 2008. The following
versions are available:

• Xcelsius Present
• Xcelsius Engage
• Xcelsius Engage Server
• BusinessObjects Xcelsius Enterprise

Xcelsius Present is the entry level product version. It is intended for users
who wish to create visualizations with Excel data only. Xcelsius Present does
not offer connectivity to external data sources. This version has a robust
suite of the most commonly used components. It also features the most
commonly used visualization export options.

Xcelsius Engage has all of the features of Xcelsius Present. It offers additional
components as well as additional visualization export options. It is intended
for users who need to connect to an external data source.

Xcelsius Engage Server provides all of the features of Xcelsius Engage. In
addition, it offers integration capabilities with web portals and Reporting
Services. Xcelsius Engage Server is bundled with Flynet Web Services
Generator. It is intended for users who wish to create visualizations that are
deployed in a portal environment.

BusinessObjects Xcelsius Enterprise provides all of the features of Xcelsius
Engage. In addition, it offers integration capabilites with web portals and
Reporting Services. BusinessObjects Xcelsius Enterprise integrates with the
BusinessObjects platform, including Query as a Web Service (QaaWS),
LiveOffice, and Crystal Reports. It is intended for users who wish to create
visualizations that are deployed in a BusinessObjects Enterprise environment.
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What is Xcelsius 2008?

Xcelsius 2008 is a leading-edge Microsoft Windows application that brings
data to life!

Using breakthrough technology, Xcelsius 2008 bridges the gap between
data analysis and visual presentation, empowering users of all proficiencies
to create visually stunning interactive reports and applications.

With Xcelsius 2008, users can communicate data in a clear and powerful
style that's appealing to the mind and to the eye.

Xcelsius 2008 is intuitive enough for beginners and versatile enough for
advanced users. Most importantly, it makes the process of generating reports
and applications fun, without requiring users to learn arcane programming
languages. With Xcelsius 2008, simply pointing and clicking your mouse can
create rich interactive presentations. Your only limitation is your imagination.

Xcelsius 2008 offers tight integration with Microsoft Corporation's ubiquitous
Office products. This tight integration lets you attach your reports to Microsoft
Outlook e-mail messages or embed them into PowerPoint slides using just
a single mouse click!

The Technologies That Drive Xcelsius 2008

Xcelsius 2008 combines two of the most widely used software applications
in the world:
• Microsoft Excel
• Adobe Flash Player

Microsoft Excel is one of the most popular software programs today. It is a
member of the Microsoft Office family of products and is used daily by millions
of people around the world to create reports.

Adobe Flash Player is widely used to view applications developed in Adobe
Flash. According to Adobe, there are roughly 516 million computers with the
Flash Player (as of March 2003).

With these figures, it is almost a certainty that your personal computers – at
home and at the office – already have Microsoft Excel and Adobe Flash
Player installed. The synergy derived by integrating these two widely deployed
applications allows Xcelsius 2008 to leverage years of sophisticated
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programming and proven IT and business technologies. The result is a
winning combination that raises the standard in terms of power and usability.

What Skills Does a User Need?

Xcelsius 2008 is uniquely designed to be easy and enjoyable to use. Since
its underlying technology is Microsoft Excel, the only skills a user needs to
create striking visual effects in their reports is a basic understanding of how
Excel works. No additional training is required!
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What's New in Xcelsius
2008

3



Embedded Spreadsheet

Xcelsius 2008 now provides an embedded spreadsheet which is a fully
functional Excel workbook incorporated into Xcelsius 2008. The Embedded
spreadsheet allows you to create, edit, and manipulate model data directly
in your Xcelsius 2008 file, without the need to import or re-import Excel
spreadsheets.

New Components

Xcelsius 2008 now provides the following new components:

• Tree Maps

Tree Maps are visualizations that display hierarchical data in a small area.
In Xcelsius 2008, Tree Maps have two parameters: size and color intensity.

• Reset Button

The Reset Button allows the end user to revert to the visualization's
original settings after changing data at runtime.

• New Maps

Additional maps have been added that cover Europe and Asia-Pacific
countries. A new map of the US that includes Alaska and Hawaii has also
been added.

• Print Button

The Print Button allows a user to print the SWF file directly from the
browser.
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Xcelsius Engage new components

In addition to the components available in Xcelsius 2008, Xcelsius Engage
provides the following components in all versions:

• Panel Container

A Panel Container acts as a smaller canvas within the main canvas and
holds one or more components. Components in the Panel Container can
be moved, added, changed, or deleted. Panels can be placed anywhere
on the canvas.

• Tab Set

Tab Set is similar to Panel Containers. The Tab Set acts as a smaller
canvas within the main canvas. A Tab Set contains multiple tab views;
each can be displayed on the canvas by clicking its corresponding tab.

• Trend Analyzer

The Trend Analyzer combines data analysis and visualization. The
component analyzes the data selection and provides an additional data
series that can be plotted to display a trend line.

• History
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The History component tracks and displays the history of changes in a
selected cell. This allows you to easily see the effect of changes in
worksheet data.

• Connection Refresh Button

The Connection Refresh Button is linked to one or more data connections
that retrieve data from an external source. Adding the Connection Refresh
Button to your visualization allows users to refresh the data on demand.

• Reporting Services Button

The Reporting Services Button component enables you to connect to the
Xcelsius Reporting Services (XRS) server and select the report that will
be used to populate the visualization. The XRS server is a web service
that allows Xcelsius to communicate with your SQL Server Reporting
Services (SSRS) server. Use of XRS requires an installation on your web
server. Please refer to the XRS documentation included on the CD for
more information.

• Source Data

The Source Data component indexes the selected source data range.
This component does not have a visual display; it works within the
visualization in combination with other components.

New Features

Xcelsius 2008 now provides the following new features:

• Alerts for selectors
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Alerts can now be added to the following selector components: Label
Based Menu, Combo Box, List Box, List Builder, and Ticker.

• Insert Filtered Rows

A selector component can be bound to a Source Data range of multiple
rows with duplicate labels; when a label is selected, the component will
filter the range to insert only the rows corresponding to that label.

• Dynamic Selected Item

In list-based selectors, the labels can be changed dynamically through
another component in the model.

• Trigger Key

Trigger keys are bound to variable cells and are set to fire when the cell
value matches a target value. Trigger keys are used to trigger data
connections and are also available in the URL Button and Connection
Refresh Button.

• Dual Axis Charts

Xcelsius 2008 now has the ability to plot series data on both a primary
and a secondary axis. This is available for the following charts: Line, Bar,
Stacked Bar, Column, Stacked Column, Area, Stacked Area, and
Combination Chart.

• Add-on Manager

This feature allows you to install or remove add-ons from within the
Xcelsius application.

• Export to Acrobat 9

Visualizations can now be exported to Acrobat 9.

• Export to Adobe AIR

Visualizations can now be exported to Adobe AIR.

New Functions

Xcelsius 2008 now provides the following new functions:

• Copy/paste components across XLF files
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Once you have set up a component in an XLF, you can reuse the
component by copying and pasting it into other XLFs. The component
will attempt to retain the same binding references and appearance.

• Printing

Visualizations can now be printed during Preview mode or from the
exported SWF.

New Functions in Xcelsius Engage versions:

In addition to the functions in Xcelsius 2008, Xcelsius Engage provides the
following functions:

• Data Manager

External connections are now managed in a central location. The Data
Manager is used to configure and manage all external data connections.

• LiveCycle Data Services connections

LiveCycle Data Services provides up-to-second views of your business
data via dashboards connected to Adobe LiveCycle Data Services,
streaming real-time data into interactive visualizations.

• External Interface Connection

Data from the SWF file can now be passed into or out of a specific cell
range, using push/pull technology.

• Crystal Reports integration

Xcelsius 2008 visualizations that are embedded in Crystal Reports can
be configured to read data from the hosting Crystal Report and dynamically
update when the Crystal Report data changes.

Appearance
• Components Browser

28 Xcelsius 2008 User Guide

What's New in Xcelsius 20083 Importing a Crystal Xcelsius 4.5 file into Xcelsius 2008



The Components Browser look and feel has been significantly changed
from previous versions.

• Interface

The Components Browser displays the components in a sliding
accordion menu. Components can be displayed in Category, Tree, or
List view.

• Favorites

Frequently used components can be added to the Favorites category
in the Category view.

• Object Browser
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• Lock/Unlock

Components can be locked in the object browser to prevent them from
being selected or changed while the visualization is being designed.

• Move forward/back

Components can easily be moved forward or backward in layers of
the visualization by dragging the component or group towards the top
or bottom of the Object Browser, or by selecting selecting a component
or group and clicking the directional arrows at the bottom of the Object
Browser.

• Group/Ungroup

Grouped components appear as subsets in the Object Browser.
Components can be added to or removed from a group in the Object
Browser.

• Hide/Show

Individual components and groups can be hidden or shown by clicking
on the dot or checkmark located in the column under the Hide icon.
All components on the canvas can be hidden/shown by clicking on
the Hide icon.

• Docking

The Components, Object, and Properties Browsers can be moved by
clicking on a browser's title bar and dragging it to dockable areas on the
canvas. Mouse over an arrow (displayed while a browser is being dragged)
and Xcelsius 2008 will highlight the corresponding docking location.
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• Auto-hiding

To increase screen space for the canvas, the Components, Objects, and
Properties Browsers can be minimized to the margins of the display. A
display tab is shown for minimized browsers; hovering over the tab
displays the browser window.

The images below show the Object Browser minimized (top image) and
displayed on mouse over (bottom image).
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• Quick Views
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Xcelsius 2008 includes pre-configured workspace configurations. In
addition, your customized workspace is automatically saved as My
Workspace when Xcelsius 2008 closes. You can select a different
workspace view from the Quick Views menu.

Importing a Crystal Xcelsius 4.5 file into
Xcelsius 2008

Xcelsius supports the ability to import a visualization created with Xcelsius
4.5. This import ability lets Xcelsius 4.5 customers upgrade their existing
visualizations to take advantage of the new features of Xcelsius 2008. Backup
your current XLF, JPEG, and external SWF files before upgrading your
visualization.

Note: Xcelsius 3.0, 3.5, and 4.0 files cannot be imported into Xcelsius 2008.
To use these files in Xcelsius 2008 you must first import them into Xcelsius
4.5, then import the files into Xcelsius 2008.

To import your existing visualizations, start Xcelsius 2008 and select File >
Open. Select the XLF that you would like to import and click Open. Xcelsius
2008 will detect that the XLF is an older visualization and warn you that it is
going to import the visualization into Xcelsius 2008, and that this may result
in certain features not functioning.

Note: After you import and save your visualization with Xcelsius 2008, the
visualization cannot be opened using an earlier version of Xcelsius.

Xcelsius 2008 minimizes the impact of migrating visualizations from Xcelsius
4.5. However, it is possible that some of your visualizations, or more
specifically, some components, will look slightly different from the original
file.

The following are some of the most frequently encountered changes:

• The size of some components is different. In most cases the size
difference is a matter of a few pixels.
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• Due to art improvements, some custom colors appear to be slightly
different.

• The Spreadsheet Table component differs in size and formatting.

In the event of formatting differences in your components, bring up the
Properties panel for the component and re-bind any properties that are tied
to the cells in the spreadsheet.
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Getting to Know Xcelsius
2008

4



Overview
This section provides an introduction to Xcelsius 2008, the components of
the program, and the functionality of the program.

Understanding the Xcelsius 2008 system
Xcelsius 2008 visualizations conform to SWF file format. SWF is the
vector-based graphics format designed to run in the Adobe Flash Player.
Because a SWF file is vector-based, its graphics are scalable and play back
smoothly on any screen size and across multiple platforms. Also, a
vector-based file usually has a smaller file size than other animations.

Xcelsius 2008 files are stored in a zipped format with an XLF extension. The
XLF file format contains the Xcelsius 2008 visualization information and its
associated embedded spreadsheet file.

Note: Xcelsius 2008 requires Flash version 9 or later. Newer Flash versions
have security features which may prevent your Xcelsius 2008 visualization
from connecting with an external data source. Without a policy file, SWF files
from one domain cannot access data on another domain or sub-domain. In
addition, SWF files served over HTTP cannot access data at an HTTPS
location. Please refer to the online article from Adobe regarding security
restrictions for data loading for information on creating a policy file to allow
access to data in the cases above.

HowXcelsius 2008 differs from traditional reporting
applications

Xcelsius 2008 complements all types of Portal initiatives, Business
Intelligence programs, Executive Dashboards, Balanced Scorecard projects,
Marketing Reports, and day-to-day reporting and presentation requirements.
Xcelsius 2008 does this by letting end users participate in the report creation
process and analysis.
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How Xcelsius 2008 works

There are three steps to create an Xcelsius 2008 visualization:

1. Add data to the spreadsheet.

2. Build the visualization.

3. Publish the visualization.

For detailed instructions on creating visualizations, seeCreating and Updating
Xcelsius 2008 Visualizations on page 69.

How visualizations look

Visualizations created with Xcelsius can have any type of standard or
personalized look. Visualizations are also fully compatible with Microsoft
Power Point, HTML, and Portals.

Xcelsius visualizations conform to SWF file format. SWF is the vector-based
graphics format designed to run in the Flash Player. Because a SWF file is
vector-based, its graphics are scalable and play back smoothly on any screen
size and across multiple platforms.Also, a vector-based file usually has a
smaller file size than a bitmap animation.

Visualizations created with Xcelsius are dynamic. What-if scenarios let users
adjust conditions on the visualization and view the results. Interactive
components let users alter the visualization conditions.

The following examples show visualizations created with Xcelsius.

Example 1: What-if presentation using alerts

This visualization shows the return-on-equity (ROE) for a financial institution
against its peer group performance. The alert colors are triggered, comparing
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the selected bank against the peer group average.

Example 2: What-if presentation using a calculator

The following visualization was created to calculate the monthly payment for
a home loan. Users can adjust the input values by moving the sliders. The
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calculator dynamically changes and displays the new values.

Example 3: Historical data comparison presentation

The following visualization is a dynamic financial statement report. It shows
the traditional Statements of Income. When a user clicks on an account, the
visualization shows the historical data organized by region or as a comparison
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against competitors.

Understanding the Xcelsius 2008 tools
Before you begin using Xcelsius, take a moment to familiarize yourself with
the interface by reading the following section. In this section you will learn
about Xcelsius elements, browsers, tools, and other options.

Note: To view a browser, select the browser from the View menu. In the
View menu, a check mark next to the browser name indicates that the browser
window is open; if you cannot see the browser in your workspace, it may be
minimized at the perimeter of the Xcelsius window.

Using the Components Browser

The Components Browser shows the available components that can be
added to your model.

40 Xcelsius 2008 User Guide

Getting to Know Xcelsius 20084 Understanding the Xcelsius 2008 tools



The window contains three views:

• Category View
• Tree View
• List View

Category View

The components are grouped in a sliding accordion menu according to their
functionality.

You can navigate to a component in the Category view of the Components
Browser by clicking on a category title or dragging the scrollbar until you
reach the desired category.
• Favorites
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• Charts

• Containers (available only in Xcelsius Engage 2008)

• Selectors

• Single-Value

• Maps

• Text

• Other

• Art & Backgrounds

• Web Connectivity

Note: To add a component to Favorites, navigate to the component in the
Category view, right-click on its icon and select Add To Favorites. To delete
the component, right-click the icon in the Favorites category and select
Remove From Favorites.

List View

In the List View, the components are organized alphabetically.

To navigate in the List View, click anywhere within the window, then type
the first letter of the component you wish to open, or drag the scrollbar until
you reach the desired component.
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Note: The List view does not contain the Favorites category. Favorites can
only be viewed or added in Category and Tree views.

Tree View

In Tree View the components are organized in folders according to their
category.

Note: To add a component to Favorites, navigate to the component in the
Tree view, right-click on its icon and select Add To Favorites. To delete the
component, right-click the icon in the Favorites category and select Remove
From Favorites.

Using the Canvas

The canvas area is the white work area where you place components to
create a visualization.

The canvas color can be customized using its Properties panel. If the
Properties panel is not open, double click anywhere on the canvas to open
the panel.

Placing components on the canvas using drag and drop

1. On the Components Browser, click a component.
2. Holding down the left mouse button, drag the component onto the canvas.
3. Release the mouse button.
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The component is dropped on the canvas at the location of the mouse
pointer.

4. Repeat this procedure for each component.

Placing components on the canvas using point and click

1. On the Components Browser click a component.
2. Click the canvas area.

The component is dropped on the canvas at the location of the mouse
pointer.

3. Repeat this procedure for each component.

Fitting the canvas to components

After you complete your visualization, you may want to adjust its final size
to eliminate any surrounding white area.

To do this, use the Fit Canvas to Components button on the tool bar.
Your visualization size will be adjusted to the minimum size according to the
components placed on the canvas.

In addition, you can use the Increase Canvas and Decrease Canvas
buttons on the toolbar to shrink or grow the canvas in small increments.

Fitting the canvas to the window

To resize the canvas so that it fills the workspace, click Fit Canvas to
Window on the toolbar.

Changing the canvas size

You can change the canvas size before you start creating a visualization by
clicking Document Properties on the File menu. The Document Properties
dialog box appears.
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You can modify the preset size to some standard sizes, or you can create
your own size. The ideal size of your visualization depends on the quantity
of components that you plan to use.

If you are building a simple visualization that contains a chart and slider, the
size can be around 640x840. Use the full size screen for dashboards or
one-page visualizations that contain several charts and selectors.

In the description field, you can write a brief description of your visualization,
the author, the date, and its intended functionality. This information will appear
to all other designers when they use your XLF file or when you save your
visualization as a template.

Using the Grid Tool

The Grid command on the Preferences menu provides a layout tool that can
aid in positioning components on the canvas. Select File > Preferences >
Grid to open the Grid Tool.
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The following options for customizing the grid are available:

• Show Grid. This option controls the visibility of the grid.

• Snap to Grid. This option aligns the selected components to the grid lines.

• Height. This option sets the vertical spacing intervals for the grid in pixels.

• Width. This option sets the horizontal spacing intervals for the grid in
pixels.

Using the Canvas Properties Panel

Type

Click the drop-down menu to select a canvas type:
• Solid Color

• Gradient (default)

• Image

• None

Note: Canvas Appearance Type “None” creates a transparent background
with used in conjunction with the “wmode” Flash Object parameter in
HTML code.

Background Color

Click the adjacent cell selector button to customize the color of the canvas
background.

Note: This setting is only available if Gradient is the selected Type.
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Background Color 1 and 2

Click the adjacent cell selector button to customize the first and second color
to be used in the canvas background. Color 1 will be displayed at the top of
the canvas and fades downward into Color 2. Color 2 will be displayed at
the bottom of the canvas and fades upward into Color 1.

Note: These settings are only available if Gradient is the selected Type.

Import Button

Click the Import Button to launch the Open file dialog box. Navigate to the
JPEG or SWF file to be used as the canvas background.

Note: This setting is only available if Image is the selected Type.

Using the Properties panel

The component Properties panel contains the setting and format options for
the selected component. After you place a component on the canvas area,
you can access the Properties panel by double-clicking the selected
component, right-clicking on the component, or selecting the component and
typingALT+ENTER. In general, the Properties panel has the same structure
for all components, but the options available are specific to each individual
component.

The Properties panel may have the following tabs:

• General
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The General tab contains the required settings for the selected component.
At a minimum, it contains an area for the title or label(s), and an area to
select the Data Source or enter the values that will be displayed.

• Drill Down

The Drill Down tab ontains a series of parameters for adding drill-down
capability for charts. For information on the Drill Down tab, see Drill Down
tab on page 264.

Note: This tab applies only to Chart components.

• Behavior

The Behavior tab contains settings related to the way the component will
work in the visualization. Typically, it contains areas for defining the
functions related to limits, interactivity, and dynamic visibility. SeeDynamic
Visibility functionality on page 148 for more information.

• Appearance

The Appearance tab contains a series of settings areas, and in some
cases sub-tabs, that let you modify the appearance and formatting of
components. On this tab you will find options like font size, title location,
and colors.

• Alerts
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The Alerts tab contains all the parameters available for using alerts. On
this tab, you can define the number of alert colors, the colors used, and
the target limits. See Alerts on page 154 for more information.

Properties for multiple selections

By selecting multiple components on the canvas, you can simultaneously
edit Properties for the components in your selection. To access Properties
for multiple components select your components and double click the
selection. You can also access the Properties by right-clicking the selection
and selecting Properties from the context menu.

If the components are of the same type, you will be able to edit Properties
specific to that component type. For example, if your current selection
contains three Line Chart components, you will be able to access the
Properties specific to the Line Chart. Any change made to the Properties will
apply to all components in the selection. The Properties panel selections
with components of mixed types or groups are limited to the Dynamic Visibility
parameters of the Behavior tab. When a number of components are grouped,
the Properties for individual components within that group may be accessed
by right-clicking on that sub-group component in the Object Browser window.
See Using the Object Browser on page 49 for more information.

Using the Object Browser

In the Object Browser, you can select, hide, show, cut, copy, paste, delete,
bring forward, move back, group, ungroup, lock, unlock, and access
Properties panels of components.
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The Object Browser can be docked in locations around the workspace or
minimized as needed. If you have closed the Object Browser, click Object
Browser on the View menu to re-open it.

Using the context menu

Display a context menu by right-clicking on any component in the browser
or on the canvas.

The context menu provides access to many of the functions that are available
in the Object Browser.

Selecting components

To select a component in the Object Browser, click the component name or
icon to make it the active component on the canvas.

To select multiple components, click a component name or icon, and then
hold down the CTRL key while you click additional components. To select
a range of components, hold down the SHIFT key while selecting the range
in the Object Browser, or click on the canvas and drag the cursor over a
group of components.

Combine methods by selecting a group of components first with SHIFT+click
and then other separate components usingCTRL+click. Always select using
SHIFT+click first; this will not work in reverse.

Select all components by selecting any component, then pressing CTRL+A.

Note: On the canvas, you cannot select components that are marked as
hidden or locked. Those components can only be selected in the Object
Browser.
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Grouping components

Objects in the Object Browser can be grouped in the following ways:

• Select several components, then right-click on any of the components
and select Group from the context menu.

• Select several components, then click n the toolbar.

Once grouped, the components will appear in the browser in tree form with
a folder representing the group. Expand the group folder by clicking the +
button or double-clicking the folder icon or the group label. Components can
be dragged into and out of the group by dragging them to a different location
in the browser tree.

To ungroup selected components, click on the toolbar or right-click on
the group to access the context menu, then select Ungroup.

Hiding components

To hide a component in the Object Browser, click the dot in the column under
the hide icon .

To hide a group, click the dot in the hide column for the group.

To hide all components, click the hide icon.

To show a hidden component or group, click the check mark under the hide
icon. To show all hidden components and groups, click the hide icon twice.

Locking Components

Components and groups can be locked on the canvas to prevent any
interaction with them. This can be helpful when there are many components
laid out on the canvas. The component or group will only be selectable in
the Object Browser.

To lock a component or group, click the dot under the lock icon . To
unlock a group or component, click the check mark under the lock icon. All
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components and groups can be locked by clicking the lock icon once, and
all unlocked by clicking twice.

Deleting components

Delete any selected components by pressing DELETE or selecting Delete
from the right-click context menu.

Tip: You do not need to ungroup components to delete components that
are in the group.

Deleting a component can be undone pressing CTRL+Z or clicking Undo
on the Edit menu.

Opening Properties panels

Properties panels for components, either alone or in a group, are opened
using one of the following methods:

• Click the icon or label.

Note: Slowly double-clicking the label will enable the Rename function
instead of Properties.

• Select the component and press ALT+ENTER.

• Right-click the component and click Properties.

Properties panels for a group are opened separately from the Properties
panels of individual components within the group:

• Right-click the group label or icon and click Properties.

• Select the group and press ALT+ENTER.

Note: Do not double-click a group to open its Properties panel; unlike
individual components, double clicking on a group entry expands or collapses
that group within the tree.

Once the Properties panel is opened for one component you can navigate
to the Properties panel of another component or group by clicking on the
entry in the Object Browser.
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Renaming components

Each component is assigned a default browsing name when placed on the
canvas. This is the name that appears in the title bar of the Properties panel
and in the entry in the Object Browser.

You can override these default names to enter your own. Double-click slowly
on the component name in the Object Browser to enable label edit mode.
Type in a name and press ENTER or click on another component.

Using the Embedded Spreadsheet

The Xcelsius 2008 workspace incorporates an embedded spreadsheet. This
fully functional spreadsheet is displayed below the canvas and contains the
source data for your visualizations. You can add, modify, and delete your
data directly within the spreadsheet without having to import or re-import an
Excel spreadsheet.

There are several ways to bring data into the embedded spreadsheet:

• Import a spreadsheet from Excel. See: Importing Excel spreadsheets
on page 56 .

• Copy/paste data from an Excel or Xcelsius 2008 file.
• Manually enter the data into the embedded spreadsheet.

You can bind cells in your embedded spreadsheet to components on your
canvas.
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Note: If you import a spreadsheet after linking to cells, the imported data
will overwrite all data in the current embedded spreadsheet. The cell binding
locations will remain the same, but the data may be changed.

You can also copy and paste cells between Xcelsius 2008 and Excel. Excel
values and formulas can be copied into Xcelsius 2008, but conditional
formatting of cells will not be retained.

Note: Xcelsius 2008 opens an instance of Excel that runs in the background.
Although you can open a second instance of Excel, you will not be able to
copy formulas between the instances. If you need to use Excel and Xcelsius
2008 files simultaneously, first open Xcelsius 2008, then open your Excel
files by navigating to them using Windows Explorer and double-clicking on
them.

If you need to keep synced Excel and Xcelsius 2008 files, we recommend
making your updates in the Xcelsius 2008 embedded spreadsheet and then
exporting the data to an Excel spreadsheet.

Note: Xcelsius 2008 imports Excel files by copying the spreadsheet data
and inserting the data into the Xcelsius 2008 embedded spreadsheet. After
the data has been imported, it is no longer linked to the original Excel
spreadsheet. Any changes you make to the source file will not appear in the
Embedded Spreadsheet, nor will any changes to the Xcelsius 2008 file appear
in the original Excel file.

The embedded spreadsheet is a fully functioning Excel spreadsheet, complete
with toolbars used in Excel.

If you are using Excel 2003, you will be able to see your default toolbars.
Toolbar buttons not related to working with the data have been disabled
(Save, Open, Print, etc.). These disabled buttons are functions that are
handled by Xcelsius. If you wish to Save the spreadsheet, use Xcelsius's
File > Save function, or export the spreadsheet back to Excel. See Importing
Excel spreadsheets on page 56 for more information.

If you are using Excel 2007, you will be able to see the ribbon displayed at
the top of the program. In addition to the disabled buttons, the drop down
menus are disabled in the ribbon.

For both versions of Excel, you can add Excel functionality to the toolbar by
right-clicking on any toolbar and adding the toolbar with the desired
function(s).
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Embedded Spreadsheet

Although the embedded spreadsheet is a fully functioning Excel spreadsheet,
not all Excel functions are supported. Xcelsius 2008 does not support macros,
conditional formatting, or all available formula functions. For a full list of
supported formula functions, see Supported Excel Functions on page 387.

Xcelsius 2008 does support the moving of bound data ranges. For instance,
if your chart source data range needs to be moved down a row to fit in the
title, simply select the range and move it to its new location. Xcelsius 2008
will retain the new information and reference the new range. However, if only
part of the range is moved the bound cell reference will remain the same.
You will need to open the component's Properties panel and re-bind the cell
reference to the new location if only part of the range is moved and you want
the new location referenced.

Note: The component's Properties panel will note reflect the updated range
as the listed cell reference if a range is moved, expanded by inserting cells,
or decreased by deleting cells. The new range is still bound and recognized
by Xcelsius 2008.

The embedded spreadsheet allows you to change the sort order of your data.
However, this action is not read as an event by Excel, and as such does not
prompt Xcelsius to update. You will not see any component bound to the
sorted data update with the new data order. The new sort will be reflected
in Preview mode or the exported visualization. An update can also be forced
by rebinding the range in the component.

Importing and Exporting data

Xcelsius 2008 uses an embedded Excel based spreadsheet as its data
source. This provides the ability to copy and paste data between the Xcelsius
2008 embedded spreadsheet and an Excel spreadsheet. Source data can
be created either in the embedded Xcelsius 2008 spreadsheet directly or in
Excel and brought into Xcelsius 2008 . Smaller pieces of data can be
copy/pasted or whole files can be imported.

Because Xcelsius 2008 files incorporate Excel data, spreadsheet data can
easily be imported from Excel into Xcelsius 2008 or exported from Xcelsius
2008 to Excel.

Xcelsius 2008 User Guide 55

4Getting to Know Xcelsius 2008
Understanding the Xcelsius 2008 tools



Importing Excel spreadsheets
To use an existing Excel spreadsheet as the source data for your
visualization, select Data > Import or use the Import Model button on
the toolbar to import the file.

Note: When the Excel file is imported the data is copied and is no longer
connected to the original data. Editing the original source file will not change
the data imported into Xcelsius.

WARNING: Importing an Excel spreadsheet will overwrite any data that is
currently in the spreadsheet.

Exporting data to Excel
Select Data > Export to export the embedded spreadsheet data as an Excel
file.

Using the Format menu

The Format menu provides various options for formatting the placement and
layout of the components in the visualization.

Access to the Themes and Color Schemes dialog boxes is provided under
the Format menu.

Note: These options are also available on the Format and Themes Toolbars.

Align

With the Align options, you can align the boundaries of components or groups
of components relative to the first component in the selection. Align functions
require the selection of at least two components.

The following Align options are available:
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• Left

• Center

• Right

• Top

• Middle

• Bottom

Make Same Size

With the Make Same Size options, you can make the selected components
the same width , height , or size relative to the first component in
the selection.

Space Evenly

With the Space Evenly options, you can distribute a selection of components
either horizontally (Across) or vertically (Down) so that there are even spaces
between them.

Note: To use the Space Evenly options, you must have more than one
component selected.

Center in Canvas

With the Center in Canvas options, you can center selected components on
the canvas. You can center them vertically, horizontally, or both.

Other commands on the Format menu

The following commands are also available on the Format menu:
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• Bring to Front. Brings component to the topmost layer.

• Send to Back. Sends component to the bottom layer.

• Bring Forward. Brings component forward one layer.

• Send Back. Sends component back one layer.

• Group. Groups selected components as a single item.
• Ungroup. Ungroups a group of components.

Understanding fonts in Xcelsius 2008

The following options are available for displaying fonts in Xcelsius 2008:
• Device Fonts

By default, Xcelsius 2008 uses this option for components within a
visualization. This option is recommended when creating models that
require the extended character set as defined by Unicode. The Device
Fonts option uses the SWF player to directly render the TrueType Font
you select.

Device Fonts also let you use different fonts for different components in
the same visualization. However, depending on the TrueType Fonts
installed on the end user's machine, the fonts in the visualization may not
display properly.

• Embedded Fonts

This option generates the characters from the TrueType Font you select,
and embeds them into the SWF file. Because the font is embedded in
the SWF file, the font displays properly regardless of whether the user
has the TrueType Font installed. However, this option increases the file
size and the time required to load the visualization.

Note: Asian character sets are not supported with Embedded Fonts due
to the large number of characters they require. You must use
Non-Embedded Fonts for situations where you require Asian characters.
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To change the font for a visualization

1. On the File menu, click Document Properties.

The Document Properties dialog box appears.

2. If you want to use one embedded font for all components in the
visualization:
a. On the Font list, click the font that you want.
b. Click OK.

3. If you want to use a different font for each component in the visualization,
or you want to use non-embedded fonts:
a. Click Use Device Fonts.
b. Click OK.

You can now use the Font Settings on the Component Properties panel
to change the font used for that component.
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Using Themes

Themes (formerly Skins) allow you to globally change the appearance of
components. Each theme has a number of different components that you
can use to maintain the look and feel of that particular theme. Combined with
Color Schemes, you can use Themes to create a multitude of different looks
for your visualizations.

Select a theme from the main toolbar dropdown or from the Format
menu.

The Themes dialog box contains a list of available Themes and a preview
of each. Selecting a new Theme will apply the Theme to all existing
components as well as new components.

Note: Some variations of a component type are only available when a
particular Theme is applied (for example, half gauge is only in Graphite).
Changing the Theme with these unique components on the canvas will
change those components to the default for that category of component.
However, the original component type is retained and will revert back to its
original form if the Theme is changed back.

Using Color Schemes

Color Schemes (formerly Styles) alter the color palette of your visualization.
You can customize your entire visualization, or only certain components.
You can create your own Color Schemes based on an existing scheme or
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combination of custom colors. Color Scheme only affect the colors of
components, and do not affect fonts, text formatting, or alerts.

Note: Color Schemes are not transferred with XLF files. If the Color Scheme
used by an XLF is unavailable, the style will continue to be used by the
existing componenets in the visualization, but it will not be able to be applied
to new components.

Changing the current Color Scheme

To change the current Color Scheme, click the color scheme icon on
the Themes toolbar. Select a color scheme from the menu:

Select Create New Color Scheme to create a custom color scheme. See
Creating a Custom Color Scheme on page 63

Alternatively, you can change the color scheme by selecting Color Scheme
from the Format menu.
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In the Color Schemes dialog box, select a color scheme from the list. Click
OK to apply the selected Color Scheme to the components on the canvas.
The Color Scheme that is applied to the visualization is displayed on the
Component Explorer.

Note: There is a default color scheme associated with each Theme that
cannot be modified. Select Current Theme Colors to revert to the original
appearance of the visualization. Any color changes made will be reverted to
their default values.

Selecting a new color scheme will affect all components placed on the canvas
after the new scheme is applied. If you would like to change the color scheme
of components already on the canvas, you will need to select Apply To
Existing Components.

Click Create New to create a custom color scheme, or select a custom color
scheme from the list and click Edit to modify the scheme.

Note: Only Custom color schemes can be edited.
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For information on the Custom Color Scheme Dialog, see Creating a Custom
Color Scheme on page 63

Creating a Custom Color Scheme

You can create custom Color Schemes by modifying the parameters of an
existing color scheme.

To create a Custom Color Scheme
1. On the Format menu, click Color Scheme then select Create New, or

select the Color Scheme icon from the toolbar and selectCreate New
Color Scheme from the dropdown menu .

The Color Schemes dialog box appears.

2. Select a color from the palette to edit its value.
3. Select a new color by clicking on the color picker or by manually entering

the color values.
4. You can modify the other colors individually, or Xcelsius 2008 can

automatically modify the other colors in the scheme to be more or less
alike than the selected color. To do this, select Auto Match Colors and
use the slider to adjust the colors.

5. Select Advanced Settings to access the advanced color menu. Here,
you can set the colors for individual elements in the visualization.

6. Click Save to save the new Color Scheme.
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7. Click OK.

The new color scheme is the active color scheme and will be applied to
any components that are added to the visualization. To apply the new
color scheme, select Apply to Existing Components.

Note: Click Reset before saving the Color Scheme to revert to the originally
assigned color settings.

Transferring Custom Color Schemes

Color Schemes are transferred with XLF files.

When a visualization with a custom color scheme is opened, the applied
color palette will be displayed in the Colors toolbar icon. The custom color
scheme will also be applied to any components added to the visualization.
However, the Custom color scheme will not appear in the list of available
Color Schemes. To add the transferred color scheme to the host machine,
follow the steps for Creating a Custom Color Scheme on page 63.

Previewing the Visualization
With Xcelsius 2008, you can test run your visualization as many times as
you need. It lets you experiment with various combinations of components,
colors, and layouts to make sure your visualization functions according to
your specifications.

Select File > Preview or use the Preview button to toggle between the
design view and Preview.

You can also select File > Export > Preview to view the visualization in your
default web browser.

In Preview, you can interact with the visualization as you would when it is
published.
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Viewing sample Xcelsius 2008
visualizations

The sample visualizations included with Xcelsius 2008 show how some of
the components and functions work.

Note: Samples include their own embedded spreadsheet data. Opening a
sample will overwrite any data already in the embedded spreadsheet.

The following User Guide Samples are included with Xcelsius 2008 (Samples
in bold have step-by-step instructions in this User Guide):

• Accordion Menu
• Alerts – Charts
• Alerts – Selectors
• Alerts – Single Values
• Calendar
• Check Box
• Connection Refresh / XML Data Connection
• Drill-Down Chart
• Dual Axis Chart
• Dynamic Selected Item
• Dynamic Visibility
• Filter
• Filtered Rows
• Fisheye Picture Menu
• Filter
• Filtered Rows
• Fisheye Picture Menu
• Flash Variable Data Connection
• Grid
• History
• Icon
• Ignore End Blanks
• Image
• Line Chart
• List Box
• List Builder
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• Map
• Panel Container
• Play Selector
• Reset Button
• Slider
• Slideshow
• Sliding Picture Menu
• Status List
• Tab Set
• Ticker
• Tree Map
• Trend Analyzer
• Value Display

Note: Samples include their own embedded spreadsheet data. Opening a
sample will overwrite any data already in the embedded spreadsheet.

To view sample Xcelsius 2008 visualizations

1. On the File menu, click Samples.

The Samples dialog box appears.

2. In the Category box, click User Guide Samples.
3. In the Items box, click the component that you want to view an example

of.

A description of the component and a preview of the visualization are
shown.

4. Click OK to open the sample visualization.

Using Templates
Xcelsius 2008 offers a set of templates you can use to create a new
visualization. You can use the existing Xcelsius 2008 templates or you can
create a visualization from scratch and save it as a template.

For more information on creating and using templates, seeCreating templates
on page 157.
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To View Xcelsius 2008 Templates

1. On the File menu, click Templates.
The New From Template dialog box appears.

2. In the Category box, click New.
3. In the Items box, click the Template you would like to view.

A description and preview of the Template is shown.

4. Click OK to open the Template.
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Creating and Updating
Xcelsius 2008 Visualizations

5



This section introduces the process of creating and updating Xcelsius 2008
visualizations.

Creating a visualization
1. Add or import spreadsheet data to an Xcelsius 2008 file.

2. Link components to the spreadsheet.

3. Preview and publish the visualization.

Step 1: Add Spreadsheet Data

The first step in creating an Xcelsius 2008 visualization is to add spreadsheet
data to support your visualization. There are three ways to do this:
• Import a spreadsheet from Excel
• Copy/paste cells from an Excel file or Xcelsius 2008 embedded

spreadsheet
• Manually enter information into the embedded spreadsheet

You can add, modify, and delete data in the embedded spreadsheet. If you
have linked cells to components, the components will automatically update
when you change the data in linked cells.

Step 2: Link components to the spreadsheet

The second step in creating an Xcelsius 2008 visualization is to select the
data sources linked to the components. In this step, you assign one or more
cells from your embedded spreadsheet to one or more Xcelsius 2008
components.

User Guide Sample: Slider

This model uses a Column Chart to show “Car Sales by Location ? and a
Horizontal Slider to create a simple "what-if" scenario that shows the impact
of selling "N" number of additional cars. Adjusting the slider will cause the
sales to increase or decrease, which is visualized in the column chart.
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To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.
The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the below step-by-step instructions,
open the Sample file and then delete the components. These instructions
will produce a working visualization that will demonstrate the use of a
component or feature; additional settings, formats or components may have
been added to enhance the appearance of the sample visualization.

Note: The completed sample XLF file with embedded spreadsheet data,
and SWF file for this visualization can be located by navigating to the following
location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

Selecting the data source for the components

1. Place a Column Chart on the canvas.
2. Double-click the Column Chart to open the Properties panel.
3. Click the Data by Range cell selector button.
4. Select the range of cells that contain the data for the Column Chart from

the spreadsheet and click OK .
5. Type or link the chart title and subtitle.
6. Type or link the axis names.
7. Click the Horizontal Slider component to open the Properties panel.
8. Click the Data cell selector button.
9. Select the Price Per Unit value cell from the spreadsheet, and click OK.

Step 3: Preview and publish the visualization

The third step is to preview and publish the visualization. You can Preview
the live visualization, test the simulation results, and generate the Flash
animation SWF that contains the visualization. The visualization is then ready
for publishing and distribution.
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Click the Preview button on the tool bar to toggle between the design
view and Preview. In Preview, you can interact with the visualization as you
would when it is published.

Once you are satisfied with the results, the visualization is ready to be
published. You can publish your visualization using one of the following
methods:

• Export as Adobe Flash (SWF)

Note: This option is available in Xcelsius Engage 2008 only.

• Export as HTML

Note: This option is available in Xcelsius Engage 2008 only.

• Export to Microsoft PowerPoint

• Export as Adobe PDF

• Email Using Microsoft Outlook

• Export to Microsoft Word

• Export to BusinessObjects Platform

Note: This option is available in BusinessObjects Xcelsius Enterprise
2008 only.

SeeExporting Xcelsius 2008 Visualizations on page 135 for more information.

Updating data for a visualization
The Export Settings command on the File menu lets you specify how you
want to update data. You can update the embedded spreadsheet as needed
or you can specify an external Excel file to use as a data source. The following
options for updating the data in your visualization are available:

• Use Current Excel Data

This option takes the data as it exists in the embedded spreadsheet. This
is the default option.

• Use Another Excel File
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This option lets you specify a different Excel file from which to take data
when the file is exported.

Updating the Embedded Spreadsheet

The easiest way to update your data is to make your changes directly in the
embedded spreadsheet. Change the data in the embedded spreadsheet the
same way you would with an Excel spreadsheet.

You can copy and paste cells from an Excel spreadsheet. Formulas and
values will be pasted into Xcelsius 2008, however conditional formatting will
not be retained.

Note: Xcelsius 2008 opens an instance of Excel that runs in the background.
Although you can open a second instance of Excel, you will not be able to
copy formulas between the instances. If you need to use Excel and Xcelsius
2008 files simultaneously, first open Xcelsius 2008, then open your Excel
files by navigating to them using Windows Explorer and double-clicking on
them.

If you need to keep synced Excel and Xcelsius 2008 files, we recommend
making your updates in the Xcelsius 2008 embedded spreadsheet and then
exporting the data to an Excel spreadsheet.

Note: Xcelsius 2008 imports Excel files by copying the spreadsheet data
and inserting the data into the Xcelsius 2008 embedded spreadsheet. After
the data has been imported, it is no longer linked to the original Excel
spreadsheet. Any changes you make to the source file will not appear in the
Embedded Spreadsheet, nor will any changes to the Xcelsius 2008 file appear
in the original Excel file.
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Using Xcelsius 2008
Components

6



Overview
This section introduces the Xcelsius 2008 components and their most basic
functionality.

Using the Chart components
Charts are one of the most powerful ways to transmit your message. A
well-created chart can transmit a real sense of value to any report. This
section describes the basic functionality available in charts.

For more information about chart components, see Chart Components
Reference on page 259.

Xcelsius 2008 provides the following charts:

• Line Chart

A single- or multi-line chart ideal for showing tendency over a period of
time. Use this chart in visualizations that emphasize a trend or a continuing
sequence of data, such as Stock Prices or Revenue History.

• Pie Chart

A chart that represents the distribution or participation of each item
(represented by a slice) of a certain total that is represented on the overall
pie value. The pie chart is appropriate for visualizations such as Revenue
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Contribution by Product. In that example, the overall pie size would
represent the total revenue, and each slice would represent a different
product.

• OHLC Chart and Candlestick Chart

The open-high-low-close and candlestick charts are primarily used to
display stock data. Each marker corresponds to the values, which are
represented as lines attached to the marker on the OHLC chart and as
colors on the candlestick chart. Open displays the opening price of the
stock. High displays the highest price the stock achieved on that day.
Low displays the lowest price the of the stock on that day. Close displays
the closing price of the stock.

• Bar Chart and Column Chart

A single- or multi-bar chart that shows and compares one or more items
over a period of time or in a specific range of values. You could, for
example, use a column chart in visualizations that contain the quarterly
headcount by region.

• Stacked Column Chart and Stacked Bar Chart
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A chart that compares several variables over a period of time. Stacked
bars compare one or more variables, with each series adding to the total
value. This chart compares several variables over a period of time, for
example: Marketing Cost and Administrative Cost. Each one of the cost
components is presented in a different color and each bar represents a
different time period. The total bar size represents the Total Cost.

• Combination Chart

A combination column and line chart ideal for displaying a range of values
and a trend line for those values. You can use the combination chart in
visualizations examining stocks. A line series might show the historical
stock price over the year, and a column chart might show the volume of
trading for that stock.

• Bubble Chart
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The bubble chart is one of the most powerful analytic tools available. It
lets you compare a group or series of items based on three different
parameters. It has an X-axis and Y-axis to represent the item location
over the chart area, and a Z value to represent the item size.

You could, for example, use this chart to represent the market composition
with the X-axis representing the ROI by industry type, the Y-axis
representing the Cash Flow, and the Z-axis representing the Market Value.

• XY Chart

A chart that displays data that encompasses two dimensions. The XY
chart shows each data point as a result of the intersection of X values
and Y values. You can, for example, use the XY chart in visualizations
that compare ROI (on the X axis) against Market Value (on the Y axis)
for a group of companies.

• Area Chart
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A standard chart with vertical and horizontal axes. Each point along the
horizontal axis represents a data point. The actual values for each data
point are plotted against the vertical axis. For each series, colored areas
are created by connecting the plotted points against the horizontal axis.
Use this chart in visualizations that emphasize a trend line, such as Stock
Prices or Revenue History.

• Stacked Area Chart

A standard chart with vertical and horizontal axes. Each point along the
horizontal axis represents a data point. The actual values for the data
points are plotted against the vertical axis, with each series adding to the
total value. You could use the stacked area chart to compare the revenue
for multiple products as well as the combined revenue of all the products
and the contribution of each product to the combined revenue.

• Radar Chart and Filled Radar Chart
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A chart with axes that radiate outwards from the center of the chart. These
charts can have several axes. They are useful for plotting
multi-dimensional sets of data. In the filled radar chart, the shape created
by connecting the points along each axis is filled in with color. You could
use the radar charts to compare aspects of stocks. One axis could display
the price, another the volume, another the Price to Earnings ratio, and
any other relevant data.

• Tree Map

A chart that displays hierarchical data in a small area. Each data point is
represented by a rectangle. In Xcelsius 2008, the tree maps display two
parameters, represented by size and color intensity. Tree maps can be
used to compare two sets of data.

For example, a tree map could be used to represent the size and interest
rate of loans. You can set the size of the rectangle as the loan amount;
a large loan would be repesented by a larger rectangle. The color of the
rectangle would represent the interest rate; a higher interest rate would
be represented by a brighter color value.

How to configure a chart

Configuring a chart in Xcelsius 2008 is similar to creating a chart in Excel.
The minimum requirement is to have a list of values in a range of cells. After
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this, you can enhance your chart with some basic information such as Title,
Subtitle, Axis Titles and Series Names.

Example: Creating a visualization with a chart

For this example, you will need an Excel file that contains an adjacent range
of cells.

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a column chart on the canvas.
3. Double-click the column chart component to open the Properties panel.

Here you can select the data sources and modify the chart's appearance.

4. Type the title of the chart in the Chart box.

Tip: You can also click the Chart cell selector button to select the chart
title from the spreadsheet.

5. Type the subtitle of the chart in the Subtitle box.

Tip: You can also click the Subtitle cell selector button to select the chart
subtitle from the spreadsheet.

6. Type the axis name in the Category (X) Axis box.

Tip: You can also click the Category (X) Axis cell selector button to select
the axis name from the spreadsheet.
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7. Type the axis name in the Value (Y) Axis box.

Tip: You can also click the Value (Y) Axis cell selector button to select
the axis name from the spreadsheet.

8. (Optional) Type the axis name in the Secondary Value (Y) Axis box.

Tip: You can also click the Secondary Value (X) Axis cell selector button
to select the axis name from the spreadsheet.

9. Click the Data by Range cell selector button and select the range of
values from the spreadsheet.

The data range is the list of values to be presented on the chart
component. Select the full range of values you want to display in the chart.

10. Select a radio button to indicate how your data is arranged: Data in Rows
or Data in Columns.

In some cases, you may want to create a multi-series chart. To do this, select
the By Series option and select one or more series. Each series is
represented by columns of the same color.

Once you have created your basic chart, you can enhance and customize
it. Refer to Chart Components Reference on page 259 for more information.
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User Guide Sample: Drill-Down Chart

This sample provides an example of the Drill Down capability that allows
charts to behave as selectors. This visualization displays a Pie Chart that
contains yearly sales for several branches. When a user clicks on a slice of
the Pie Chart, the monthly sales for that branch are displayed in a Column
Chart.

To open the User Guide Sample file:

1. Select File > Samples
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats or components may have been added
to enhance the appearance of the sample visualization.

Note: The completed sample XLF file with embedded spreadsheet data and
SWF file for this visualization can be located by navigating to the following
location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

For this example the spreadsheet should contain monthly sales data for
different branches.

2. Place a Pie Chart component on the canvas.
3. Place a Column Chart component on the canvas below the Pie Chart

component.
4. Double-click the Pie Chart component to open the Properties panel.
5. Click the Values cell selector button and select the data range from the

spreadsheet.
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For this example, select the cells that contain the Sales Totals for the
individual branches.

6. Click the Data in Columns radio button to indicate that the data is
organized in a column.

7. On the Drill Down tab, click Enable Drill-Down.

The Drill Down settings can now be configured.

8. On the Insertion Type list, click Rows.

This will let you insert a row of data into the Destination range.

9. Click the Source Data cell selector button and select the source data from
the spreadsheet.

For this example, the range of cells should contain the columns of monthly
sales data from January to December and the names of the branches.

10. Click the Destination cell selector button and select a range of cells from
an empty row of the spreadsheet.

This is the range of cells where the row of data (Branch name and sales
Jan-Dec) will be inserted.

Note: The cells must be empty or the drill down functionality will be
compromised.

11. Click the Column Chart component to open the Properties panel.
12. Click the Chart cell selector button and select the first cell of the

Destination range selected for the Pie Chart.
13. Click Data by Series; click the plus button to add a series to the list box.
14. Click the Values (Y) cell selector button and starting with the first cell to

the left of the cell selected in Step 12, select the remainder of the range
of empty cells you selected for the Destination range.

15. Click the Category Labels (X) cell selector button to select the cells in the
spreadsheet that contain the column headers, for this sample the months
of the year.

16. Click the Preview button to view the interaction between the Pie Chart
and Column Chart components.

As you click on slices of the Pie Chart, the column chart will update to
show the monthly sales data for the selected branch.
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User Guide Sample: Dual Axis Charts

Xcelsius 2008 now has the ability to plot series data on both a primary and
a secondary axis. This is available for the following charts: Line, Bar, Stacked
Bar, Column, Stacked Column, Area, Stacked Area, and Combination Chart.

To open the User Guide Sample file:
1. Select File > Samples
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats or components may have been added
to enhance the appearance of the sample visualization.

Note: The completed sample XLF file with embedded spreadsheet data and
SWF file for this visualization can be located by navigating to the following
location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use

2. Place a Combination Chart component on the canvas. .
3. Double-click the Combination Chart to open the Properties panel.
4. In the Chart box, type "Stock Price vs. Volume".
5. In the Category (X) Axis box, type "Week Ending".
6. In the Value (Y) Axis box, type "Price".
7. Click Data by Series; click the plus button to add a series to the list box.
8. In the Name box, type "Closing Price".
9. Click the Values (Y) cell selector button and select the Source Data for

this series; for this sample, select the data under the column header
"Closing Price".

10. Under Plot Series On, click the Primary Axis radio button.
11. Click the plus button to add another series to the list box.
12. In the Name box, type "Volume".
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13. Click the Values (Y) cell selector button and select the Source Data for
this series; for this sample, select the data under the column header
"Volume".

14. Under Plot Series On, click the Secondary Axis radio button.
15. Click the Category Labels (X) cell selector button and select the data

labels; for this sample select the data under the column header "Date".
16. Click the Appearance tab; click the Series sub-tab.
17. For the series "Closing Price", click the Type dropdown menu and select

Column.
18. For the series "Volume", click the Type dropdown menu and select Line.
19. Click Preview to view the Combination Chart component displaying two

series plotted on separate axis.

In this sample, the Combination Chart component has been configured to
display two disparate sets of data, each plotted on its own axis.

Using the Container components
This category contains a group of components that group and display other
components.

Note: These components are not available in Xcelsius Present.

For more information about Container components, see Container
Components Reference on page 281.

• Panel Container

The Panel Container components act as smaller canvases within the
main canvas and hold one or more components. Components in the Panel
Container can be moved, added, changed or deleted. Click the plus sign
next to the Panel Container in the Object Browser to expand the list of
components within the Panel Container.

• Tab Set
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The Tab Set component is similar to the Panel Container components.
The Tab Set acts as a smaller canvas within the main canvas. A Tab Set
contains multiple tab views; each can be displayed on the canvas by
clicking its corresponding tab. Tabs can be added or deleted from the
Tab Set by clicking on the gray plus and minus buttons displayed on the
top left corner. These buttons do not display when the visualization is run.

User Guide Sample: Panel Container

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats or components may have been added
to enhance the appearance of the sample visualization.

Note: The completed sample XLF file with embedded spreadsheet data and
SWF file for this visualization can be located by navigating to the following
location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Panel Container on the canvas
3. Click the Panel Container, displaying the black sizing boxes. Increase

the size of the Panel Container by dragging the bottom corner sizing box.
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4. In the Components browser, select a Pie Chart component; drag the
pointer and release in the interior of the Panel Container. The Pie Chart
will now be inside the Panel Container.

5. In the Components browser, select a Label component; drag the pointer
and release in the interior of the Panel Container. The Label will now be
inside the Panel Container.

6. In the Objects Browser, click the plus sign to expand the Panel Container
tree. The Pie Chart and Label will be displayed as sub-components of
the Panel Container.

7. Select the Label, click Enter Text. Type or paste any block of text into the
box.

8. Click the Panel Container, displaying the black sizing boxes. Decrease
the size of the Panel Container so that only the Pie Chart is visible by
dragging the bottom corner sizing box.

9. Click Preview to view how the Panel Container displays components.

In this sample, the Panel Container has been sized smaller than its contents.
The Panel Container automatically adds horizontal and/or vertical scroll bars
as needed. If more components were added to the canvas of the visualization,
dynamic visibility functionality could be used to show or hide the entire Panel
Container and its contents, rather than applying the functionality to each
component individually.

User Guide Sample: Tab Set

The Tab Set component is similar to the Panel Container component. The
Tab Set acts as one or more smaller canvases within the main canvas. A
Tab Set contains multiple views organized in tabs; each view can be displayed
by clicking its corresponding tab. Each view can hold one or more
components and works similar to the Group function during design of the
visualization. Components in the Tab Set can be moved, added, changed
or deleted. In the Object Browser, click the plus sign next to the Tab Set
expand it; each tab view is represented as a Canvas which can also be
expanded to list the components it contains.

The number of tab views displayed by the Tab Set can be increased or
decreased by clicking a tab label. Gray plus and minus buttons will display
above the first tab. Clicking the plus button will open an Insert dialog box,
which prompts you to enter a Label for the new tab.
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Note: The plus and minus buttons do not display when the visualization is
run.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Tab Set component on the canvas.
3. Double-click the interior of the Tab Set (canvas) to open the Properties

panel.
4. In the Label box, type "North America".
5. In the Components browser, select a Pie Chart component; drag the

pointer and release in the interior of the Tab Set. The Pie Chart will now
be inside the Tab Set.

6. Click the tab label; click the plus button to add a new tab.
7. At the prompt, enter "Latin America" for the tab Label; click OK to add

the new tab.
8. In the Components browser, select a Line Chart component; drag the

pointer and release in the interior of the Tab Set. The Line Chart will now
be inside the Tab Set.

9. Click the tab label; click the plus button to add a new tab.
10. At the prompt, enter "Europe" for the tab Label; click OK to add the new

tab.
11. In the Components browser, select a Column Chart component; drag the

pointer and release in the interior of the Tab Set. The Column Chart will
now be inside the Tab Set.
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12. Click the tab label; click the plus button to add a new tab.
13. At the prompt, enter "Asia" for the tab Label; click OK to add the new tab.
14. In the Components browser, select a Bar Chart component; drag the

pointer and release in the interior of the Tab Set. The Bar Chart will now
be inside the Tab Set.

15. Click the tab label; click the plus button to add a new tab.
16. At the prompt, enter "Australia & Pacific" for the tab Label; click OK to

add the new tab.
17. In the Components browser, select a Pie Chart component; drag the

pointer and release in the interior of the Tab Set. The Pie Chart will now
be inside the Tab Set.

18. Optional: Using the Objects Browser, navigate to the chart in each tab
and bind it to the spreadsheet data. For step-by-step chart configuration
instructions see User Guide Sample: Status List. For this sample exclude
configuration of the Status and Key for each chart.

19. Click Preview to view how the Tab Set displays components.

In this sample, the Tab Set has been configured to display five different
views, each with a unique component (and data set if configured). Click on
the tabs to navigate between the views.

Using the Selector components
The functionality of selector components lets you create a visualization with
multiple selections.

Note: The Information button that appears on the Properties panel of
each selector component displays an animation that describes the
functionality of the selector component.

For more information about Selector components, seeOverview on page 290.

Each selector can be combined with other components to create a dynamic
visualization:

• Accordion Menu
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The Accordion Menu is a two-level menu that lets users first select a
category and then select from items within that particular category.

Note: This component is not available in Xcelsius Present.

• Check Box

A standard user-interface component where users toggle between two
states: checked and unchecked.

• Combo Box

A standard user-interface component that drops down a vertical list of
items when it is clicked. Users can then select an item from the list.

• Filter

The Filter component looks at a range of cells with multiple fields of data
and categorizes them by unique data entries. The Filter sifts through the
data range and inserts data corresponding to the drop down selections.

• Fisheye Picture Menu
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With the Fisheye Picture Menu, users select from a set of pictures or
icons. As the mouse is moved over each item in the menu, the item is
magnified. The closer the mouse is to the center of the item, the more
the item is magnified. This creates an effect similar to that of a fish-eye
lens.

• Sliding Picture Menu

With the Sliding Picture Menu, users select from a set of icons or pictures.
The users can use arrows to scroll through the icons or the menu can be
configured to scroll through the icons as the user moves the mouse.

Note: This component is not available in Xcelsius Present.

• Icon

The Icon can be used as a selector or display component. As a selector,
it functions similar to the Check Box component. It can represent the
actual value contained in one cell and be compared to its target value in
another cell.

The Icon can also be set to change color depending on its value relative
to the target value, which is an Alert. See Alerts on page 154 for more
information. At the same time, you can use the Icon to activate and display
other components. See Dynamic Visibility functionality on page 148 for
more information.

Note: To configure the Icon as a display-only component, click the
Appearance tab and uncheck Show On/Off . The Icon will not be selectable
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• Label Based Menu

The Label Based Menu lets users select items from a vertical or horizontal
grouping of buttons.

• List Box

A standard user-interface component that lets users select items from a
vertical list.

• List View

Note: This component is not available in Xcelsius Present.

The List View component has the same functionality as the table
component, but lets the user sort the columns and adjust the width of the
columns in the exported SWF file.

• List Builder

94 Xcelsius 2008 User Guide

Using Xcelsius 2008 Components6 Using the Selector components



The List Builder provides a way for end-users to build their own set of
data. This data set can then be used to populate another component.

Note: This component is not available in Xcelsius Present.

• Radio Button

The Radio Button component lets users select from a vertical or horizontal
group of selections.

• Ticker

The Ticker component displays horizontally scrolling text in your
visualization. Scrolling stops when the user hovers the mouse over the
labels.

Note: This component is not available in Xcelsius Present.

• Toggle Button
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A standard user-interface component that lets users toggle between two
states: on and off.

• Spreadsheet Table

The Spreadsheet Table component is a What You See Is What You Get
representation of any group of cells from your spreadsheet.

Note: The Spreadsheet Table component can be used as a display
component as well as a selector component. As a display component,
the Spreadsheet Table is a graphic representation of a range of cells in
the spreadsheet. To use the Spreadsheet Table as a display component,
click the Display Data cell selector button and select a range of cells to
display from the spreadsheet. Under the Behavior tab, click Deselect All.
The rows of the table will not be selectable. To use the spreadsheet table
as a selector component, after setting the Display Data range, set the
Insert Option to rows.

• Play Selector

The Play Selector sequentially inserts one row or column from a defined
range into the Destination cells you selected. You can link the Destination
cells to a chart so that the chart data changes each time the play selector
inserts a new row or column. The Play Selector component can display
a large amount of data with a movie effect which lets users view the data
without clicking on each selection.

Note: This component is not available in Xcelsius Present.
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User Guide Sample: Filter

The Filter component takes a range of data with fields that contain duplicate
data entries and filters each field into a Combo Box so that there are only
unique entries in each field. The Filter component can present a large amount
of data and can be used to create a selector with up to ten Combo Box fields.
When selections are made on the Filter component, the corresponding data
is inserted in the spreadsheet and can be used as source data for a chart
component.

In this sample, the quarterly Sales data is displayed. The data is organized
by Product, Sales Rep, and Account Type. Selecting an item from any of the
Combo Boxes will show the quarterly Sales data for the corresponding
combination of selections on the Bar Chart.

To open the User Guide Sample file:
1. Select File > Samples.

2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a filter component on the canvas.

3. Double-click the filter component to open the Properties panel.

4. Click the Source Data cell selector button and select all the data to be
included in the visualization.
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For this sample, the data selection should include the fields used by the
filter as well as the corresponding data that will be displayed in the chart.

5. Click the Destination cell selector button and select an empty range of
cells in a row. The range must be large enough to display a full row of
chart data.

For this sample, select the range of cells adjacent to "Filter Destination".

Note: The cells must be empty or the inserted data may not function
properly.

6. Adjust the value in the Number of Filters box.

For this sample, set the number of filters to three: Product, Sales Rep,
and Account Type.

7. Click the Title cell selector button and select the labels that will appear
above each Combo Box.

For this sample, select the column headers of the fields to be filtered.

8. Place a Bar Chart component on the canvas.
9. Click Data by Series; click the plus button to add a series to the list box.
10. Click the Values (X) cell selector button and select the range of empty

cells you selected for the Destination range for the Filter component.
11. Click the Category Labels (Y) cell selector button to select the cells in the

spreadsheet that contain the chart data column headers; for this sample
the quarters of the year.

12. Click the Preview button to view the interaction between the Filter and
Bar Chart components.

The quarterly Sales data displayed in the Bar Chart will update depending
on the selections made in the Combo Boxes of the Filter Component.

User Guide Sample: List Builder

The List Builder provides a way for users to build their own sets of data. The
List Builder consists of a Source list containing all possible selections, a
Destination list containing the user's selections, and an Update button. Users
can move items between the Source and Destination lists in a number of
ways:
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• Double-clicking items in either the Source or Destination list to move the
item to the other list.

• Dragging items from one list to another.
• Using the Add and Remove buttons.

When the Update button is pressed, the items in the Destination List are
inserted into the Destination range to be displayed by another component.
To change the order of selections in the Destination List, drag an item up or
down in the list.

In this sample, the user selects from a list of branches to see the yearly sales
data for those branches. The user builds a list of branches and then clicks
the Update button to see the selected data in a Column Chart.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a List Builder component on the canvas.
3. Place a Line Chart component on the canvas below the List Builder

component.
4. Double-click the List Builder component to open the Properties panel.
5. Click the Labels cell selector button and select the Source List items from

the spreadsheet.

For this sample, select the list of branches.
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6. On the Insertion Type list, click Row.

This inserts a row of data corresponding to each item that is placed in
the Destination List.

7. Click the Source Data cell selector button and select the range of data
from the spreadsheet.

For this sample, the range of cells should contain the table of yearly sales
data for the branches.

8. Click the Destination cell selector button and select a range of empty
cells.

For the List Builder, the Destination range must be the same size as the
Source Data range you selected in the last step.

Note: The cells must be empty or the List Builder may not function
properly.

9. Click the Column Chart component to open its Properties panel.
10. Click Data by Series; click the plus button to add a series to the list box.
11. Click the Values (Y) cell selector button and select the range of empty

cells you selected for the Destination range for the List Builder component.
12. Click the Category Labels (X) cell selector button to select the cells in the

spreadsheet that contain the chart data column headers, for this sample
the fiscal years.

13. On the Behavior tab, in the Ignore Blank Cells area, click In Series and
In Values.

Note: This ensures that the Column Chart only displays data for the items
that were selected in the Destination List of the List Builder.

14. Click the Preview button to view the interaction between the List Builder
and Column Chart components.

Move some of the branches from the Source List to the Destination List.
Click the Update button. The Column Chart will update to show the yearly
sales data for the selected Branches.
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User Guide Sample: Accordion Menu

The Accordion Menu component is a two-level menu that displays Categories,
and when clicked on the Categories expand to display a list of items to select
from. For this sample, the Accordion Menu displays Regions that when
clicked on show the names of Sales Reps; selecting a Sales Rep displays
their sales data for the year.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place an Accordion Menu component on the canvas.

3. Place a Column Chart component on the canvas.

4. Double-click the Accordion Menu component to open the Properties panel.
5. Select Category 1 in the list box; click the Name cell selector button and

select the first Category name.

In this sample, select the first region name.

6. Click the Labels cell selector button and select the items to be listed under
the first category.

For this sample, each region is a Category and the Labels for each region
are the names of the corresponding sales representatives.
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7. Click the Source Data cell selector button and select the data
corresponding to the Labels in the first Category.

For this sample, the range of cells should contain the sales data for the
sales representatives in the first region.

8. Repeat steps 5-7 for each Category. In this sample, repeat the steps for
each region in the spreadsheet.

9. Click the Insertion Type dropdown menu, then select Row.
10. Click the Destination cell selector button and select an empty row of cells.
11. Click the Column Chart component to open its Properties panel.
12. Click Data by Series; click the plus button to add a series to the list box.
13. Click the Values(Y) cell selector button and select the range of empty

cells you selected for the Destination range for the Accordion Menu
component.

Note: Do not include the first cell of the Destination range; this is where
the Sales Rep's name will be inserted. The Values (Y) range should only
include the cells that will contain sales data.

14. Click the Category Labels(X) cell selector button to select the cells in the
spreadsheet that contain the chart data column headers, for this sample
the months of the year.

15. Click the Chart cell selector button and select the first cell in the
Destination range selected for the Accordion Menu.

This cell will contain the name of the sales representative and will now
be displayed as the Column Chart title.

16. Click the Preview button to view the interaction between the Accordion
Menu and Column Chart components.

As you click on a region and select a sales representative, the chart will
display the monthly sales data for that sales representative.

User Guide Sample: Sliding Picture Menu

The Sliding Picture Menu component displays thumbnail images that when
selected insert data corresponding to the images that can be displayed by
another component. In this sample, the Sliding Picture Menu displays
thumbnail images of a company's products, clicking on a product image
displays sales data for that product in a Column Chart.
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To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Sliding Picture Menu component on the canvas.
3. Place a Column Chart on the canvas beneath the Sliding Picture Menu

component.
4. Double-click the sliding picture menu component to open the Properties

panel.
5. Click the Labels cell selector button and select the data to be displayed

as the image labels.

For this sample, select the names of the products.

6. Click the Embedded radio button, then click the Import button.

The Import Thumbnail dialog box appears.

7. Select the Click to Add Images button. Navigate to the first thumbnail
image and click OK. For this sample, image files have been provided in
the User Guide Samples file directory.

8. Repeat Step 7 until all images to be used have been added to the Import
Thumbnail dialog box.

9. On the Insertion Type list, select Row.
10. Click the Source Data cell selector button and select the range of cells

containing the source data.
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For this sample, the range of cells should contain the yearly sales data
for the products.

11. Click the Destination cell selector button and select an empty row of cells.
12. Click the Column Chart component to open its Properties panel.
13. Click Data by Series; click the plus button to add a series to the list box.
14. Click the Values(Y) cell selector button and select the range of empty

cells you selected for the Destination range for the Sliding Picture Menu
component.

Note: Do not include the first cell of the Destination range; this is where
the product name will be inserted. The Values(Y) range should only include
the cells that will contain sales data.

15. Click the Category Labels(X) cell selector button to select the cells in the
spreadsheet that contain the chart data column headers, for this sample
the fiscal years.

16. Click the Chart cell selector button and select the first cell in the
Destination range selected for the Accordion Menu.

This cell will contain the name of the product and will now be displayed
as the Column Chart title.

17. Click the Preview button to view the interaction between the Sliding Picture
Menu and Column Chart components.

As you click on the images in the Sliding Picture Menu, the Column Chart
displays the yearly sales data for that product.

User Guide Sample: Dynamic Selected Item

The Dynamic Selected Item functionality is available in list-based selectors.
The selector labels can be changed dynamically through another component
in the visualization.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.
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The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a List Box component on the canvas.
3. Double-click the List Box to open the Properties panel.
4. Click the Labels cell selector button and select the labels for the selections

in the List Box.
5. From the Insertion Type dropdown menu, select Rows.
6. Click the Source Data cell selector button and select the data

corresponding to the Labels.
7. Click the Destination cell selector button and select a range of empty

cells.
8. Click the Behavior tab; in the Selected Item section, click the Item cell

selector box and select a cell in the spreadsheet.
9. Place a Column Chart component on the canvas.
10. Click the Column Chart to open its Properties panel.
11. Click Data by Series; click the plus button to add a series to the list box.
12. Click the Values (Y) cell selector button and select the same range of

cells as the Source Data for the List Box component.
13. Click the Category Labels (X) cell selector button and select the column

headers of the Source Data range.
14. Place a Radio Button component on the canvas.
15. Click the Radio Button to open its Properties panel.
16. Click the Labels cell selector button and select the labels for the Radio

Button selections.
17. From the Insertion Type dropdown menu, select Label.
18. Click the Destination cell selector button and select the same cell selected

in step 8 as the Selected Item for the List Box.
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19. Click Preview to view the interaction between the List Box, Radio Button,
and Column Chart components.

In this sample, the Radio Button selection affects the labels that are displayed
in the List Box. The List Box selection then updates the Column Chart display
data.

User Guide Sample: Filtered Rows

The Filtered Rows functionality is one of the methods available to configure
a selector component. The selector is associated with a range of data
organized in rows. Within that range of data there are labels that will be
displayed on the selector component. These labels may be duplicated and
associated with more than one data point or row of data. With Filtered Rows,
the selector filters the range of labels into unique data entries. When the
label is selected on the selector component, only the rows that correspond
with that label are inserted in the Destination range.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Radio Button component on the canvas.
3. Double-click the Radio Button to open the Properties panel.
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4. Click the Labels cell selector button and select the labels for the radio
buttons; for this sample select all of the data under column header "Item".

5. On the Insertion Type dropdown menu, select Filtered Rows.
6. Click the Source Data cell selector button and select the data

corresponding to the Labels.

For this sample select all of the data under column headers "Date of
Purchase", "Quantity" and "Item".

7. Click the Destination cell selector button and select a range of empty
cells.

For this sample, select a range of cells large enough to contain all of the
Source Data.

8. Place a Column Chart component on the canvas.
9. Click the Column Chart to open its Properties panel.
10. In the Chart box, type "Purchases by Date".
11. In the Category (X) Axis box, type "Date".
12. In the Value (Y) Axis box, type "Quantity".
13. Click Data by Series; click the plus button to add a series to the list box.
14. Click the Values (Y) cell selector button and select the range of cells

where the data will be inserted; for this sample select the range where
the column "Quantity" will be inserted.

15. Click the Category Labels (X) cell selector button and select the range of
cells where the labels will be inserted; for this sample select the range
where the column "Date of Purchase" will be inserted.

16. Click Preview to view the interaction between the Radio Button and
Column Chart components.

In this sample, the Radio Button uses the Filtered Rows functionality and
takes a range of data with duplicate data entries and filters the data so that
there are only unique entries. Based on the user's selection, the Radio Button
locates all data points that correspond to the selected label. The data is then
inserted in a range of cells to be displayed in the Column Chart.

User Guide Sample: Tree Map

The Tree Map uses two parameters to create a color block for each Product.
The size of each color block represents its Price relative to all other prices.
The light or dark shade of each block represents is Market Share relative to
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the rest of the market. This graphic representation allows instant comparison
of multiple data points against each other in two parameters. If a data point
lies far outside the range of the data points it's being compared to, it might
show up as significantly larger/smaller or very bright/dark.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Tree Map component on the canvas
3. Double-click the Tree Map component to open Properties panel.
4. Click Data By Series; click the plus button to add a series to the list box.
5. Click the Display Labels cell selector button and select the Labels for the

items to be represented in the Tree Map.

For this sample, select the product names.

6. Click the Values (Size) cell selector button and select the data that will
determine the size of the blocks within the Tree Map.

For this sample, select the price data.

7. Click the Values (Color Intensity) cell selector button and select the data
that will determine the color intensity of the blocks within the Tree Map.

For this sample, select the market share data.

8. Click Preview to view how the Tree Map displays data.

108 Xcelsius 2008 User Guide

Using Xcelsius 2008 Components6 Using the Selector components



In this sample, if the user were looking for the weakest product in this group,
Product A would stand out because it is light colored, indicating small market
share, and is also the smallest block, indicating a low price. Conversely,
Product G is dark colored, indicating a large market share, and is also one
of the largest blocks, which indicates a higher price; the dark color and large
size make it stand out as a strong product.

Using the Single Value components
Single Value components let you add user interactivity to your visualizations.
Single Value means that the components are linked to a single cell in the
spreadsheet. When you run the visualization the component lets you modify
or represent the value of that cell.

For more information about Single Value components, see Single Value
Components Reference on page 315.

Input vs. output

Single Value components have been classified as both input and output
components, which means that you can use any Single Value component
as an input or output element in your visualization.

What dictates whether a Single Value component is an input (which permits
user interaction) or output, is the cell to which it is linked. If the cell contains
a formula of any type, the component is interpreted as an output. If the cell
does not contain a formula, it is represented as an input.

For example, if you have a Gauge linked to a cell that does not contain a
formula, you can modify the value by dragging the gauge needle, thereby
modifying the cell value. If you have a Gauge linked to a cell that does contain
a formula, you cannot modify the value.

Each component can be used to add interactivity to a visualization:

• Dial
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An input component. A Dial represents a variable that can be modified
to affect other components. For example, to represent the Price per Unit.

• Slider and Dual Slider

An input component. A Slider represents a variable that can be modified
to affect other components. For example, to represent the Price per Unit.
The Dual Slider allows you to adjust both the minimum and maximum
values.

• Progress Bar

An output component. A Progress Bar represents a value that changes
and fills the progress bar area depending on its value.

• Gauge

An output when bound to a cell containing a formula, or an input when
bound to a cell containing a value.

As an output, a Gauge represents a value that changes and moves the
needle. As an input, a Gauge represents a variable that can be modified
to affect other components. Users can interact with the Gauge by dragging
the needle to change the value.

• Value
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An output when bound to a cell containing a formula, or an input when
bound to a cell containing a value.

As an output, a Value represents a value that changes. As an input, a
Value represents a variable that can be modified to affect other
components. Users can interact with the Value by typing in a new value.

• Spinner

An input component. A Spinner represents a variable that can be modified
to affect other components. Users can interact with the Spinner by clicking
the up and down arrows or by typing a value into the component.

• Play Control

An input component. Play Control is used to automatically increase the
value of a cell in your spreadsheet. For example, link the play button to
a cell that contains the headcount. What will happen if the headcount
increases by one, two, three, or more? Play Control takes the initial
headcount value and increases its value automatically by increments.

User Guide Sample: Value Display

The Value component can be used to display or adjust the numeric value of
cells. This visualization contains a Column Chart displaying revenues for five
(5) different stores. Adjusting the Value component will cause an increase
or a decrease in the revenue on the Column Chart.

In this sample, a store supervisor wants to measure the effect that increasing
or decreasing the price of a particular product has over the Revenue from
products normally sold over a period of time.
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• In this case, Price per Unit is the variable that we want to modify. This
cell affects the revenues for all stores.

• Quantity sold is the normal volume of products sold over a period of time.
• Revenues are calculated as Quantity multiplied by Price per Unit..

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Column Chart component on the canvas.
3. Double click the Column Chart to open the Properties panel.
4. Click Data by Series; click the plus button to add a series to the list box.
5. Click the Values (Y) cell selector and select the data under Revenues.
6. Click the Category Labels (X) cell selector and select the Store Names.
7. Place a Value component on the canvas.
8. Click the Title cell selector button and select the cell containing "Price per

Unit".
9. Click the Data cell selector button and select the Price per Unit value cell

from the spreadsheet.
10. Click the Preview button to view the interaction between the Value and

Column Chart components.

You can increase or decrease the Price per Unit by clicking in the Value
component and dragging the pointer up or down. Double-click the Value
component to type in the Price per Unit. Because the Value component is
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linked to a cell that affects the Revenues, the chart dynamically changes
when the Price per Unit changes to reflect the new revenues by store.

Using the Map components
Map components create visualizations with geographical representations
that can display data by region.

The Map components have two major characteristics: they display data for
each region and each region can also act as a Selector. By combining these
two features, you can create a visualization where the data for each region
appears when you pass the pointer over the region. At the same time, each
region can insert a row of data that contains additional information. This row
of data is displayed by other components, such as a chart or value
components.

For more information about Map components, see Map Components
Reference on page 327.

How does it work?

Xcelsius 2008 associates data with each region in the map by using region
keys. Each region in the map has a default region key, and you can enter
your own region keys. When a region on the map is selected, the component
searches either the first column or first row of that range's key. The data in
the row or column corresponding with the key will be associated with the
region.

By default, the USA maps use postal abbreviations as region keys; the Europe
map uses the ISO (or International Organization for Standardization) two-digit
country codes as region keys. To use the map components with existing
spreadsheets, you can edit the region keys associated with each region by
clicking the Manual Edit button to type the new keys, or by clicking theRegion
Key cell selector button to select the row or column containing the new keys
by editing the region names.

Note: In the spreadsheet you must enter the region keys and data in adjacent
cells for both Display Data and Source Data.

Tip: Xcelsius 2008 provides a spreadsheet that lists the default region codes
for each map component. The file is located in the following location:
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C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

User Guide Sample: Map

In this sample, the USA map acts as a selector. The Map will display Revenue
data for the state when the pointer passes over or clicks on it. The historic
Revenue data of the selected state will be displayed on the Column Chart.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Map component on the canvas, for this sample use the United
States by State Continental component.

3. Click the Region Keys Manual Edit button to verify that each state is linked
to the same state region key as in your spreadsheet.

The U.S. by State Continental component has region keys for the 48
continental states plus Washington D.C. in alphabetical order. Before
configuring the Map component, you must include the region keys for
each state that is identified in your spreadsheet. For example, the default
region key is AL for Alabama and CA for California. The Map identifies
data in the cell adjacent to the region key "AL" as being the data for
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Alabama, and the region key "CA" as being adjacent to the data for
California.

4. Click theDisplay Data cell selector button and select the cells containing
the state region keys and their corresponding data that will be displayed
on the Map, for this sample the most recent Revenue data.

5. Under Insertion Type, select Row.
6. Click the Source Data cell selector button and select the cells containing

State Keys and the data to be displayed in the chart based on the user's
selection, for this sample the historic revenue data.

Note: The Display Data range and the Source Data range each must
have region keys associated with the data points, thereby requiring two
sets of data ranges depending on your data structure.

7. Click the Destination cell selector button and select an empty range of
cells.

Note: The range of cells must be empty and large enough to
accommodate the region key and the historic revenue data for the state.
The Map component will insert the data into the selected range of cells.

8. Place a Column Chart component on the canvas.
9. Click the Chart cell selector button and select the first cell of the

Destination range selected for the Map component.
10. Click Data by Series; click the plus button to add a series to the list box.
11. Click the Values(Y) cell selector button and starting with the first cell to

the left of the cell selected in Step 9, select the remainder of the range
of empty cells you selected for the Destination range.

12. Click the Category Labels (X) cell selector button to select the cells in the
spreadsheet that contain the column headers of the Source Data, for this
sample the fiscal years.

13. Click the Preview button to view the interaction between the Map and
Column Chart components.

The historic revenue data in the Column Chart updates according to the
State selected by the user.
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Using the Text components
This category contains components for placing labels and typing text into
your visualization.

For more information about Text components, see Text Components
Reference on page 345.

Text components let you customize your visualization:

• Input Text Area

The Input Text Area lets users input multiple lines of text into the
visualization.

• Label

The Label component lets you add an unlimited amount of text to enhance
your visualizations. You can use the Label component to create titles,
subtitles, explanations, help, and more. Label text cannot be changed by
the user.

• Input Text

The Input Text component lets users input text into the visualization.

Using the Other components
This category contains an assorted set of components that you can use to
enhance your visualizations.
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For more information about Other components, see Other Components
Reference on page 369.

• Calendar

The Calendar component is a selector that lets you incorporate date
selection into your visualizations.

Note: This component is not available in Xcelsius Present.

• Local Scenario Buttons

The Local Scenario Button lets users save and load runtime configurations
of an Xcelsius 2008 visualization on their local machine. Once saved,
these configurations or scenarios can be loaded again, even after closing
the visualization. These scenarios are saved to the local machine, and
will be unavailable if the visualization is opened on a different machine.

• Trend Icon

The Trend Icon changes its pointing direction, depending on the value of
the cell to which it is linked:

• If the value is positive, the arrow points up.

• If the value is zero, the symbol is neutral.

• If the value is negative, the arrow points down.

• History
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The History component tracks and displays the history of changes in a
selected cell. This allows you to easily see the effect of changes in
worksheet data.

Note: This component is not available in Xcelsius Present.

• Panel Set

The Panel Set component is a series of framing options that enables you
to easily navigate between files in a presentation. You can embed JPEG
or SWF files into the frames of the Panel Set component and adjust a
variety of formatting features to customize the look of the component in
your visualization.

Note: This component is not available in Xcelsius Present.

• Source Data

The Source Data component has no visual interface. It allows you to push
data into other cells simply by changing the value of the component's
Selected Index.

Note: This component is not available in Xcelsius Present.

• Trend Analyzer

118 Xcelsius 2008 User Guide

Using Xcelsius 2008 Components6 Using the Other components



The Trend Analyzer combines data analysis and visualization. The
component analyzes spreadsheet data and inserts data points for a trend
line into the spreadsheet, which can then be added to your visualization.

Note: This component is not available in Xcelsius Present.

• Print Button

The Print Button allows the user to easily print the visualization while it
is being run. The user can click the print button to print the SWF file. The
print button is part of the canvas and will be visible in the printout.

• Reset Button

The Reset Button returns the visualization to its original state. Users can
interact with the components, then click the button to clear their changes.

• Grid

The Grid component is a dynamic table that represents a group of rows
and columns of content. The Grid lets you show the data just as it is on
any table, or perform data modification that can impact other components.

The Grid component differs from the Spreadsheet and List View
components in that rather than being a static representation of the data
table, the user can click the cells of the Grid and type new values or drag
the values higher/lower

Note: This component is not available in Xcelsius Present.
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Using the Local scenario button component

The Local Scenario Button component lets users save the current state of
a visualization, making it well-suited for saving results of what-if analyses.
Users can save any number of these results or scenarios and load them at
any time, even after closing the visualization.

The scenarios created are specific to each visualization. As such, two
visualizations can have scenarios with the same names without interfering
with one another.

The visualization can be moved or renamed on the same computer and will
still be able to access its saved scenarios.

Scenarios saved in preview mode will not persist outside of the preview
session. This includes snapshots and exporting to PowerPoint or to Outlook.

Note: Local scenarios created on one computer will not be accessible to the
visualization if it has been emailed or moved to another computer.

How does the Local Scenario Button component work?

To enable users to save, load, and delete scenarios, add a Local Scenario
Button component to the visualization.

When running the visualization, users click the Local Scenario Button
component for the options Save, Load, and Delete.

After one of the three options is chosen, a dialog box appears, allowing the
user to complete the operation.

Flash Player settings

An unlimited number of scenarios can be saved in every visualization, so
long as enough local storage is allocated for the Flash Player. If a user
attempts to save a scenario and there is not enough local storage, the Flash
Player will prompt the user to allocate more. If more space is allocated, the
scenario will be saved successfully. If not, the scenario will not be saved.
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If a user attempts to save a scenario and local storage has been disabled,
the local scenario button component will ask the user to enable local storage
and automatically open the Flash Player settings. The scenario will not be
saved until the user enables local storage and then saves the scenario.

The Flash Player settings can be opened by right-clicking anywhere on the
Preview or exported visualization.

Note: Setting the Local Storage amount of the Flash Player below what is
currently used, or disabling local storage by checking the Never box will
erase all saved scenarios on the computer. This includes scenarios created
in all other visualizations. The Flash Player will warn the user before allowing
the scenarios to be erased.

Loading a saved scenario should restore the visualization to almost the same
state it was in when it was saved. There are a few exceptions, primarily
cosmetic changes, which don't directly affect the data visualization. The
states of external and nested SWF files are also not restored when a scenario
is loaded.

User Guide Sample: Calendar component

The Calendar component is a selector that lets you incorporate date selection
into your visualizations. This sample shows the daily sales for different
branches in a Bar Chart based on the date selected on the Calendar
component. The Calendar lets the user scroll through either any year and
month, or a fixed date range by setting a starting and ending year and month.
The Calendar has two Insertion Types: Date and Day. The Date function
inserts the selected date formatted in the Excel universal date format. The
Day function inserts the numeric value for the selected date (day, month,
and/or year).

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
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or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Calendar component on the canvas.
3. Place a Bar Chart component on the canvas below the Calendar

component.
4. Double-click the Calendar component to open the Properties panel.
5. Click the Insertion Type dropdown menu; select Date.
6. Click the Destination cell selector button and select an empty cell from

the spreadsheet.

Note: The cell must be empty or the functionality of the Calendar
component will be compromised.

7. On the Behavior tab, under Default Date, click Use Custom Date. For this
sample set the Day to 1, Month to 7 and the Year to 2007.

8. Check Enable Calendar Limits for the Calendar component. For this
sample, set the Start Month to 7, Start Year to 2007, End Month to 7 and
the End Year to 2007.

9. Click the Bar Chart component to open its Properties panel.
10. Type in the Chart box or click the adjacent cell selector button and select

the title from the spreadsheet.

For this sample, use "Daily Sales by Branch".

11. Click the Subtitle cell selector button and select the subtitle from the
spreadsheet.

For this sample, choose the "Chart Subtitle" value cell which will update
based on the Calendar selection.

12. Click Data by Series; click the plus button to add a series to the list box.
13. Click the Values(X) cell selector button; for this sample select the row of

cells adjacent to "Chart Data Range".
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14. Click the Category Labels (Y) cell selector button to select the cells in the
spreadsheet that contain the column headers of the Source Data, for this
sample the branch names.

15. Click the Preview button to view the interaction between the Calendar
and Bar Chart components.

As you click on the dates in the Calendar component, the Bar Chart
component will display the daily sales data for all of the branches for that
date.

User Guide Sample: Grid

In some visualizations, you might want to complement the graphical display
of data with traditional tables that show the underlying data. One way to do
this is by using a Value component. For instances where you would need
multiple Value components, you can also use the Grid component. The Grid
component is a collection of N number of Value components that are linked
together. Each cell of the Grid component works in the same way as the
Value component.

The Grid component can be used as an input or output component. Each
cell of the Grid can be modified by clicking the value and dragging the value
higher or lower.

This sample shows Sales by Branch. Selecting a Branch from the List Box
will show the historical data for the selected Branch on the Column Chart.
The Grid displays the data that underlines the Column Chart. Adjusting the
data in the Grid will modify the data in the Column Chart.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.
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The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

For this sample, open the User Guide Sample Listbox. This provides the
data and a visualization to add the Grid component to.

2. Expand the canvas by clicking the Fit Canvas to Window button on the
Standard toolbar.

3. Place a Grid component on the canvas.
4. Double-click the Grid component to open the Properties panel.
5. Click the Data cell selector button; select the range of cells adjacent to

"Insert In Row". This is where data used by the Column Chart is inserted.
6. Place a second Grid component on the canvas, above the first Grid.
7. Double-click the Grid component to open the Properties panel.
8. Click the Data cell selector button; select the column headers of the

Source Data, in this sample the fiscal years.
9. On the Behavior tab of the second Grid, clear the Enable Interaction check

box.

Note: This Grid is acting as a display with text values, therefore users
should not be able to interact with the values.

10. Click the Preview button to view the interaction between the Grid and
Column Chart components.

As you click the values in the Grid and drag the pointer up or down, the
values displayed in the Column Chart will be increased or decreased.

User Guide Sample: History

The History component is linked to a data point, and then records the value
of that point every time it changes. It can also be configured to record the
value at a set time interval.

To open the User Guide Sample file:
1. Select File > Samples.
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2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Play Selector component on the canvas.
3. Double-click the Play Selector to open the Properties panel.
4. Click the Insertion Type dropdown menu; select Row.
5. Click the Source Data cell selector button and select the source data.

For this sample, select the data in the Values column.

6. Click the Destination cell selector button and select an empty cell. For
this sample, select the top left-most cell.

7. Click the Behavior tab. In the Interaction Options section, check all Auto
options.

8. Place a History component on the canvas.
9. Click the History component to open its Properties panel.
10. Click the Data cell selector button and select the same cell as the

Destination cell for the Play Selector.
11. Click the Data Destination cell selector button and select an empty range

of cells.

Note: The size of this cell range will be the maximum number of historical
changes recorded.

12. Click the When Value Changes radio button.
13. Place a Line Chart component on the canvas.
14. Click the Line Chart to open its Properties panel.

Xcelsius 2008 User Guide 125

6Using Xcelsius 2008 Components
Using the Other components



15. Click Data by Range; click the cell selector button and select the same
range of cells as the Data Destination range for the History component.

16. Click the Data in Columns radio button.
17. Click Preview to view the interaction between the History component and

the Play Selector and Line Chart components.

In this sample, the Play Selector has a fixed series of data points. The selector
inserts each point in sequence into a cell of the spreadsheet. The History
component records the value in this cell each time it changes. The Line Chart
then displays the history of changes as recorded by the History component.

User Guide Sample: Reset Button

The Reset Button component can be added to a visualization to allow users
to reset all components to the values displayed when the visualization was
loaded. This sample has three Sliders that affect the value displayed. By
clicking the Reset Button the Sliders and Value component are reverted to
their original values.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Horizontal Slider component on the canvas.
3. Double-click the Horizontal Slider to open the Properties panel.
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4. Click the Title cell selector button and select the title for the Slider; for
this sample, select "Cost per Item".

5. Click the Data cell selector button and select the data for the Slider; for
this sample, select the "Cost per Item" value.

6. Repeat steps 3-5, using "Quantity Sold".
7. Repeat steps 3-5, using "Sales Price".
8. Place a Value component on the canvas.
9. Click the Value to open its Properties panel.
10. Click the Title cell selector button and select the title; for this sample select

"Net Profit".
11. Click the Data cell selector button and select the data for "Net Profit".
12. Place a Reset Button component on the canvas.
13. Click Preview to view the interaction between the Slider and Value

components, and how the Reset Button affects that interaction.

In this sample, the Slider components adjust the value displayed by the Value
component. Clicking the Reset Button clears any adjustments made to the
Sliders and reverts the Value component to its original number.

User Guide Sample: Trend Analyzer

The Trend Analyzer combines data analysis and visualization. The component
analyzes the data selection and provides an additional data series that can
be plotted to display a trend line. The Trend Analyzer does not display in the
visualization.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.
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The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Combination Chart component on the canvas.
3. Double-click the Combination Chart to open the Properties panel.
4. In the Chart box, type "Stock Price Trend Analysis".
5. Click Data by Series; click the plus button to add a series to the list box.
6. In the Name box, type "Price".
7. Click the Values (Y) cell selector button and select the Source Data for

this series; for this sample, select the data under the column header
"Price".

8. Click the plus button to add another series to the list box.
9. In the Name box, type "Trend".
10. Click the Values (Y) cell selector button and select the Source Data for

this series; for this sample, select the empty cells under the column header
"Analyzed Trend Data".

11. Click the Category Labels (X) cell selector button and select the data
labels; for this sample select the data under the column header "Date".

12. Click the Appearance tab; click the Series sub-tab.
13. For the series "Price," click the Type dropdown menu and select Column.
14. For the series "Trend," click the Type dropdown menu and select Line.
15. Place a Trend Analyzer component on the canvas.
16. Click the Trend Analyzer to open its Properties panel.
17. Click the Data cell selector button and select the data to be analyzed for

trending; for this sample, select the data under the column header "Price".
18. In the Trend/Regression Type section, click the Use Best Fit radio button.
19. Click the Analyzed Data Destination cell selector button and select an

empty range of cells for the new data series to be inserted into; for this
sample, select the empty cells under the column header "Analyzed Trend
Data".

20. Click Preview to view the between the Combination Chart component
displayed with a trend line.

In this sample, the Trend Analyzer component analyzes the selected data
and determines a the best way to display a trend line for the data.
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Using the Art and Background
components

Art and backgrounds can be used to enhance your visualizations. The
background components can be used to import images or Flash movies into
your Xcelsius 2008 visualization.

For more information about Art and Background components, see Art and
Background Components Reference on page 337.

Art and background components can be used to customize visualizations:

• Background

Backgrounds are prebuilt artwork that you can add to your visualizations
to assist layout and improve design. Backgrounds can be used to create
divisions and designate groups of related components.

• Image Component

The image component can be used to display JPEG images or SWF files.
You can add your own logos or artwork into an Xcelsius 2008 visualization.
You can also add videos, animations, and other interactive elements by
importing a Flash file.

• Rectangle

A rectangle that you can add to your visualizations to outline, define, or
contain sections.

• Ellipse
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An ellipse or circular shape that you can add to your visualizations to
outline, define, or contain sections.

• Line

A vertical or horizontal line that you can add to your visualizations to
outline, define, or contain sections.

How to use the Image component

Use the Image component to display JPEG images. This allows you to add
your own logos or artwork to an Xcelsius 2008 visualization.

Note: Progressive JPEGs and JPEGs with CMYK coloring, as opposed to
the standard RGB coloring, are not supported.

You can also add videos, animations, and other interactive elements by
importing a Flash files. Since Xcelsius 2008 visualizations are Flash files,
you can use this feature to add an exported Xcelsius 2008 visualization into
another Xcelsius 2008 visualization.

Note: Flash Player versions 9 and later have new security features which
may prevent your Xcelsius 2008 visualization from connecting with an external
data source. Without a policy file, SWF files from one domain cannot access
data on another domain or sub-domain. In addition, SWF files served over
HTTP cannot access data at a HTTPS location. Please refer to the online
article from Adobe regarding security restrictions for data loading for
information on creating a policy file to allow access to data in the cases
above.

Embedding external files

When importing external files into the Image components, you may choose
whether or not to embed the file. If you do so, it will become a part of the
SWF file that is created when the visualization is exported.
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If you choose not to embed the file, at runtime the file will be loaded into the
exported visualization as needed. When the visualization is exported, all of
the non-embedded external files used in the visualization are written out to
a folder with the same name and location as the exported visualization. The
visualization will load the external files from this folder. The visualization and
folder must exist in the same directory for the external files to be loaded
correctly.

The decision to embed the file will depend on your specific needs.

The main advantages for embedding files are as follows:

• Embedded files let you distribute your entire visualization in a single file.

• Dynamic Visibility is faster as reloading is not necessary.

• Embedded files maintain their state when hidden with Dynamic Visibility.

The main advantages for not embedding files as follows:

• Possible runtime performance increases since the external files are
unloaded when they are hidden with Dynamic Visibility.

• Shorter load times for the application since external files are loaded only
when necessary.

• The visualization does not need to be re-exported if external file changes.

Regardless of which option you choose, Xcelsius 2008 stores a local copy
of the file internally in the XLF file. The original file is no longer accessed or
used in the visualization. An XLF file with embedded content can be moved
or emailed and the contents of the file will travel with it. XLF files with
non-embedded content will need to be updated if external files are moved
or the XLF is moved. These XLF files must be emailed or moved with the
folder Xcelsius 2008 created with the same name.

In certain cases, you may not want to use local copies of images, but rather
load an image from a specified URL at runtime.

Nested external files

Xcelsius 2008 lets you use external SWF files in your visualizations. These
SWF files may, in turn, have external assets such as other SWF files, images,
or XML files. The external assets used by the SWF that are referenced with
relative paths must be available from the location of the host visualization.
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For example, if you have a SWF file located at z:\file.swf, which loads an
external image at z:\images\myImage.jpg, and you use the SWF file within
your visualization at c:\visualization.xlf, the SWF file will attempt to load an
image at c:\images\myImage.jpg, which is the location of the visualization.

In the following example, you can insert a corporate logo into your
visualization.

To create an Xcelsius 2008 visualization with an image component
1. Place an Image component on the canvas.
2. Double-click the image component to open the Properties panel.
3. Click Import.
4. Navigate to and select the JPEG or SWF file.
5. Click Open.
6. Select Embed File to have a copy of the image stored in the visualization.

Your logo is imported into the visualization at its default size. You can
now place and resize the image.

Tip: Click Resize Image to Component to prevent the image from loading
and automatically changing the size of the component.

Using theWebConnectivity components
This category contains a group of components that provides options for
linking your visualizations to the Web.

For more information about Web Connectivity components, see Web
Connectivity Components Reference on page 355.

• URL Link Button

A button that links to a relative or absolute URL when pressed.

• Slide Show
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The Slide Show component creates a slide show of URL-based images
and SWF files.

Unlike the normal Image Component, which requires that you first Import
the file, the Slide Show component loads the image at the URL specified
in the URL data source.

Note: When an image is imported into normal Image Components,
Xcelsius 2008 stores its own local copy of the file internally in the XLF
file. The original file is no longer accessed or used in the visualization.
Because the file data is stored within the XLF, the XLF can be moved or
emailed and the contents of the file travels with it. The Slide Show points
to a URL, however, which can change at runtime. This means that the
image does not travel with the XLF. Therefore the image must be available
to the SWF at runtime.

Note: Whenever the Slide Show URL changes, it attempts to load in the
image at that location. Once it has loaded the image, it will transition from
the current image to the new one specified at the URL data source.

Note: Flash Player versions 9 and later have new security features which
may prevent your Xcelsius 2008 visualization from connecting with an
external data source. Without a policy file, SWF files from one domain
cannot access data on another domain or sub-domain. In addition, SWF
files served over HTTP cannot access data at a HTTPS location. Please
refer to the online article from Adobe regarding security restrictions for
data loading for information on creating a policy file to allow access to
data in the cases above.

Note: This component is not available in Xcelsius Present.

• Connection Refresh Button

A button that manually refreshes the connection it is linked to.

Note: This component is not available in Xcelsius Present.

Xcelsius 2008 User Guide 133

6Using Xcelsius 2008 Components
Using the Web Connectivity components



For more about this component, please see User Guide Sample:
Connection Refresh Button – XML Data Connection on page 173.

• Reporting Services Button

The Reporting Services Button component enables you to connect to the
XRS server and select the report that will be used to populate the
visualization.

Note: This component is only available in Xcelsius Engage Server and
BusinessObjects Xcelsius Enterprise.
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Exporting Xcelsius 2008
Visualizations

7



Overview
This section provides information on exporting your Xcelsius 2008
visualizations. All versions of Xcelsius 2008 provide the following export
options:

• PowerPoint
• PDF
• Outlook
• Word
• Acrobat 9
• Adobe AIR

In addition to the above, Xcelsius Engage versions also have the following
options:

• Adobe Flash (SWF)
• HTML

In addition to all of the above options, BusinessObjects Xcelsius Enterprise
also has the following option:

• Export to Business Objects Platform

This option provides the ability to export to either BusinessObjects
Enterprise or Crystal Reports Server.

Exporting your visualization to
PowerPoint

Once your visualization is complete, you can export it as a PowerPoint slide.
You can then modify the slide using Microsoft PowerPoint.

To export an Xcelsius 2008 visualization to
PowerPoint

1. Create an Xcelsius 2008 visualization.
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2. Select File>Export, then select PowerPoint Slide, or click the Export to
PowerPoint button in the toolbar.

The Save As dialog box appears.

3. Enter a name for the PPT file, and click Save.

Xcelsius 2008 generates the PowerPoint (PPT) file and a SWF file with the
same name. The generated PowerPoint file is automatically opened and the
visualization will be visible on the first slide of the presentation. When the
presentation is run, the visualization is dynamic and interactive.

Note: When the visualization is exported, any external files are placed in a
folder with the same name and location as the exported visualization. The
external files must remain in the same folder as the visualization for the
visualization to work properly.

Exporting your visualization to Adobe
PDF

Once your visualization is complete, you can export your content as an
Adobe® Portable Document Format (PDF) file. The PDF file can be viewed
locally, opened in a browser, or deployed on a web site. The visualization is
embedded in the PDF and is dynamic and interactive.

Xcelsius 2008 now supports Acrobat 9. You can save your PDF files to be
compatible with either Acrobat 6 (and later verions) or Acrobat 9.

To export an Xcelsius 2008 visualization to Adobe
PDF

1. Create an Xcelsius 2008 visualization.
2. Select File> Export, then select PDF, or click the Export to PDF button

in the toolbar.

Note: Clicking the Export to PDF button automatically embeds the SWF
file into an Acrobat PDF file. In Xcelsius Present, the default PDF version
is Acrobat 9 (PDF 1.8); in Xcelsius Engage versions, the default PDF
version is Acrobat 6 (PDF 1.5).
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If you selected, File > Export, the Save As dialog box appears.

3. Select the PDF version (Acrobat 6 for PDF 1.5, or Acrobat 9 for PDF 1.8)
you would like your files to be compatible with.

Note: Acrobat 9 will require users to have the latest version of Acrobat
Reader installed in order to view the visualization.

4. Enter a name for the PDF file, and click Save.

Xcelsius 2008 generates the Adobe PDF file. The generated PDF file is
automatically opened and the visualization is visible on the first page of the
document. The visualization in the PDF file is dynamic and interactive.

Note: When the visualization is exported, any external files are placed in a
folder with the same name and location as the exported visualization. The
external files must remain in the same folder as the visualization for the
visualization to work properly.

Emailingyour visualizationwithOutlook
Once your visualization is complete, you can export it using Microsoft Outlook.

To email anXcelsius 2008 visualizationwithOutlook

1. Create an Xcelsius 2008 visualization.
2. Select File >Export, then select Outlook, or click the Export to Outlook

button in the toolbar.

Xcelsius 2008 generates a SWF file. Outlook launches a new email message
window and the SWF file is attached to a new email. You can then customize
and send the email.

Exporting your visualization to Word
When your visualization is complete, you can export it to a Microsoft Word
document. The visualization in the Microsoft Word document is dynamic and
interactive.
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To export an Xcelsius 2008 visualization to Word

1. Create an Xcelsius 2008 visualization.
2. Select File >Export, then select Word, or click the Export to Word button

in the toolbar.

The Save As dialog box appears.

3. Enter a name for the Word document, and click Save.

Xcelsius 2008 generates a Word document and embeds a SWF of your
visualization in the document.

Note: If your visualization in Word is static, on the Microsoft Word Control

toolbar click the Exit Design Mode button .

Exporting your visualization to Flash
Once your visualization is complete, you can export your content as an Adobe
Flash (SWF) file. The SWF file can be executed locally with the standalone
Flash player, opened in a browser, used as part of a web site, or imported
into a number of different programs.

Note: This export option is only available in Xcelsius Engage versions.

To export an Xcelsius 2008 visualization to Flash

1. Create an Xcelsius 2008 visualization.
2. Select File > Export, then select Flash (SWF).

The Export dialog box appears.

3. Enter a name for the SWF file, and click Save.

Xcelsius 2008 generates the Adobe Flash file.

Note: If there are any non-embedded external files in the visualization, a
folder containing those files is also generated with the same name and
location as the exported file. The visualization loads the external files from
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this directory at runtime. The visualization and folder must exist in the same
directory for the external files to be loaded correctly.

Exporting your visualization to HTML
Not all computers are configured to open Flash files in the browser. By
embedding your SWF visualization in an HTML file, you ensure that your
users can view the visualization simply by double-clicking one file. The
generated HTML document references your SWF visualization.

Note: This export option is only available in Xcelsius Engage versions.

To export an Xcelsius 2008 visualization to HTML

1. Create an Xcelsius 2008 visualization.
2. Select File > Export, then select HTML.

The Save as HTML dialog box appears.

3. Enter a name for the HTML file, and click Save.

Xcelsius 2008 generates the HTML file and a SWF file with the same name,
and saves them in the selected directory. These files must be kept together
in order for the HTML file to work properly.

Exporting your visualization to an
Enterprise folder

When your visualization is complete, you can export it to a folder in
BusinessObjects Platform or Crystal Reports Server.

Note: This export option is only available in BusinessObjects Xcelsius
Enterprise versions.
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To export an Xcelsius 2008 visualization to an
Enterprise folder

1. Create an Xcelsius 2008 visualization.
2. Select File >Export, then select Business Objects Platform, or click

the Export to Business Objects Platform button in the toolbar.

The Log On to BusinessObjects Enterprise dialog box appears.

3. Enter your logon information.
• In theSystem field, type the name of the Central Management Console

(CMC) that you want to export the SWF file to.

The CMC stores information about the objects saved to the Enterprise
system. For more information about the CMC , refer to the
BusinessObjects Enterprise or Crystal Reports Server guides.

• In the User name and Password fields, type your logon credentials.

• From the Authentication list, select the authentication type.

If you are unsure of your logon information, contact your system
administrator.

4. Click OK.

The Save As dialog box appears and displays the folder structure of the
Enterprise repository.

5. Select the folder that you want to export the SWF file to, enter a file name,
and click Save.

The SWF file is exported to the Enterprise repository.

Exporting your visualization to Adobe
AIR

Once your visualization is complete, you can export your content as an Adobe
Integrated Runtime (AIR) desktop application. The visualization is exported
as a browserless runtime for rich internet applications (RIAs) that can be
deployed onto the desktop across multiple operating systems.
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Requirements for exporting to Adobe AIR

Xcelsius requires Adobe Flex 3.0 SDK in order to export visualizations to
Adobe AIR. To install the requirement:
1. Download Adobe Flex 3.0 SDK:

http://www.adobe.com/cfusion/entitlement/index.cfm?e=flex3email
2. Unzip Adobe Flex 3.0 SDK in the folder under C:\Program

Files\Adobe\Flex Builder 3 Plug-in\sdks\3.0”

Note: You can change the folder location in file [Xcelsius’s Installa
tion Path]\Xcelsius\assets\air\sdkPath.dat after Xcelsius install.

3. Download Java 2 Runtime Environment (J2RE 1.4 or higher).

Requirements for running exported AIR files

To run the exported AIR file, you will need to download and install the AIR
player.

http://get.adobe.com/air/

To Export your visualization to Adobe AIR
1. Create an Xcelsius 2008 visualization.

2. Select File > Export, then select AIR.

The AIR – Export Settings dialog box appears.
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3. Enter the Application Information:

• Name. Enter the name for the application that will appear on the
installation screen. The default value is the current document name.

• ID. Enter a unique ID that will identify the application. The default value
is “com.air.flash.[DOCUMENT_NAME]”.
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• Version Enter a version number for the application. The default value
is “1.0”.

• Description. Enter a description of the application The description will
appear on the installation screen.

• Copyright. Enter the copyright information for the application. This
information will appear on the installation screen.

Note: Copyright information will only appear for users installing the
application on a Macintosh system. Copyright information will not
appear when installing on a Windows system.

• Window Style. Select the Window Style from the drop-down menu.
The default selection is “System Chrome”.

• Window Size. Specify the size of the window when the application is
run. The default value is the current document size.

4. Select the image files to be used as application icons.

Note: AIR only supports PNG files for application icon images.

Taking a Snapshot of your visualization
In Preview mode, you can interact with the visualization just the same as an
end user will. If you find a scenario or combination of settings while in Preview
mode, you can take a snapshot of the visualization.

To access the Snapshot tool, select File > Snapshot, then select one of the
following export methods:

• Current Excel Data

An Excel spreadsheet (XLS) with the current data values is generated.

Tip: This can be a useful tool for diagnosing dashboards that are not
performing as desired.

• PDF

An Adobe PDF file with the current state of the components is generated.

• PowerPoint Slide
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A Microsoft PowerPoint file with one slide that contains a Flash (SWF)
file with the current state of the components is generated.

• Outlook

A Microsoft Outlook email that attaches the Flash (SWF) file with the
current state of the components is generated.

The following Snapshot export options are only available in Xcelsius Engage
versions:

• Flash (SWF)

A Flash (SWF) file with the changes made in preview mode is generated.

• HTML

An HTML file and a Flash (SWF) file with the current state of the
components is generated.
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Using Advanced Features

8



Overview
This section provides an introduction to the more advanced functionality that
can be used to customize Xcelsius 2008 visualizations.

Dynamic Visibility functionality
For information on the specific dynamic visibility options, see Dynamic
Visibility on page 251.

You can show or hide components in your visualization with dynamic visibility.
For example, you can add a Toggle Button to display a specific chart. The
Toggle Button can be configured to toggle between inserting showChart and
hideChart into a Destination cell when it is selected. By linking the Chart's
status to this Destination cell and setting the Chart's Key to showChart, the
Chart becomes visible when the Toggle Button inserts the value showChart
and hidden when the Toggle Button inserts hideChart.

You may want to switch between a number of components. To accomplish
this, use the Key and a Selector. For example, a visualization might need to
toggle between different charts. To achieve this, give each chart a unique
Key, such as chart1 or chart2. Link each Chart's Status to the same cell in
the spreadsheet. Add a List Box with Source Data that matches the Chart
Keys. As the List Box value is inserted into the Status cell, the corresponding
chart is made visible, while the others are hidden.

User Guide Sample: Dynamic Visibility

Dynamic Visibility allows users to control the visibility of components in a
visualization. In this sample, the Check Box is used to toggle the visibility of
the Line Chart. Clicking the Check Box inserts a certain value into a cell. The
Dynamic Visibility Status of the Line Chart is also linked to this cell. The Line
Chart will appear or disappear depending on whether the value in the Status
cell matches its Dynamic Visibility Key.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
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3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Check Box component on the canvas.
3. Place a Column Chart component on the canvas.
4. Double-click the Check Box component to open the Properties panel.
5. Click the Source Data Manual Edit button and set the values to be inserted

when the Check Box is checked and unchecked. Click OK.

For this sample, use the default values of 0 for Unchecked and 1 for
Checked.

6. Click the Destination cell selector button and select an empty cell from
the spreadsheet.

7. Click the Column Chart to open its Properties panel.
8. Click Data by Series; click the plus button to add a series to the list box.
9. Click the Name cell selector button and select the name of the first series.

For this sample, select "Market Growth."
10. Click the Values(Y) cell selector button and select the data for the first

series.
11. Repeat Steps 8-10 for the second series "Sales Growth."
12. Click the Category Labels (X) cell selector button to select the cells in the

spreadsheet that contain the column headers, for this sample the years.
13. On the Behavior tab, click the Dynamic Visibility Status cell selector button

and select the Destination cell for the Check Box.
14. Set the Dynamic Visibility Key value to match the Source Data of the

Check Box component. For this sample, use the default value of 1.
15. Click Preview to view the interaction between the Check Box and Line

Chart components.
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16. Click the Check Box to display the Line Chart, and un-check to hide the
Line Chart.

Note: By default, the Check Box status is unchecked. Therefore, when you
Preview the visualization, the chart will not be initially visible. Users must
click on the Check Box to enable the chart's visibility. This can be changed
by modifying the Line Chart's Dynamic Visibility Key value, or by changing
the Selected Item to Checked on the Behavior tab of the Check Box
component.

User Guide Sample: Status List

Selector components can be configured to insert different forms of data in
the spreadsheet. This sample provides an example of the Insertion Type:
Status List in conjunction with the Dynamic Visibility functionality. The
visualization has different charts displaying the revenue of the selected
region. Selecting the radio button for a region will display the corresponding
chart.

The Insertion Type: Status List functions so that when a selection is made
on the selector component a value of 1 is entered in the cell of the Destination
range corresponding to that selection, and a value of 0 is entered in all other
cells in the Destination range. For example, if the second of three options is
selected, the values 0, 1, 0 will be inserted into the Destination range.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the below step-by-step instructions,
open the Sample file and then delete the components. These instructions
will produce a working visualization that will demonstrate the use of a
component or feature; additional settings, formats or components may have
been added to enhance the appearance of the sample visualization.

Note: The completed sample XLF file with embedded spreadsheet data, and
SWF file, for this visualization can be located by navigating to the following
location:
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C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Radio Button component on the left side of the canvas.
3. Double-click the Radio Button component to open the Properties panel.
4. Click the Labels cell selector button and select the cells containing the

labels for the buttons from the spreadsheet. For this sample, the cells
should contain the region names.

5. On the Insertion Type list, click Status List.
6. Click the Destination cell selector button and select an empty column of

cells. For Status List, the Destination range must have the same number
of cells as the number of Labels. For this example, the range of cells must
have five cells, one for each of the region names.

7. Place the following charts on the canvas, placing them on top of each
other: Pie Chart, Line Chart, Column Chart, Bar Chart, Pie Chart

8. Using the Object Browser, click on the first Pie Chart to open its Properties
panel.

9. Click the Data Values cell selector button and select the data for the North
America region. Click the Data by Rows radio button. Type the region
name in the Chart box.

10. Click the Labels cell selector button and select the column headers of the
source data. For this sample, select the product names.

11. Repeat steps 8-10 for the second pie chart, using the Australia & Pacific
region.

12. Using the Object Browser, click on the Line Chart to open its Properties
panel.

13. Click Data by Series; click the plus button to add a series to the list box.
14. Click the Values(Y) cell selector button and select the data for the Latin

America region.
15. Type the region name in the Chart box.
16. Repeat steps 12-15 for the Column and Bar Charts, using the Europe

and Asia regions.
17. Using the Object Browser, click the first Pie Chart used for the North

America region.
18. On the Behavior tab, click the Dynamic Visibility Status cell selector button

and select the first cell of the Destination range for the Radio Button. For
this sample, North America is the first Label on the Radio Button; therefore
the North America chart's visibility will correspond to the first cell.
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19. Set the Dynamic Visibility Key to 1.
20. Repeat steps 17-19 for the other charts and their corresponding regions.

Link the Latin America chart's Status cell to the second cell of the
Destination range, and so on according to the spreadsheet order.

21. Click Preview to view the interaction between the Radio Button and Chart
components.

When a region is selected on the Radio Button component, a value (in this
sample Status List was selected, so the value equals 1) is inserted in the
spreadsheet in the cell of the Destination range that corresponds to that
region's position in the list of regions. All of the other Destination range cells
have the value zero (0). The visibility of all the charts is also linked to the
Destination range. Each chart has been configured to be visible only when
its corresponding cell has the value 1 inserted. Since only one cell in the
range has the value 1 at any given time, only one chart at a time is visible.

Ignore End Blanks for variable length
ranges

Series: Ignore End Blanks

Select the Series: Ignore End Blanks option to prevent all of the empty series
past the last non-empty series from being displayed in the Chart. This option
is useful when you need to display a variable number of series in your Chart.

For example, you may want to create a model in which users select a region
and then see statistics for every store within that region all in one chart. Each
series in the Chart would represent one store within the region, and the
values of the series would represent the different statistics for that store.
Since each region may have a different number of stores, Series: Ignore End
Blanks could be enabled so that the number of series displayed in the Chart
could vary to match the number of stores within each region.

For this example:
1. Link the Chart to a range with the same number of series as the maximum

number of stores within any region.
2. Configure your model so that when a user selects a region:

• the store statistics for all of the stores within that region are inserted
into the beginning of the Chart Data range.
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• the rest of the series ranges are filled with empty values.
3. Enable Series: Ignore End Blanks on the Chart.

This feature allows just one Chart to display all of the store statistics for every
region.

Note: Although the Chart may not be displaying all of the data within the
Data range, the performance of the model will be affected by the actual size
of the range.

Values: Ignore End Blanks

Select the Values: Ignore End Blanks option to prevent all of the empty values
past the last non-empty value from being displayed in the Chart. This option
is useful when you need to display a variable amount of data in your Chart.

For example, you may want to create a model in which users select a region
and then see the total sales for every store within that region in a chart. Each
value within the Chart would represent the total sales of one store. Since
each region may have a different number of stores, Values: Ignore End
Blanks could be enabled so that the number of values displayed in the Chart
could vary to match the number of stores within each region.

For this example:
1. Link the Chart to a range with the same number of values as the maximum

number of stores within any region.
2. Configure your model such that when a user selects a region:

• the sales figures for the stores within that region are inserted into the
beginning of the Chart Data range.

• the rest of the Chart Data range is filled with empty values.
3. Enable Values: Ignore End Blanks on the Chart.

This feature allows just one Chart to display all of the sales figures for every
region.

Note: Although the Chart may not be displaying all of the data within the Data
range, the performance of the model will be affected by the actual size of
the range.
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Alerts
For information on Alert tab settings, see Alerts Tab on page 253.

Alerts are commonly used to call the attention of the user to a specific item
or action that has reached some pre-established limits. These limits are often
called targets, budgets, benchmarks, etc. and are a standard to which an
item is compared. In all mature Business Intelligence applications, you will
find the capability to trigger alerts when some conditions are not met. Xcelsius
2008 has one of the most advanced and user friendly Alert methods available.
Its flexibility, use, and application is covered in this section.

Xcelsius 2008 lets you define alerts on most charts and single-value
components. When alerts are enabled on these components, the component
will represent the current level of the alert by displaying the specific color
that corresponds to that level.

How to Use Alerts

Using simple and easy-to-understand methods, you can configure and
customize the Alert levels, colors, methods, etc.

On the Properties panel, select the Alerts Tab. This tab is available for most
Charts and Single Value components. Some Selector components have
Alerts functionality as well.

Note: Alerts can be enabled in Chart components with only a single series.

User Guide Sample: Alerts – Selectors

Alerts can now be added to the following selector components: Label Based
Menu, Combo Box, List Box, List Builder, and Ticker.

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
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the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Place a Label Based Menu component on the canvas.
3. Double-click the Label Based Menu to open the Properties panel.
4. Click the Labels cell selector button and select the labels for the selections

in the menu; for this sample select the product names.
5. On the Insertion Type dropdown menu, select Rows.
6. Click the Source Data cell selector button and select the data

corresponding to the Labels.
7. Click the Destination cell selector button and select a range of empty

cells.
8. Click the Alerts tab; check Enable Alerts.
9. Click the Alert Values cell selector button and select the range of cells

with alert values; for this sample select the "Average Sales" data.
10. Click the By Value radio button.
11. In the Color Order section, click the High Values are Good radio button.
12. Place a Column Chart component on the canvas.
13. Click the Column Chart to open its Properties panel.
14. Click Data by Series; click the plus button to add a series to the list box.
15. Click the Values (Y) cell selector button and select the same range of

cells as the Source Data for the Label Based Menu component.
16. Click the Category Labels (X) cell selector button and select the column

headers of the Source Data range.
17. Click Preview to view the interaction between the Label Based Menu and

Column Chart components.

In this sample, the Label Based Menu can alert the user to values in the
Column Chart that may require closer attention.

Xcelsius 2008 User Guide 155

8Using Advanced Features
Alerts



User Guide Sample: Alerts – Single Value

This sample provides a demonstration of the alert functionality applied to the
Gauge component. The alert levels show the Actual Values vs. the Target
Values for the accounts Revenues, Inventory, and the Cost of Goods Sold.
Using the Slider component, the Actual Values can be adjusted up or down
which will trigger different alert level displays.

To open the User Guide Sample file:

1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.

The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius file that contains the data you would like to
use.

2. Place a Gauge component on the right of the canvas.
3. Double-click the Gauge component to open the Properties panel.
4. Click the Title cell selector button and select the cell containing the title

for the Gauge component. For this sample, use the value "Sales".
5. Click the Data cell selector button and select the Actual Value for Sales.
6. In the Scale section, click Manual. Set the Minimum and Maximum Limits

to 99 and 500 respectively.
7. On the Alerts tab, click Enable Alerts.
8. Click As Percent of Target, click the cell selector and select the Target

value for Sales.
9. In the Color Order section, click High Values are Good.
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10. In the Alert Location section, check both Background and Marker.
11. Place a Horizontal Slider component under the Gauge.
12. Click the Slider to open its Properties panel.
13. Click the Data cell selector button and select the Actual Value for Sales.
14. In the Scale section, click Manual. Set the Minimum and Maximum Limits

to 99 and 500 respectively.
15. Repeat steps 2-14, customizing the second Gauge and Slider components

to display the "Inventories" data. For both components, set the Scale
Minimum and Maximum limits to zero (0) and 108 respectively. For the
Gauge, in the Color Order section, click Middle Values are Good.

16. Repeat steps 2-14, customizing the third Gauge and Slider components
to display the "Cost of Goods Sold" data. For both components: set the
Scale Minimum and Maximum limits to zero (0) and 440 respectively. For
the Gauge: in the Color Order section, click Low Values are Good.

17. Click the Preview button to view the interaction between the Gauge and
Slider components.

Dragging the Slider adjusts the Actual Value of each account. The affect on
the alert display of increasing or decreasing the Actual Value varies based
on whether it should be higher or lower than the Target Value. Sales values
should be high, while the Cost of Goods Sold should be low, and Inventory
amounts should be as close as possible to its Target.

Creating templates
Xcelsius 2008 offers a set of templates you can use to create a new
visualization. You can also create a visualization from scratch and save it
as a template.

To open a template, on the File menu, click Templates. A list of available
Categories is available. Each Category contains a group of templates that
are displayed under the Items section. As you select each template in the
list, a preview of the template is shown on the right side of the screen. You
can click on the selectors to see the intended functionality of the components.
Select a template from the list and click OK.

When selected, the template is inserted on the canvas as a new visualization.
You can now add, delete or modify the template, and save it as a new
visualization or as a modified or new template.
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Note: Templates are not bound to any data. They demonstrate assorted
layouts and combinations of components.

Custom-made templates

You can create your own templates. For example, if you are creating a set
of Portlets for use in your corporate portal, you may want to save your
visualizations as templates so that you can re-use them when updates are
necessary.

To create a new template

1. Create the Xcelsius 2008 visualization you want to save as a template.
2. On the File menu, click Save As.

The Save As dialog box appears.

3. Navigate to:
C:\Program Files\Business Objects\Xcelsius 2008\assets\tem
plate

Note: To create a new Category, create a new folder under the \template
directory of the Xcelsius 2008 installation.

4. Enter a file name for the template, and click Save.
5. On the File menu, point to Export, and click Flash (SWF).
6. Navigate to the templates folder.
7. Enter the same file name for the SWF file that you entered for the

template, and click Save to export the visualization.

Note: Exporting the Flash (SWF) creates the template preview that will
be displayed in the Preview section of the Templates window.

The visualization is now available as a template. The next time you open the
templates window, your template will be available for preview and use.
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Using the Add-on Manager
This feature allows you to install or remove add-ons from within the Xcelsius
application. In addition, you can view the details of any add-ons you have
installed.

To Install an Add-on
1. Select File > Manage Add-Ons from the main toolbar.

2. Click the Install Add-On button.

To Remove an Add-on
1. Select File > Manage Add-Ons from the main toolbar.

The Add-on Manager will display the current add-ons in the left panel.

2. Select the Add-on you want to delete and click the Remove Add-On
button.
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To View the Details of an Add-on
1. Select File > Manage Add-Ons from the main toolbar.

The Add-on Manager will display the current add-ons in the left panel.

2. Select the Add-on you want to view.

The details of the Add-on are displayed in the Add-on Details panel.
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Using the Data Manager
The Data Manager is a central place to configure and manage external
connections in your visualization.

You can configure the following types of connections:

New Connections

• Query as a Web Service (QaaWS)

Note: This connection type is only available in BusinessObjects Xcelsius
Enterprise.

• Web Service Connections
• XML Data Connections
• FlashVariable (flashvars)
• Portal Data
• Crystal Report Data Consumer
• FS Command
• LiveCycle Data Services (LCDS)
• External Interface

Existing Connections

• Excel XML Maps
• Live Office connections

Note: This connection type is only available in BusinessObjects Xcelsius
Enterprise.

The Data Manager can be used to add several types of XML-compliant data
connections to your visualization. The Data Manager will also detect any
existing connection types when a visualization is opened. Some connection
types are not available to add as a new connection, but are supported only
as existing connections in data sources created outside of Xcelsius 2008.
These connection types are listed in the Add menu under Existing: Excel
XML Maps and Live Office Connections.
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To add a connection

1. Select Data > Connections, or click the Manage Connections button in
the toolbar.

The Data Manager dialog box appears.

2. Click the Add button and select a connection type from the list.
3. Configure the connection. See Configuring Connections with the Data

Manager on page 164 for more information.

To remove a connection

1. Select Data > Connections, or click the Manage Connection button on
the toolbar .
The Data Manager dialog box appears.
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2. Select the connection you want ro remove and click the Delete button

at the bottom of the connections list.

Configuring Connections with the Data Manager

This section discusses configuring data connections with the Data Manager.
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Configuring QaaWS connections

Add or edit the following connection parameters for Querying as a Web
Service (QaaWS) Connections:

Note: This Data Connection is only available in BusinessObjects Xcelsius
Enterprise.

Definition Tab
• Name

Type a name for the connection.

• WSDL URL

Type the URL for the WSDL that you would like to bind the connection
to, or select one from the drop-down menu.

• Import

Click on the Import button to bind the connection to the WSDL that was
entered into the WSDL URL text box.
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• Method

Select the method that you would like to bind the Query as a Web Service
Connection.

• Web Service URL

Type the URL for the Web Service, or select a cell from the spreadsheet.

• Input Values

Select a node from the tree to bind the node to the spreadsheet. Selecting
a node enables the Input Value selection icons.

• Read From

Select a cell in the spreadsheet that will provide data for the Query as a
Web Service Connection to read from.

• Output Values

Select a node from the tree to bind the node to the spreadsheet. Selecting
a node enables the Output Value selection icon.

• Insert In

Select a destination cell for the Output Values.
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Usage Tab

See Usage Tab on page 201 for Data Manager Usage Tab options.

Configuring Web Service Connections

Add or edit the following connection parameters for Web Service Connections:

Definition Tab
• Name

Type a name for the connection.

• WSDL URL

Type the URL for the WSDL that you would like to bind the connection
to, or select from the dropdown.

• Import button

Click on the Import button to bind the connection to the WSDL that was
entered into the WSDL URL text box.

• Method
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Select the method that you would like to bind the Web Service Connection
to.

• Web Service URL field

Enter the URL for the Web Service, or click the cell selector to select a
cell in the spreadsheet.

• Input Values

Select a node from the tree to bind the node to the spreadsheet. Selecting
a node enables the Input Value selection icon.

• Read From

Select a cell in the spreadsheet that will provide data for the Web Service
Connection to read from.

• Output Values

Select a node from the tree to bind the node to the spreadsheet. Selecting
a node enables the Output Value selection icon.

• Insert In

Select a destination cell for the output values.

Usage Tab

See Usage Tab on page 201 for Data Manager Usage Tab options.

Advanced Tab

If your Web Service Connection requires information to be passed in the
SOAP Header, enter your information in HTML format into the text field, or
click the cell selector button to select a cell in the spreadsheet.
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Note: When using the cell selector button, the <soap:Header> HTML tags
will be automatically added to the text values contained in the cell. For
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example, the selected cell would only need to contain
“<username>joe</username> <password>1234</password>”.

Configuring the XML Data Connection

With the XML Data Connection, you can refresh visualization data from an
external source through HTTP. The connection can be used to send live
visualization data to an external source; for example, form submission and
data collection.

The data can be refreshed and sent periodically and automatically or on
demand when combined with the Connection Refresh Button component.

Note: Flash Player versions 9 and later have new security features which
may prevent your Xcelsius 2008 visualization from connecting with an external
data source. Without a policy file, SWF files from one domain cannot access
data on another domain or sub-domain. In addition, SWF files served over
HTTP cannot access data at a HTTPS location. Please refer to the online
article from Adobe regarding security restrictions for data loading for
information on creating a policy file to allow access to data in the cases
above.
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The XML Data connection lets you use send and load functionality
simultaneously through one URL. The send ranges are sent to the URL prior
to retrieving the load data. This lets you create scripts which examine the
sent data and return data that corresponds to the values sent —much like a
web request. For example, if a date was sent to a server script, the script
could return the sales figures for that date.

Excel ranges are mapped to XML using a row-column structure. For example,
a one-row, three-column range named "ExampleRange" would be represented
in XML with:
<variable name="ExampleRange">
<row>
<column> Row1 Column1 value </column>
<column> Row1 Column2 value </column>
<column> Row1 Column3 value </column>

</row>
</variable>

where "Row1 Column1 value" would be the actual value of the cell in the
first row and first column of the range, and so on.

The entire group of ranges is encapsulated within <data> tags.

During a load, XML is translated into Excel ranges using the reverse process.

Configuring XML Data Connections

Add or edit the following connection parameters for XML Data Connections:

Definition Tab
• Name

Enter a name for the connection.

• XML Data URL

Type the URL for the button or use the Cell Selector button to select a
cell in the embedded spreadsheet. Any change to the value of this cell
will update the URL button with the link to the new value

Note that http:// is required for hyperlinks.

• MIME Type

Select the MIME Type from the drop-down menu.
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• Enable Load

Select this check box to load the XML data at the URL into the Load
Ranges when the connection is triggered.

• List Box

Select a range in the list box to edit the cell selection for that range.

• Add

Use the Add button to add a new range.

• Remove

Use the Remove button to delete the highlighted range from the
list.

• Name

Type a name for the selected range, or use the cell selector button to
link to a cell in the spreadsheet.

• Range

Use the Range cell selector to select the cells from the spreadsheet.

• Preview XML button

Use the Preview XML button to see the structure of the XML that your
visualization needs to receive data from the external data source.

• Import Named Ranges

Use this button to import named ranges from the spreadsheet.

• Enable Send

Select this check box to send the XML data to the URL from the Send
Ranges when the button is triggered. Edit the ranges that are translated
to XML and sent to the URL. The translated ranges are sent via HTTP
using the POST method.

• List Box

Select a range in the list box to edit the cell selection for that range.

• Add
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Use the Add button to add a new range.

• Remove

Use the Remove button to delete the highlighted range from the
list.

• Name

Type a name for the selected range, or use the cell selector button to
link to a cell in the spreadsheet.

• Range

Use the Range cell selector to select the cells from the spreadsheet.

• Preview XML button

Use the Preview XML button to see the structure of the XML that your
visualization needs to send data to the external data source.

Usage Tab

See Usage Tab on page 201 for Data Manager Usage Tab options.

User Guide Sample: Connection Refresh Button – XML Data Connection
This sample demonstrates a simple XML Data connection that is triggered
by clicking a Connection Refresh Button. This sample also includes the Reset
Button to clear the data retrieved, so that the connection can be refreshed.

To open the User Guide Sample file:

1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.
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The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

1. Open or create an Xcelsius 2008 file that includes the data you want to
use.

2. Open the Data Manager and add an XML Data Connection.
3. Enter the URL where the XML file is hosted. For this sample, use this

URL:

http://www.businessobjects.com/ipl/default.asp?destination=Xcelsius
Marketplace

4. In the MIME Type dropdown menu, select application/x-www-form-urlen
coded.

5. Check Enable Load.
6. Click the plus button to add a range.
7. Click the Range cell selector button and select a range of empty cells

from the spreadsheet. For this sample, select the cells beneath column
headers "Company" and "Quantity".

8. Place a Bar Chart component on the canvas.
9. Double-click the Bar Chart to open the Properties panel.
10. Click Data by Series; click the plus button to add a series to the list box.
11. Click the Values (X) cell selector button and select the data to be

displayed. For this sample, select the cells beneath column header
"Quantity".

12. Click the Category Labels (Y) cell selector button to select the cells in the
spreadsheet that contain the labels; for this sample the cells under column
header "Company".

13. Place a Connection Refresh Button component on the canvas.
14. Click the Connection Refresh Button to open its Properties panel.
15. In the Label box, type "Get Data".
16. In the Available Connections box, check the box next to the XML Data

connection. This will enable the button to refresh the selected connection.
17. Place a Reset Button component on the canvas.
18. Click Preview to view the interaction between the Connection Refresh

Button and Bar Chart components.
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In this sample, the Bar Chart is populated with the data retrieved by the "Get
Data" button (Connection Refresh Button). The Reset Button can be clicked
to clear the data populating the Bar Chart.

User Guide Sample: XML Data (Advanced)

A polling application utilizes both send and load functionality. Votes must be
sent to the server to be tallied and total results must be loaded from the
server. There are five parts to such a procedure:

• Part 1: To configure the XML Data Connection on page 176

Specify the server script that will communicate with the component.

• Part 2: To send the data selection on page 176

Select the cells that will be sent to the server at run time.

• Part 3: (Server-side) To receive data from the XML Data Connection on
page 177

Develop the web script to receive and tally votes.

• Part 4: To load the data selection on page 180

Select the cells that will be updated at run time from the server.

• Part 5: (Server-Side) To send data to the XML Data Connection on
page 181

To open the User Guide Sample file:
1. Select File > Samples.
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.
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The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

Part 1: To configure the XML Data Connection
To create applications that connect to external sources using the XML Data
Connection, you must configure the connection and refresh options.

Each XML Data connection can communicate with a different external source.
This source is specified by a URL on the Definition tab of the Data Manager.
The URL must be available to the generated SWF application at run-time in
order for the data to be sent and loaded correctly.

In this example, votes need to be tallied and up-to-date results displayed.
We can accomplish this by communicating with a server script that interacts
directly with a database. An ASP .NET script called addresults.aspx is used,
but there are no restrictions on how the server script needs to be
implemented.

To configure the XML data connection
1. In the Data Manager, add an XML Data Connection. If you have already

added the connection, select it from the list to edit it.
2. In the XML Data URL box, enter the URL where your server script is

hosted, or use the cell selector button to select the URL from the
spreadsheet..

3. On the Usage tab, ensure that Refresh On Load and Refresh Every
are not selected.

Part 2: To send the data selection
Users can vote on four separate categories using a series of sliders. By
adding the cells that are tied to the sliders to the list of ranges to send, we
can send the vote to the server.

To configure an Xcelsius 2008 visualization to send data to an
external source
1. On the Definition tab, click Enable Send.
2. Click the add button .

A new range is created.

176 Xcelsius 2008 User Guide

Using Advanced Features in Xcelsius Engage9 Using the Data Manager



3. In the Name box, type a name for the range.

For this example, enter the name "Vote".

4. Click the Range cell selector button and select the range of cells to be
sent to the external data source.

Part 3: (Server-side) To receive data from the XML Data Connection
The XML Data Connection sends specified ranges in a row-column structure.
You can view the exact structure that will be sent to the server using the
Preview XML button in the Send section. The server script should expect
this XML structure.

The following example was developed to run on a Microsoft .NET web server.
There are no restrictions on how the web query needs to be implemented.

The server script for the polling application has two functions. It must handle
the data sent from the SWF and, return the updated totals for the poll.

In order to tally votes, the server-side script must examine the incoming XML
data to extract the vote information. Using this information, the script can
then record the vote by inserting it into a database.

The following files make up the server-side implementation of tallying the
votes:

• SendPreview.xml.

An XML file generated by Xcelsius 2008 with the Preview XML button of
the Send section on the General tab of the Properties panel.
<data>
<variable name="vote">
<row>
<column>1.0</column>
<column>1.0</column>
<column>1.0</column>
<column>1.0</column>

</row>
</variable>

</data>

• addresults.aspx.
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A VB script that reads the XML data and adds the parsed vote to the
database.
<%@ Page Language="VB" aspcompat=true Debug="true" vali
dateRequest="false" %>
<%@ Import Namespace="System.Data" %>
<%@ Import Namespace="System.Data.SqlClient" %>

<%

'Get XML that was send from SWF file
Dim sXMLString

dim item as String
For Each item In Request.Form
'Response.Write(item & " = " & Request.Form(item) & VbCrLf)
sXMLString = sXMLString & item & " = " & Request.Form(item)
Next

'Load XML into object
Dim oXML as Object
Dim oNodeList as Object
Dim oNode as Object

oXML = Server.CreateObject("MSXML2.DOMDocument")
oXML.async = False
oXML.validateOnParse = False

'Response.Write(sXMLString)
'Response.Write(oXML.loadXML(sXMLString))
oXML.loadXML(sXMLString)

'Use XPath to get the data
dim sPath as String
sPath = "/data/variable/row/column"
oNodeList = oXML.documentElement.selectNodes(sPath)

'Store data in an array
dim i, aVals(3)
i=0
For Each oNode in oNodeList
With oNode
' Just write the xml for that node to show you.
'Response.Write(.text + "<br>")
aVals(i)=.text
i=i+1
End With
Next

'Insert data into database
Dim sSQL as String ' String variable for building our query
Dim oCon as Object
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dim oCmd as Object
dim sConnect as String

'Define insert statement
sSQL = "INSERT INTO ComdexPoll (Booth, Staff, Demos, Buy)
VALUES (" & aVals(0) & ", " & aVals(1) & ", " & aVals(2) &
", " & aVals(3) & ")"

'Create connection object
sConnect = "Provider=SQLOLEDB;Data Source=yourdb;Initial
Catalog=yourdb;User Id=user;Password=password;"
oCon = Server.CreateObject("ADODB.Connection")
oCon.ConnectionString = sConnect
oCon.Open

'Create command object
oCmd = Server.CreateObject("ADODB.Command")
oCmd.ActiveConnection = oCon
oCmd.CommandText = sSQL

'Execute the command to insert the data
oCmd.Execute()

'Select new totals from the database
dim oRst as Object
oRst = Server.CreateObject("ADODB.RecordSet")
oRst.ActiveConnection = oCon
sSql = "select Sum(Booth) as Booth, Sum(Staff) as Staff,
Sum(Demos) as Demos, Sum(Buy) as Buy, Count(ID) as TotalRecs
from comdexpoll"
oRst.Open(sSql)

'Build XML data to return
dim sXML as String
sXML = "<data>"

'totalData
sXML = sXML & "<variable name=" + chr(34) + "totalData" +
chr(34) + ">"
sXML = sXML & "<row>"
sXML = sXML & "<column>" & oRst("Booth").value & "</column>"
sXML = sXML & "<column>" & oRst("Staff").value & "</column>"
sXML = sXML & "<column>" & oRst("Demos").value & "</column>"
sXML = sXML & "<column>" & oRst("Buy").value & "</column>"
sXML = sXML & "</row>"
sXML = sXML & "</variable>"

'totalEntries
sXML = sXML & "<variable name=" + chr(34) + "totalEntries"
+ chr(34) + ">"
sXML = sXML & "<row>"
sXML = sXML & "<column>" & oRst("TotalRecs").value &
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"</column>"
sXML = sXML & "</row>"
sXML = sXML & "</variable>"

'userDefaults
sXML = sXML & "<variable name=" + chr(34) + "userDefaults"
+ chr(34) + ">"
sXML = sXML & "<row>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "</row>"
sXML = sXML & "</variable>"

'close out the XML data string
sXML = sXML & "</data>"

'Now write the data out so that it gets returned
Response.Write(sXML)

'Cleanup connection vars
oRst.close
oRst = Nothing
oCmd = Nothing
oCon.close
oCon = Nothing

%>

Part 4: To load the data selection
To configure an Xcelsius 2008 visualization to refresh data from an
external source
1. On the Definition tab, click Enable Load.
2. Click the Add button .

A new range is created.

3. In the Name box, type a name for the range.

For this example, enter the name "totalData".

4. Click the Range cell selector button and select the range of cells to be
refreshed.

5. Repeat steps 3-5 to create "totalEntries" and "userDefaults" ranges.
6. Set up the external data source to return the XML.
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You can create an XML file and manually update it as needed or write a
server script that queries a database and translates the results into XML.
Choose an implementation that suits your specific needs.

First configure the XML Data button to enable loading from the external data
source.

Part 5: (Server-Side) To send data to the XML Data Connection
The XML Data Connection expects to receive XML data in the same
row-column format that it uses to send range data. You can view the exact
structure that the connection is expecting by pressing the Preview XML button
in the Load area.

The following example was developed to run on a Microsoft .NET web server.
There are no restrictions on how the web query needs to be implemented.

The server script for our polling application has two functions. It must handle
the data sent from the SWF and return the updated totals for the poll.

To refresh the polling application with the latest results, the server-side script
queries a database to pull the most up-to-date data. The script then converts
the data into the XML structure that the XML Data Connection is expecting.
The XML is sent back to the connection where it is converted into data and
used to update the visualization.

The following files make up the server-side implementation of tallying the
votes:

• LoadPreview.xml

An XML file generated by Xcelsius 2008 with the Preview XML button of
the Load area on the Definition tab of the Properties panel of the
component.
<data>
<variable name="totalData">
<row>
<column>5</column>
<column>10</column>
<column>3</column>
<column>5</column>

</row>
</variable>
<variable name="totalEntries">
<row>
<column>10.0</column>
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</row>
</variable>
<variable name="userDefaults">
<row>
<column>1.0</column>
<column>1.0</column>
<column>1.0</column>
<column>1.0</column>

</row>
</variable>

</data>

• addresults.aspx

A VB script that reads the XML data and reads the new data.
<%@ Page Language="VB" aspcompat=true Debug="true" vali
dateRequest="false" %>
<%@ Import Namespace="System.Data" %>
<%@ Import Namespace="System.Data.SqlClient" %>

<%

'Get XML that was send from SWF file
Dim sXMLString

dim item as String
For Each item In Request.Form
'Response.Write(item & " = " & Request.Form(item) & VbCrLf)
sXMLString = sXMLString & item & " = " & Request.Form(item)
Next

'Load XML into object
Dim oXML as Object
Dim oNodeList as Object
Dim oNode as Object

oXML = Server.CreateObject("MSXML2.DOMDocument")
oXML.async = False
oXML.validateOnParse = False

'Response.Write(sXMLString)
'Response.Write(oXML.loadXML(sXMLString))
oXML.loadXML(sXMLString)

'Use XPath to get the data
dim sPath as String
sPath = "/data/variable/row/column"
oNodeList = oXML.documentElement.selectNodes(sPath)

'Store data in an array
dim i, aVals(3)
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i=0
For Each oNode in oNodeList
With oNode
' Just write the xml for that node to show you.
'Response.Write(.text + "<br>")
aVals(i)=.text
i=i+1
End With
Next

'Insert data into database
Dim sSQL as String ' String variable for building our query
Dim oCon as Object
dim oCmd as Object
dim sConnect as String

'Define insert statement
sSQL = "INSERT INTO ComdexPoll (Booth, Staff, Demos, Buy)
VALUES (" & aVals(0) & ", " & aVals(1) & ", " & aVals(2) &
", " & aVals(3) & ")"

'Create connection object
sConnect = "Provider=SQLOLEDB;Data Source=yourdb;Initial
Catalog=yourdb;User Id=user;Password=password;"
oCon = Server.CreateObject("ADODB.Connection")
oCon.ConnectionString = sConnect
oCon.Open

'Create command object
oCmd = Server.CreateObject("ADODB.Command")
oCmd.ActiveConnection = oCon
oCmd.CommandText = sSQL

'Execute the command to insert the data
oCmd.Execute()

'Select new totals from the database
dim oRst as Object
oRst = Server.CreateObject("ADODB.RecordSet")
oRst.ActiveConnection = oCon
sSql = "select Sum(Booth) as Booth, Sum(Staff) as Staff,
Sum(Demos) as Demos, Sum(Buy) as Buy, Count(ID) as TotalRecs
from comdexpoll"
oRst.Open(sSql)

'Build XML data to return
dim sXML as String
sXML = "<data>"

'totalData
sXML = sXML & "<variable name=" + chr(34) + "totalData" +
chr(34) + ">"
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sXML = sXML & "<row>"
sXML = sXML & "<column>" & oRst("Booth").value & "</column>"
sXML = sXML & "<column>" & oRst("Staff").value & "</column>"
sXML = sXML & "<column>" & oRst("Demos").value & "</column>"
sXML = sXML & "<column>" & oRst("Buy").value & "</column>"
sXML = sXML & "</row>"
sXML = sXML & "</variable>"

'totalEntries
sXML = sXML & "<variable name=" + chr(34) + "totalEntries"
+ chr(34) + ">"
sXML = sXML & "<row>"
sXML = sXML & "<column>" & oRst("TotalRecs").value &
"</column>"
sXML = sXML & "</row>"
sXML = sXML & "</variable>"

'userDefaults
sXML = sXML & "<variable name=" + chr(34) + "userDefaults"
+ chr(34) + ">"
sXML = sXML & "<row>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "<column>5</column>"
sXML = sXML & "</row>"
sXML = sXML & "</variable>"

'close out the XML data string
sXML = sXML & "</data>"

'Now write the data out so that it gets returned
Response.Write(sXML)

'Cleanup connection vars
oRst.close
oRst = Nothing
oCmd = Nothing
oCon.close
oCon = Nothing
%>
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Configuring Flash Variables connections

Add or edit the following connection parameters for Flash Variables
Connections:

Definition Tab
• Name

Type a name for the connection.

• Variable Format

Select XML or CSV format data to send to the SWF file.
• Variable Data

The Name and Range parameters apply to the range that is highlighted
in the Ranges list box.

• Ranges List Box

Select a range in the list box to edit the data for that range.

• Add

Use the Add button to add a new range to receive return XML.

• Remove
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Use the Remove button to delete the highlighted range from the
list.

• Name

Type a name for the selected range or use the cell selector button to
link to a cell in the spreadsheet..

• Range

Click the Range cell selector button to select a range from the
spreadsheet.

• Import Named Ranges button

Use this button to import named ranges from the spreadsheet.

User Guide Sample: Flash Variables connection

With the Flash Variables connection, you can pass data directly to a SWF
file that is hosted in an HTML page. This data is passed to the visualization
before the SWF file loads and lets you initialize your visualization with any
data that is passed in by this method.

Note: This functionality utilizes the FlashVars property of the Adobe Flash
Player. For more information on this functionality please see the "Using
FlashVars to pass variables to a SWF" TechNote on the Adobe web site.

The sample visualization below lists stock market data for several companies
and displays the latest stock data when the file is viewed as a web page.

To open the User Guide Sample file:

1. Select File > Samples
2. Select the User Guide Samples category.
3. Select the file name in the Items section.

The Sample file will contain all components and the corresponding
spreadsheet data. To follow along with the step-by-step instructions, open
the Sample file and then delete the components. These instructions will
produce a working visualization that will demonstrate the use of a component
or feature; additional settings, formats, or components may have been added
to enhance the appearance of the sample visualization.
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The completed sample XLF file with embedded spreadsheet data and SWF
file for this visualization can be located by navigating to the following location:

C:\Program Files\Business Objects\Xcelsius\assets\samples\User Guide
Samples

Also included in this directory is the HTML file of the final visualization.

Step 1: To configure the visualization

1. Create an Xcelsius 2008 visualization to display stock data.
2. Open the Data Manager, click Add, and select Flash Variables connection.
3. In the Name box, type a name for the range.

For this example, type "Flash Variable example".

4. On the Variable Format drop-down menu, select CSV.

For this example, selecting CSV will pass comma separated data to the
SWF file.

5. In the Variable Data area, add a Range by clicking the plus button.
6. Select the added range in the Ranges list box.
7. In the Variable Data Name box, type a name for the range.

For this example, type "StockData".

8. In the Variable Data Range box, use the cell selector button to select the
range of cells to be replaced from the spreadsheet.

For this example, the range of cells should contain the stock data.

9. Click the Close button to exit the Data Manager.

Step 2: To export the visualization

1. On the File menu, point to Export and click HTML.
2. Enter a name for the HTML file, and click Save.

For this example, name the file "Stocks.html".

Note: Export to HTML generates an HTML file and a SWF file of the
same name in the specified location.

3. Open Stocks.html with an HTML editing program such as Microsoft
Notepad.
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4. Find the specified line of code:
• Internet Explorer

<PARAM NAME=FlashVars
VALUE="StockData=Widget%20Maker%20Inc.%2C33.50...

• Netscape/Mozilla
<EMBED src="Stocks.swf" quality=high
bgcolor=#FFFFFF WIDTH="452" HEIGHT="355" FlashVars="Stock
Data=Widget%20Maker%20Inc.%2C33.50...

5. Change the first value (33.50) to 99.50.
6. Save Stocks.html
7. Open Stocks.html with your web browser.

The value change is reflected in Stocks.html.
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Configuring Portal Data

The Portal Data Connection includes three connection types:

• None (Parameter)

• Consumer

• Provider

These connections are added to a visualization that needs to have parameters
defined or that needs to pass or receive data from another web part.

Portal without connection

Portal without connection allows visualization designers to define parameters
that they want the user to customize from within a portal. Different users may
want to see the data in different ways.
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There are three important selections in the Parameter section:

• Name

Name is user-defined and will be displayed for the visualization in the
property dialog box in Sharepoint. Name is required or the parameter will
not be listed as a parameter in Sharepoint.

Type a name or use the cell selector button to link to a cell in the
spreadsheet.

• Range

Range is the area in the spreadsheet where the parameters are set.

Select the range by using the cell selector button to link to a range in the
spreadsheet.

• Type

Type sets the type of parameter. The parameter can be Text, Number,
Check Box, Date, or List Box.

• Text is used to set any text based data within the XLF. For example,
chart titles.

• Number is used to set any numeric based data. For example, alert
levels.

• Check Box is useful for toggling the value of a cell between zero and
one. It can be used for showing or hiding components using Dynamic
Visibility.

• Date is used to define a date in the XLF. It sets the format to Date and
uses a true date value within the XLF. For example, this type can be
used to set date ranges for data access or for amount of data to
display.

• List Box enables the designer to build user selection options into the
parameters. When List Box is selected, two more options become
available.

• Entries

Entries is used to set what entries are available for the user to
select.

• Default Selection
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Default Selection is used for selecting which entry's value will be
used by default if the user does not make a selection.

The List Box Type allows the designer to specify set values that can
be selected by the user. Text, Number, Check Box, and Date allow
the user to enter any value into the parameter. If the value they enter
is not compatible with the visualization, the correct behavior will not
occur. The List Box type eliminates this issue because the user must
select from values the designer provides.

Portal Consumer Connection

The Portal Consumer connection should be added to any visualization that
will accept data from a web part within the portal. In addition to the
Parameters, there are three important selections to configure on the
Properties panel of the Consumer connection: Range Name, Range Type,
and Range.

• Range Name

Range Name is user-defined and is displayed when connecting web parts
together in Portals. Range Name is required or the web parts cannot be
connected together.

• Range Type

Range Type defines the amount of data that will be passed. Cell consumes
a single cell from another web part. Row is a single row with multiple
columns. Table is multiple rows and columns. If another visualization is
passing in data, the most likely type to select is Cell or Row. Table is used
to pass data from a Portal list.

• Range

Range is the area on the internal spreadsheet of the visualization that
the incoming data will be written to.

Portal Provider Connection

The Portal Provider Connection should be added to any visualization that
will provide data to another web part. In this case only Xcelsius 2008 Portal
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web parts can be used to consume information from a visualization that is
using the Portal Provider connection.

The Portal Provider contains the same options as the Portal Consumer
connection. See above for details about these three options.

Usage Tab
The Usage Tab for the Portal Data connection is only available with Portal
Provider type connections.

See Usage Tab on page 201 for more information.

Configuring Crystal Report Data Consumer
Connections

Add or edit the following connection parameters for Crystal Report Data
Consumer Connections:

Definition Tab
• Row Headers

Use the Cell Selector button to select a row header in the spreadsheet.

• Column Headers
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Use the Cell Selector button to select a column header in the spreadsheet.

• Data

Use the Cell Selector button to select a data range in the spreadsheet.

• Description

Type a description for the Data Connection that will be saved with the
file.

Configuring FS Command Connections

For detailed information about FS Command, see the Adobe Flash support
site at http://www.adobe.com/support/flash/action_scripts/actionscript_dictio
nary/actionscript_dictionary372.html

Definition Tab
• Name

Type a name for the connection.

• Command

Use the Command field to type a command for the FS Command, or click
the Cell Selector button and select a command in the spreadsheet.

• Parameters

Use the Parameter field to type a parameter value for the FS Command,
or click the Cell Selector button and select a value in the spreadsheet.
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Usage Tab

See Usage Tab on page 201 for details on the Data Manager usage
configurations.

Configuring LCDS connections

LiveCycle Data Services, a component of Adobe LiveCycle Enterprise Suite
software, provides up-to-second views of your business data via dashboards
connected to Adobe LiveCycle Data Services. The LCDS connection streams
real-time data into interactive visualizations, animated charts and graphs,
financial presentations, or business calculators, delivering meaningful
information in a visually engaging way.

Add or edit the following connection parameters for Live Cycle Data Services
(LCDS) connections:

Definition tab
• Dropdown menu
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Select the LCDS host connection to be associated with this connection.
If no hosts are listed, click the Host button to add a new host.

• Host button

Click the Host button to launch the Edit a Host dialog box.
• Name

Type a name for this LCDS host.

• URL

Type the URL to the LCDS server to connect to.

Basic structure:
http://<server name>:<port>/<LCDS context path>/xcelsius

e.g.
http://localhost:8700/flex/xcelsius

Click OK to add the Host and return to the Data Manager

• Query button

Click on the Query button to retrieve information on what feed destinations
are available from the LCDS host selected in the dropdown menu.

• Available Data Destinations

Select one of the available feed destinations to bind to the CX model.

• Id:

The Id of the LCDS feed destination.

• Description:

The description of the feed destination.

• Advanced button

Click the Advanced button to expand the settings available for the selected
feed destination.

• Id:

The Id of the LCDS feed destination.
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• Channel Type:

The type of channel (or communication protocol) that is being used.

• Channel URL:

The URL associated with the selected feed destination.

• Destination Data

This section lists the Data Elements available from the selected Host.
Select a Data Element, and then click the cell selector button on the
bottom right to select a range in your spreadsheet.

• Data Element:

The data element(s) that are being returned by the feed destination.

• * Data Type:

The data type of the element:

• Number
• Txt
• True/False (Boolean)

• Shape:

Describes the shape or structure of the data that is returned for this
element:
• Singleton (single value)
• 1D (a column or row of values)
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• 2D (a table of values)

Configuring LiveOffice Connections

Edit the following connection parameters for LiveOffice:

Note: This Data Connection is only available in BusinessObjects Xcelsius
Enterprise.

Note: The Range option of the Live Office connector does not control how
many columns are returned in an XLF file. This option controls only how
many rows of data are returned. This behavior is by design.

LiveOffice Web Services URL

Use this field to enter the location of the Live Office Web Services that the
visualization will use to connect to Live Office data.

LiveOffice Connections

• Views
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The Views area lists the Live Office Views that are used as data sources
in the XLF file.

• Ranges

The Ranges area lists the Excel ranges that can be selected for refresh
in the XLF file. The ranges are split into headings and data grid.

Click the Cell Selector button below the Ranges area to select a different
range of cells to refresh.

For more information about using LiveOffice connections, see Using
LiveOffice data for Xcelsius 2008 visualizations on page 212.

Configuring Excel XMLMaps Connections

Xcelsius 2008 supports the XML functionality that was introduced in Excel
2003. Excel supports the ability to embed XML documents and schemas
into a spreadsheet. These files can be imported in Xcelsius 2008; the Xcelsius
2008 SWF files will retain the link to the XML source generated.

Note: Data that has been mapped using the Excel mapping functionality
can be manually refreshed by using a Connection Refresh button in your
visualization.
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Note: If a Dynamic URL is used with the XML Map feature and an interval
refresh, it must be bound to an Excel cell that contains a formula.

Building the visualization

After the Excel file has been set up, the next step is to build your visualization
and configure the XML Map Options.

For information on setting up the Excel file with an XML map, refer to the
on-line help in Microsoft Excel.

Name

The Name field displays the name of the XML Map. This field cannot be
updated.

XML Data URL

The XML Data URL provides the URL of the data's external location. The
location can be edited by typing or using the cell selector button to select a
cell with the new URL.

Sample visualization: Excel spreadsheetwith anXML
map

This sample creates a visualization that lists stock market quotes for several
companies based on data in an XML file. After the data has been imported
into an Excel file you can use Xcelsius 2008 to build a visualization that
retains the link to the XML data source. This means that changes to the XML
file will be reflected in the exported SWF file.

This visualization will display share price information for several companies.
The stock information is contained in an XML file that has been imported
into the Excel file and mapped to a range of cells. A Spreadsheet Table
component has been bound to the range of cells to display the data.

To open the User guide Sample file:
1. Select File > Samples.
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2. Select the User Guide Samples category.
3. Select the file name in the Items section.

Also included in this directory is the HTML file of the final visualization.

1. Import an Excel file with XML mapped data.
2. Place a Spreadsheet Table component on the canvas.
3. Double-click the Spreadsheet Table to open the Properties panel.
4. Click the Display Data cell selector button.
5. Select the range of data in the spreadsheet, and click OK.
6. Open the Data Manager, click the Add button; select Excel XML Maps

connection.

The connection parameters will be filled in per the existing connection's
parameters.

7. Export the visualization to an HTML file.

Note: Xcelsius 2008 generates the HTML file and a SWF file with the
same name and saves them in the selected directory. These files must
be kept together in order for the HTML file to work properly.

Once the visualization has been exported, you can open the HTML file in
your web browser. Changes made to the source XML file will be reflected in
your HTML file.

Configuring External Interface Connections

External Interface connections allow visualization developers to expose
selected data ranges of the spreadsheet. This essentially creates a generic
framework for getting data into and out of the SWF file of the exported
visualization. It also provides built-in eventing so that it is instantly recognized
when a particular data source has changed (e.g. Slider component is dragged
and updates a cell’s data, etc).

Add or edit the following connection parameters for External Interface
connections:

Definition tab
• Range Name
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Enter a name for the range, or click the cell selector to select a cell in the
spreadsheet.

• Range Type

Select one of the following from the dropdown menu:

• Cell – the data range consists of a single cell

• Row/Column – the data range is in a single row or a single column

• Table – the data range has more than one column or row

• Range

Click the cell selector button to select a range from the spreadsheet.

• Access

Select one of the following from the dropdown menu:

• Read – an external application will be able to be read data in the range

• Write – an external application will be able to be write data into the
range

• Read/Write – an external application will be able to be read data in
the range and write data into the range

Usage Tab

The Usage Tab contains the Refresh and Load Status options.

Refresh Options
• Refresh On Load

Use this option to refresh the data when the visualization loads.

• Refresh Every

Use this option to automatically refresh the XML data. Enter the interval
value, then select a time unit (minutes, seconds, etc.) from the drop-down
menu.

• Refresh on Trigger
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Use this option to select a cell that will trigger the visualization to refresh
the data. Use the Cell Selector to select the spreadsheet cell that will
define the Trigger Cell, then set the trigger options:
• When Cell Updates. This option triggers a refresh when the Trigger

Cell is updated, even if the value of the cell does not change.

• When Value Changes. This option triggers a refresh when the value
in the Trigger Cell changes.

• When Value Equals. This option triggers a refresh when the value in
the Trigger Cell equals the target value. Type a target value, or use
the cell selector to link to a spreadsheet cell that contains the trigger
value.

Load Status
• Loading Message

Use this option to specify a message that is displayed while the
visualization is loading. Type your message in the entry field, or use the
cell selector to link to a cell in the spreadsheet.

• Idle Message

Use this option to specify a message that is displayed while the
visualization is idle. Type your message in the entry field, or use the cell
selector to link to a cell in the spreadsheet.

• Insert In

Use the cell selector button to select the spreadsheet cell that Loading
and Idle Messages will be inserted into.

• Enable Load Cursor

Use this to display the cursor while the data is loading.

• Disable Mouse Input on Load

Use this to disable mouse input while the data is loading.
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Xcelsius 2008 IntegrationwithSQLServer
Reporting Services

Xcelsius 2008 and SQL Server Reporting Services

Xcelsius 2008 uses Xcelsius Reporting Services (XRS) to dynamically
populate Xcelsius 2008 visualizations based on SQL Server Reporting
Services (RS) data. XRS allows users to connect to an RS report through
the Xcelsius 2008 interface and to create visualizations that can easily be
updated.

Xcelsius 2008 Reporting Services server

You can perform the following tasks within the Reporting Services (RS)
server:

• Configure reports and how they run.

• Set user security and viewing rights.

• Configure caching and scheduling for reports

Note: You can only do this is you have administrative rights.

The Web.config file located at <drive>:\inetpub\wwwroot\xrs is where
this server configuration occurs. The most important section of this file, where
the configuration takes place, is shown here.
<appSettings>
<add key="ReportingServicesUrl" value="http://xrsdemo-sd/Re

portServer" />
<add key="ReportServerUrl" value="http://xrsdemo-sd/Reports"
/>
<add key="XrsServicesUrl" value="http://xrsdemo-sd/xrs" />

</appSettings>
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Xcelsius 2008 Portal Integration

Xcelsius 2008 for Portals

Xcelsius 2008 support for portals enables you to create dashboards within
the portal environment. Portal integration supports Sharepoint and
Websphere. Administrators can provide complex visualizations or simple
Xcelsius 2008 components that can be customized by users.

Xcelsius 2008 supports the following Portal scenarios:

• Visualizations can be connected to Sharepoint lists.

• Visualizations can communicate with one another. This scenario is useful
for what-if analyses or drill-downs.

• Users can customize their visualizations, such as the data, components,
alert levels, date ranges, and default parameters that will be used.

For more information about integration with Websphere, see the
documentation included in the Xcelsius 2008 installation CD.

Deploying Xcelsius 2008 Visualizations
to Microsoft Sharepoint

Xcelsius 2008 for Sharepoint server

Xcelsius 2008 for Sharepoint server (XSP) installs a web part container into
the Sharepoint web part library. After installation and configuration, the web
part container can be added to the Web Part Gallery within Sharepoint and
any user with the appropriate rights can add the web part container to a page
within the site.

Deploying visualizations in Sharepoint

This section outlines the steps required to deploy Xcelsius 2008 visualizations
in Sharepoint
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Step 1: Add Xcelsius 2008 to a Sharepoint web page

1. Navigate to the web page that the visualization will reside in.
2. Go to Modify Shared Page > Add Web Parts > Browse to open the

Web Part Gallery.
3. Locate the Xcelsius 2008 Sharepoint Connector and drag it to the location

on the page where the visualization will reside.

Step 2: Configure the Xcelsius 2008 Sharepoint web
part

1. Click the down arrow on the Xcelsius 2008 Sharepoint Connector, then
click Modify Shared Web Part.

The Properties dialog box opens. The property used during this initial
configuration is Xcelsius 2008 Visualization Source.

2. Import the visualization that you are configuring.

To populate the web part with a visualization, that visualization should
already be imported into the Sharepoint library of documents. It is usually
best to create a document list for all visualizations so they can be
accessed from the same location.

3. Click the link to open the imported visualization and find its exact URL.
4. Copy the URL into the Xcelsius 2008 Visualization Source field on the

Web Part properties dialog box and click Apply.

The visualization appears in the web part on the page. If there are any
parameters defined in the visualization, they appear on the Property dialog
box below the Width parameter. These parameters can be set at anytime
by navigating to the property dialog box, setting the parameters and
clicking Apply.

Note: Parameters can be of 5 types: Text, Numeric, Check Box, Date, and
List Box. They can be used to set the value of any cell within the visualization.
More information about parameters can be found in the description of the
Sharepoint Parameter component in the XSP client section.
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Step 3: Connect the web part to other web parts

When in modify Shared web part mode the user can also connect the
visualization to other visualizations or to other web parts that can pass it
data, such as a Sharepoint List.

1. Click the down arrow on the Xcelsius 2008 Sharepoint Connector then
click Modify Shared Web Part.

2. Click the down arrow on the web part then click Connections.

If Connections is unavailable, the visualization was not configured to
connect to another web part.

If Connections is available, after you click it you will see options such as
Consume Row, Send Value, Get Value, and Send list. This means that
the visualization is configured to either send information to another web
part (Provider) or receive information from another web part (Consumer).
These options are discussed in more detail in the Sharepoint Consumer
and Sharepoint Provider component sections of this chapter.

3. If a visualization has been configured to receive a value from another
visualization, add both visualizations to the page.

4. Click the down arrow on the web part then click Connections.
5. ClickGet value from and select the other Xcelsius 2008 Sharepoint Web

Part.

The two visualizations are now connected.

These connections can be configured in many ways to allow for What-If
analysis, drilling down to more detailed data, or to allow a user interaction
in one visualization to affect other visualizations.

Note: Xcelsius 2008 visualizations support consumer and provider
connections, but are limited to either a single consumer connection or a
single provider connection.
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Business Objects Platform Integration

Overview

BusinessObjects Xcelsius Enterprise enables you to create interactive
presentations from managed Enterprise data. Using the LiveOffice
connections in BusinessObjects Xcelsius Enterprise and the Live Office Web
Services in BusinessObjects Enterprise XI Release 2 (XI R2) or Crystal
Reports Server XI R2, you can create and refresh visualizations against
managed Enterprise data.

This chapter discusses how to use Excel spreadsheets built with LiveOffice
as data sources for Xcelsius 2008 files. It also discusses how to manage
Xcelsius 2008 XLF files and SWF files in BusinessObjects Enterprise or
Crystal Reports Server.

Note:

• The functionality discussed in this chapter is only supported in
BusinessObjects Enterprise XI R2 and Crystal Reports Server XI R2.

• Single Sign-on is not supported in this release.
• This document assumes working knowledge of LiveOffice and

BusinessObjects Enterprise or Crystal Reports Server.

Terms used in this document

There are terms used in this document that you may not be familiar with.
Look at this list to see what these terms refer to.

• XLF

This is an Xcelsius 2008 design file. It is the file that is created by Xcelsius
2008 and is where all the functionality of the visualization is configured.

• SWF

This is an Adobe Flash file. Xcelsius 2008 uses Adobe Flash to render
interactive files.

• Xcelsius 2008 Visualization
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This term is used for the final output of an Xcelsius 2008 file. For example,
when you create a file in Xcelsius 2008 and export it to PowerPoint, the
PowerPoint file is an Xcelsius 2008 Visualization.

• LiveOffice-enabled

This term is used to describe an Excel spreadsheet that is created with
LiveOffice as the data source.

Moving from an unmanaged environment to a
managed environment

If you have upgraded from the Crystal Vision bundle, you likely have
LiveOffice report views that are based on unmanaged Crystal Reports. To
take advantage of the refresh capabilities of the LiveOffice connections in
Xcelsius 2008 and the viewing and distribution capabilities of BusinessObjects
Enterprise or Crystal Reports Server, you must move to managed files. You
can publish your unmanaged Crystal Report to BusinessObjects Enterprise
or Crystal Reports Server and then update your visualizations to take
advantage of the functionality available in Xcelsius 2008.

This section outlines the steps to move from an unmanaged environment to
a managed environment. It does not describe each step in detail but instead
gives an overview of the workflow involved. For detailed information on how
to perform each step, referred to the appropriate product guide.

To move to a managed system

1. Publish your unmanaged Crystal Reports to Crystal Reports Server or
BusinessObjects Enterprise.

For detailed information about how to publish reports, refer to the chapter
"Publishing Reports to Crystal Reports Server" in the Crystal Reports
Server XI Release 2 Installation Guide or the chapter "Publishing Objects
to BusinessObjects Enterprise" in the BusinessObjects Enterprise XI
Administrator's Guide.

2. In Live Office, set the location of the report view that you want to update
to be managed. Set this location to the location of its new managed report
source.
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For detailed information about how to set the location of a Live Office
report view, refer to the chapter "Creating Report Views from Unmanaged
Reports" in the Live Office User Guide.

3. Open the XLF that you want to modify with the updated report view.
4. In the Data Manager, add and configure a LiveOffice connection to the

XLF.

For detailed information about how to do this, see Creating an Xcelsius
2008 visualization from a LiveOffice- enabled Excel spreadsheet on
page 212. Specifically refer to the procedure called "To make the Xcelsius
2008 file refreshable".

5. Save the XLF file to your Enterprise system or export a SWF file to your
Enterprise system.

For detailed information about how to do this, see Storing Xcelsius 2008
files in Crystal Reports Server or BusinessObjects Enterprise on page 216.

UsingLiveOffice data for Xcelsius 2008 visualizations

With Xcelsius 2008, you can create Xcelsius 2008 XLF files and SWF (Adobe
Flash files) using Excel spreadsheets constructed from managed Crystal
Reports or Web Intelligence data.

The LiveOffice Web Services in Crystal Reports Server and BusinessObjects
Enterprise enables you to refresh Xcelsius 2008 SWF files and Xcelsius
2008 Visualizations from within InfoView. The BusinessObjects Enterprise
Web Services enables you to refresh the data from outside InfoView, as long
as you can connect to your Crystal Reports Server or BusinessObjects
Enterprise system.

Depending on the data that is contained in the Excel spreadsheet, you can
perform a variety of tasks in Xcelsius 2008 that allow you to interact with
Enterprise data.

Creating an Xcelsius 2008 visualization from a LiveOffice-
enabled Excel spreadsheet

You can create an Xcelsius 2008 Visualization using data in a
LiveOffice-enabled Excel spreadsheet. LiveOffice-enabled means that the

212 Xcelsius 2008 User Guide

Using Advanced Features in BusinessObjects Xcelsius Enterprise11 Business Objects Platform Integration



data in the spreadsheet is actually a View created from either managed
Crystal Reports or managed Web Intelligence documents.

After you have imported a LiveOffice-enabled file into Xcelsius 2008, you
can also make it refreshable against the source data by configuring the
LiveOffice connection in the Xcelsius 2008 Data Manager.

Note: The following procedures assume a working knowledge of LiveOffice.

When launching the program, Xcelsius 2008 will detect if LiveOffice is installed
on the user’s machine. If LiveOffice is detected, the following dialog box will
appear.

In order to use LiveOffice with the embedded spreadsheet inside of Xcelsius,
Live Office Compatibility Mode must be enabled. If you choose to enable
Live Office Compatibility Mode, the performance of other Microsoft Office
programs may be affected. If you choose not to enable Live Office
Compatibility mode, you will need to work with Live Office in a spreadsheet
outside of Xcelsius and then import your spreadsheet. Live Office
Compatibility Mode, can be enabled and disabled by going to File >
Preferences > Excel Options; check or clear the Enable check box under
Live Office Compatibility. The selection made will be retained when Xcelsius
2008 is closed.

To create an Xcelsius 2008 Visualization using LiveOffice
1. Import an Excel spreadsheet that contains LiveOffice data.
2. Open the Data Manager and click Add.

A list of connection types appears.

3. Select LiveOffice connections.
4. Configure each of the LiveOffice views.
5. Select the refresh options on the Usage Tab in the Data Manager.

To make the Xcelsius 2008 file refreshable
1. Open the Data Manager and select the LiveOffice connection you want

to refresh. .
2. On the Definition tab, type the URL into the Live Office Web Services

URL field.

The default URL listed in the field is:

http://<webserver>:8080/dswsbobje/services/session
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If your BusinessObjects Enterprise or Crystal Reports Server has a default
Web Services installation, replace <webserver> in the default URL with
the name of your CMC to correctly complete the URL.

The URL is cached so that you do not have to type it in each time you
configure the LiveOffice connection.

3. On the Definition tab, click the View that you want the LiveOffice
connection to refresh against.

Note:

• If your Excel spreadsheet contains more than one View, you can
choose one, some, or all of the Views listed in the Views area of the
Definition tab. Only the data from the Views you choose will be
refreshed when the Xcelsius 2008 file is refreshed.

• You can increase the range of cells that your Xcelsius 2008
visualization is able to accommodate so that if the data grows, your
Xcelsius 2008 visualization will continue to analyze the full data set
properly.

In the Ranges area of the Definition tab, you will see the cell ranges that
have been imported for the selected view.

To increase the original range that you selected:

a. Click the range that you want to adjust.
b. Click the cell selector button under the Ranges area.
c. Select a new range from your spreadsheet and click OK.

The new cell range is reflected in the field next to the cell selector
button.

4. On the Usage tab, set the refresh options you want.
• Refresh on Load automatically refreshes the data whenever you open

the file.

• Refresh on Interval automatically refreshes on the time interval you
specify. The time is measured in seconds.

• If you do not select either of these options, the refresh will be manual.
You will need to add and configure a Connection Refresh button to
the visualization, which the end user can click to refresh the connection.

5. Export your XLF file to any format you choose.
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Depending on what option you chose in step 4, the Xcelsius 2008
Visualization will be refreshed when you open it, when you click the
Connection Refresh Button, or at the set time interval.

Note: You can set additional refresh options with a Connection Refresh
Button. SeeWeb Connectivity Components Reference on page 355 for more
information.

Passing parameters from Xcelsius 2008 to LiveOffice

You can pass parameter values from an Xcelsius 2008 visualization or SWF
file to LiveOffice by taking advantage of Xcelsius 2008's ability to pass values
to an Excel spreadsheet. This way, you can input parameter values in your
visualization and have the correct data returned from the data source.

To pass a parameter to LiveOffice
Note: This procedure requires a LiveOffice-enabled Excel spreadsheet with
a bound parameter. The spreadsheet must require user input for the
parameter when it is refreshed.

1. Place a Single Value component such as a dial or a slider on the canvas.
2. On the General tab of the Single Values properties browser, click the cell

selector button next to the Data field.
3. Click the cell that contains the bound parameter and then click OK.
4. Repeat steps 1 through 5 outlined in To create an Xcelsius 2008

Visualization using LiveOffice on page 213.
5. On the Usage tab, click the Cell Selector button beside the Trigger Cell

field.
6. Click the cell that contains the bound parameter and then click OK.
7. Ensure that Trigger on Change only is selected.

Configuring the Trigger Behavior this way causes the SWF to refresh
each time there is a change to the cell and in this case, the parameter
value.

8. Click the Preview button to generate a SWF file.

When you adjust the Single Value component in the SWF file, you receive
a prompt to log on to your Enterprise system. When you have successfully
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logged on, the data is refreshed and the new value or values are reflected
in your SWF file.

Storing Xcelsius 2008 files in Crystal Reports Server
or BusinessObjects Enterprise

You can use BusinessObjects Enterprise or Crystal Reports Server as a
secure repository to store and manage XLF and SWF files. Once the files
have been added to the Enterprise system, any user with the appropriate
rights can log on and view the XLF and SWF files.

Saving XLF files to an Enterprise folder

Once you have created an XLF file, you can save it to a folder in
BusinessObjects Enterprise or Crystal Reports Server.

To save an XLF file to an Enterprise folder
1. In Xcelsius, on the File menu, click Save to Enterprise.

The Log On to BusinessObjects Enterprise dialog box appears.

2. Enter your logon information.
• In the System field, type the name of the Central Management console

(CMC) where you want to save the XLF file.

The CMC stores information about the objects saved to the Enterprise
system. For more information about the CMC, refer to the
BusinessObjects Enterprise or Crystal Reports Server guides.

• In the User name and Password fields, type your logon credentials.

• On the Authentication list, click the appropriate authentication type.

If you are unsure of your logon information, contact your system
administrator.

3. Click OK.
4. Select the folder where you want to save the XLF file, enter a file name,

and click Save.

Tip: To add a folder to the CMC, click New Folder.
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Opening XLF files from an Enterprise folder

When an XLF file is saved to an Enterprise folder in BusinessObjects
Enterprise or Crystal Reports Server, it can also be opened from that location.

To open an XLF file from an Enterprise folder
1. In Xcelsius 2008, on the File menu, click Open from Enterprise.

The Log on to BusinessObjects Enterprise dialog box appears.

2. Enter your logon information.
• In theSystem field, type the name of the Central Management Console

(CMC) that you want to open the XLF file from.

The CMC stores information about the objects saved to the Enterprise
system. For more information about the CMC, refer to the
BusinessObjects Enterprise or Crystal Reports Server guides.

• In the User name and Password fields, type your logon credentials.

• From the Authentication list, select the authentication type.

If you are unsure of your logon information, contact your system
administrator.

3. Click OK.

When you have successfully logged on to your Enterprise system, the
folder structure of your Enterprise system appears in the Open dialog
box.

4. Select the folder that contains the XLF file you want to open, and click
Open.

The XLF file opens in Xcelsius 2008.

Exporting SWF files to an Enterprise folder

You can export a SWF file generated within Xcelsius 2008 to a folder in
BusinessObjects Enterprise or Crystal Reports Server.

To export a SWF file to an Enterprise folder
1. In Xcelsius 2008, open the XLF file.
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2. On the Filemenu, point to Export, and clickBusinessObjects Platform.

The Log On to BusinessObjects Enterprise dialog box appears.

3. Enter your logon information.
• In theSystem field, type the name of the Central Management Console

(CMC) that you want to export the SWF file to.

The CMC stores information about the objects saved to the Enterprise
system. For more information about the CMC, refer to the
BusinessObjects Enterprise or Crystal Reports Server guides.

• In the User name and Password fields, type your logon credentials.

• On the Authentication list, click the appropriate authentication type.

If you are unsure of your logon information, contact your system
administrator.

4. Click OK.

The Save As dialog box appears and displays the folder structure of the
Enterprise repository.

5. Select the folder that you want to export the SWF file to, enter a file name,
and click Save.

The SWF file is exported to the Enterprise repository.

Managing Xcelsius 2008 files in Crystal Reports
Server or BusinessObjects Enterprise

The Enterprise system allows you to manage Xcelsius 2008 files through
InfoView and the Central Management Console (CMC).

You can perform the following tasks with XLF and SWF files in InfoView:

• View a list of your XLF and SWF files.

• Search for specific files.

• Move or copy files to different folders.

• View and refresh SWF files in InfoView.
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If you have administrative rights to the Enterprise system, you can modify
the edit and view rights for XLF and SWF files within the Central Management
Console (CMC).

Note: You cannot view XLF files in InfoView. To view XLF files that have
been added to the Enterprise system, you must open the XLF file within
Xcelsius 2008. For more information, see Opening XLF files from an
Enterprise folder on page 217.

With the release of Crystal Reports 2008, it is now possible to embed an
Xcelsius-generated SWF file into a Crystal Report and have the SWF
consume data from that report. When set up properly, refreshing the data in
your Crystal Report will update the embedded SWF.

To configure your Xcelsius SWF to consume data from its Crystal Rport
source data, you must open the Data Manager in Xcelsius and add a new
Crystal Report Data Consumer connection. After adding the connection, bind
the following ranges to your spreadsheet:
• Row Headers
• Column Headers
• Data

The components in your visualization should be bound to the aforementioned
ranges.

Next, you will export your visualization to Adobe SWF. Using Crystal Reports
2008, embed the SWF file into the Crystal Report source data file. When
designing your Crystal Report, you will determine what fields/data populate
the Row Headers, Comumn Headers, and Data ranges that were designated
in your Xcelsius SWF. When set up properly, refereshing your Crystal Report
will also refresh the data being sent to and consumed by the embedded
SWF. See the Crystal Reports 2008 User Guide for more information on
working with Crystal Reports.

Viewing SWF files in InfoView

The process for viewing a SWF file in InfoView is the same as the process
for viewing other file types in BusinessObjects Enterprise or Crystal Reports
Server.
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To view a SWF file in InfoView
1. To launch InfoView, open your web browser and enter one of the following

paths depending on your Enterprise deployment:
• .NET

http://webserver/businessobjects/enterprise115/

• Java
http://webserver:portnumber/businessobjects/enter
prise115/desktoplaunch

Here, webserver represents the name of the web server, and portnumber
represents the connection port.

The CMC stores information about the objects saved to the Enterprise
system. For more information about the CMC, refer to the BusinessObjects
Enterprise or Crystal Reports Server guides.

Tip: If you have Enterprise installed on your machine, you can also access
InfoView on the Start menu. Click Start > Programs > Business Objects
> BusinessObjects Enterprise. Click either .NET InfoView or Java InfoView
depending on your Enterprise deployment.

2. Enter your logon information.
• In theSystem field, type the name of the Central Management Console

(CMC) that the SWF file is saved to.

• In the User name and Password fields, type your logon credentials.

• From the Authentication list, select the authentication type.

If you are unsure of your logon information, contact your system
administrator.

3. Click Log On.
4. Go to the folder that contains the SWF file you want to view.
5. Click the name of the SWF file.

The SWF opens inside the InfoView panel.
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Refreshing SWF files in InfoView

In InfoView, users can refresh a Live Office-enabled SWF file to view the
newest data.

When you design the visualization in Xcelsius 2008, you can set the
visualization to refresh in InfoView in one of the following ways:

• Refresh on Load

• Refresh on Interval

• Manual Refresh

• Refresh based on Trigger Behavior

If you are unsure of how the data in the SWF file refreshes, check the
LiveOffice connection settings in the XLF file in Xcelsius 2008.

To check the LiveOffice connection refresh setting
1. In Xcelsius 2008, open the XLF file.
2. In the Data Manger, open the LiveOffice connection properties.
3. On the Usage tab, ensure the refresh setting that you want has been

selected and configured.

Refresh on Load
If you selected Refresh on Load when you configured the LiveOffice
connection in Xcelsius 2008, the file automatically refreshes when you view
it.

To refresh a SWF file on load
1. Ensure that you have a Live Office-enabled SWF file saved to Enterprise

that has its refresh option set to Refresh on Load.
2. Open InfoView and find the SWF file you want to view.

For more information, see Viewing SWF files in InfoView on page 219.

3. Open the SWF file.

The SWF file is refreshed with the newest data from the data source.
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Refresh on Interval
If you selected Refresh on Interval when you configured the LiveOffice
connection in Xcelsius 2008, the file refreshes at the interval you selected.

To refresh a SWF file on interval
1. Ensure that you have a Live Office-enabled SWF file saved to Enterprise

that has its refresh option set to Refresh on Interval.
2. Open InfoView and find the SWF file you want to view.

For more information, see Viewing SWF files in InfoView on page 219.

3. Open the SWF file.

The SWF file automatically refreshed after the set number of seconds
has passed.

Manual refresh
If you did not select any refresh option when you configured the LiveOffice
connection in Xcelsius 2008, you must click a Connection Refresh Button to
refresh the file.

To manually refresh a SWF file
1. Ensure that you have a LiveOffice-enabled SWF file saved to Enterprise

that has a Connection Refresh Button configured to refresh the LiveOffice
connection.

2. Open InfoView and find the SWF file you want to view.

For more information, see Viewing SWF files in InfoView on page 219.

3. Open the SWF file and click the Connection Refresh Button.

Note: This button may have been renamed when the visualization was
created.

When the Connection Refresh button is clicked, the Xcelsius 2008 file is
refreshed with the newest data from the data source.

Refresh based on Trigger Behavior
If you passed a Crystal Reports parameter to the Xcelsius 2008 visualization,
and used the features in the Trigger Behavior area to configure the refresh
option, the data refreshes when the parameter value changes in the Trigger
Cell that you specified.
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To refresh a SWF file based on trigger behavior
1. Ensure that you have a Live Office-enabled SWF file saved to Enterprise

with the following characteristics:
• A Single Value component configured to trigger the refresh.

• A LiveOffice connection configured to refresh based on the settings
in the Trigger Behavior area.

2. Open InfoView and find the SWF file you want to view.

For information on how to do this, see Viewing SWF files in InfoView on
page 219.

3. Open the SWF file and change the value on the Single Value component.

The data is refreshed and the new value or values are reflected in the
file.

Refreshing Xcelsius 2008 visualizations outside InfoView

If you are outside of InfoView and you have a connection to the Enterprise
system, you can still refresh an Xcelsius 2008 visualization with the newest
data.

To refresh an Xcelsius 2008 Visualization outside InfoView
1. Ensure that you have a LiveOffice-enabled Xcelsius 2008 visualization

with a Connection Refresh Button configured to refresh LiveOffice.
2. Open the Xcelsius 2008 Visualization and click the Connection Refresh

button .

This button may have been renamed when the visualization was created.

The Log On to BusinessObjects Enterprise dialog box appears.

3. Enter your logon information.
a. In theSystem field, type the name of the Central Management Console

(CMC) where you want to save the XLF file.
The CMC stores information about the objects saved to the Enterprise
system. For more information about the CMC, refer to the
BusinessObjects Enterprise or Crystal Reports Server guides.

b. In the User name and Password fields, type your logon credentials.
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c. On the Authentication list, click the appropriate authentication type.

If you are unsure of your logon information, contact your system
administrator.

4. Click OK.

The visualization is refreshed with the newest data from the data source.

Modifying edit and view rights in the Central Management
Console

If you have administrative rights to the Enterprise system, you can modify
the edit and view rights of XLF and SWF files in the Central Management
Console (CMC).

For more information about rights and how they work, refer to the
BusinessObjects Enterprise Administration Guide.

To modify rights in the CMC
1. To launch the CMC, open your web browser and enter one of the following

paths depending on your Enterprise deployment:
• .NET

http://webserver/businessobjects/enterprise115/WebTools/ad
minlaunch/default.aspx

• Java
http://webserver:portnumber/businessobjects/enter
prise115/adminlaunch/launchpad.html

Here, webserver represents the name of the web server, and portnumber
represents the connection port.

Tip: If you have Enterprise installed on your machine, you can also access
InfoView on the Start menu. Click Start > Programs > Business Objects
> BusinessObjects Enterprise. Click either .NET Administration
Launchpad or Java Administration Launchpad depending on your
Enterprise deployment.

2. Click Central Management Console.
3. On the CMC Log On page, enter your logon information.
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In the System field, type the name of the CMC where the XLF or SWF
file is stored.

•

• In the User name and Password fields, type your logon credentials.

• From the Authentication list, select the authentication type.

4. Click Log On.
5. On the CMC home page, click Objects.

A list of all the objects on the CMC appears.

6. Click the XLF or SWF file you want.
7. Click the Rights tab.
8. Use the lists under Access Level to set the rights for each user group.
9. When you have finished, click Update to submit the changes that you

have made.

Updating LiveOffice connection settings after system
migration

When content is migrated from one BusinessObjects Enterprise system to
another, the location of the LiveOffice Web Services changes. Therefore,
the Data Manager settings for the LiveOffice connection become incorrect
and LiveOffice-enabled visualizations cannot be refreshed.

You can update the web.config file or web.xml file directly to update the
LiveOffice Web Services location without having to open each individual
visualization.

Note: Editing the web.config or web.xml file incorrectly can lead to
unexpected behavior. Ensure you backup your files before making any
changes to them.

To update the web.config file for .NET InfoView

1. Locate web.config by going to

<drive>:\Program Files\Business Objects\BusinessObjects Enterprise
11.5\Web Content\Enterprise115\InfoView\web.config
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2. Open web.config in a text editor such as Notepad.
3. Search for the following text at the end of file:

<appSettings>
<add key="applications" value="com.businessobjects. encyclo
pedia.reportviewer.wrapper.InfoViewPanel, analyticwrapper"/>

4. When you find this text, add the following text below it:
<add key="webConnectorUrl" value="http://webservice:port/dsws
bobje/services/session"></add>

Where webservice represents the name of your web service and port
represents the port number that the web server communicates on.

This setting overrides the setting that is in Xcelsius 2008.

To update the web.xml file for Java InfoView

1. Locate web.xml by going to:
C:\Program Files\Business Objects\web server\webapps\busines
sobjects\enterprise115\desktoplaunch\WEB-INF\web.xml

Where web server is the name of your web server.

2. Open web.xml in a text editor such as Notepad.
3. Search for the following text at the end of file:

<context-param>
<param-name>crystalXcelsius 2008.webconnectorurl</param-name>

4. When you find this text, add the following text below it:
<param-value>http://webservice:port/dswsbobje/services/ses
sion</param-value>

Where webservice represents the name of your web service and port
represents the port number that the web server communicates on.

This setting overrides the setting that is in Xcelsius 2008.

Launching an InfoViewdocument fromXcelsius 2008

Xcelsius visualizations stored in InfoView can be configured to open reports
or other documents that are also in InfoView. This is accomplished by adding
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the OpenDocument API (Application Programming Interface) to the URL that
is used to call the document. The OpenDocument API was created by
Business Objects to provide a standard way of opening documents and
reports that have been published to BusinessObjects Enterprise using a
simple URL. OpenDocument allows you to specify not only the report but
also report parameters to return only the desired data.

Note: OpenDocument launches the report or document in a separate browser
window.

Basic Structure:

http://<webserver>/businessobjects/enterprise115/<platformSpe
cific>?<parameter1>&<paramter2>&...&<parameterN>

Note: The URL needs to be URL-encoded if it contains non-URL safe
characters.

Sample URL:

http://cdi5boe:8080/businessobjects/enterprise115/deskto
plaunch/opendoc/openDocument.jsp?sType=rpt&sRepoType=corpo
rate&sPath=[folder],[subfolder1],[subfolder2]&sDocName=Report
Name&IsSpromptName1=promptValue1

The sample URL is structured per below; sections in bold would need to be
customized to the file:

http://

(can be https://)Protocol:

cdi5boe:Server
name:

8080/Port:

businessobjects/enterprise115/desktoplaunch/opendoc/openDoc
ument.jsp?

Note: the syntax for .NET based systems is businessobjects/en
terprise115/InfoView/scripts/opendocument.aspx

Open Doc
JSP:
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sType=rpt&

Note: rpt = Crystal Reports; wid = Web Intelligence; rep = Desktop
Intelligence; car = OLAP Intelligence

Type:

sRepoType=corporate&Repository
Type:

sPath=[folder],[subfolder1],&[subfolder2]File Path:

sDocName=ReportName&

Note: If the sDocName is not unique, the sPath will need to be
specified. Alternatively, iDocID can be used to identify the docu-
ment.

FileName:

IsSpromptName1=promptValue1Prompts:

Tip: OpenDocument can also be used with primary visualizations that are
not in InfoView, but which have secondary files in InfoView. The user will be
prompted for InfoView credentials prior to launching the document.

For more information on URL reporting using OpeDocument, see Viewing
Reports and CDocments using URLs in the BusinessObjects XI SDK
developer documentation.

The OpenDocument URL can be entered directly into the URL field of the
URL Button component. The URL Button can also be linked to a URL as text
in a cell of your spreadsheet. In combination with Selector components and
the Excel CONCATENATE function, the URL can be changed dynamically
based on user selection.

Opening an Infoview SWF with Xcelsius 2008

Xcelsius visualizations stored in InfoView can be configured to open
secondary SWF files that are also in InfoView. This is accomplished by adding
the DocumentDownload function to the URL that is used to call the file. The
DocumentDownload function was created by Business Objects to provide a
standard way of opening SWF files that have been published to
BusinessObjects Enterprise.
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Note:
• DocumentDownload will open the secondary SWF file within Xcelsius,

for example in a Slide Show component. This makes DocumentDownload
the choice for creating a "nested" or "parent-child" visualization within
InfoView.

• Logon credentials are not passed from the parent visualiztion HTML file
when calling a secondary SWF file. Therefore, DocumentDownload
requires appending CELogonToken to the URL.

Basic Structure:
http://<webserver>/businessobjects/enterprise115/deskto
plaunch/opendoc/documentDownload?<parameter1>&<parame
ter2>&...&<parameterN>&CELogonToken=<>

Note: The URL needs to be URL-encoded if it contains non-URL safe
characters.

Sample URL:

http://cdi5boe:8080/ businessobjects/enterprise115/deskto
plaunch/opendoc/documentDownload?iDo
cID=10348&sKind=Flash&CELogonToken=SERVER%408757Jxnge3URUJ8L4

The sample URL is structured per below; sections in bold would need to be
customized to the file:

http://

(can be https://)Protocol:

cdi5boe:Server
name:

8080/Port:

businessobjects/enterprise115/desktoplaunch/opendoc/document
Download?Function:

iDocID=10348&

Note: iDocID is the ID or the CUID of the SWF file.
Document
ID*:
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sKind=Flash&

Note: sKind must be Flash.File Type*:

CELogonToken=SERVER%408757JxmheURUJ8L4LogonCre
dentials*:

**These parameters are required with the documentDownload function.

Tip: To obtain the document ID, navigate to the document in InfoView, hover
your mouse over the document name hyperlink, and look for the ID number
in the browser's staus bar. You can also obtain the document ID from the
Central Managment console.

BusinessObjects XI Release 3 Notes:

• In Release 3, you can use the sDocName (file name) parameter as an
alternative to the iDocID.

• In Release 3, the DocumentDownload function is appended to read:
Xcelsius/opendoc/documentDownload?

Note: Additional parameters can be passed into the SWF file by adding
FlashVar ranges to the URL, for example: "Range1=yyy&Range2=zzz&"

To pass the CELogonToken from the parent visualization to a child SWF, a
Flash Variable connection must be added to the primary visualization. Open
the Data Manager, click Add, and select Flash Variables. In addition to the
connection required for the CELogonToken, any additional parameters must
have Flash Variable connections. Any additional parameters are converted
to FlashVars by the Flash Player.

The DocumentDownload URL can be entered directly into the URL field of
the Slide Show component. The Slide Show can also be linked to a URL as
text in a cell in your spreadsheet. In combination with Selector components
and the Excel CONCATENATE function, the URL can be changed
dynamically based on user selection.
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Frequently Asked Questions
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Installation questions

Do I need to install Adobe Flash to use Xcelsius 2008?

Adobe Flash player version 9 is required for Xcelsius 2008 to function
properly. If you did not install Adobe Flash as part of the installation process,
you can download and install Flash from the Adobe web site
http://www.adobe.com.

Why doesn't Xcelsius 2008 function after I upgrade
or install Microsoft Office?

When Xcelsius 2008 is installed, it automatically configures itself to work
with the version of Microsoft Office that is installed. If you upgrade or change
the version of Microsoft Office on your machine, Xcelsius 2008 must be
re-installed to work properly with the new version.

Embedded Spreadsheet questions

Why doesn't my Excel formula paste correctly?

You may have more than one instance of Excel open. Excel can only copy
formulas within a single instance of Excel. When Xcelsius 2008 launches, it
opens an instance of Excel in the background. If you subsequently open
Excel, it will open as a second instance, and formulas will not copy between
the two instances.

Tip: You can see how many instances of Excel are running by checking the
Processes tab in the Task Manager.

If you are planning to work with Excel spreadsheets while you work with
Xcelsius 2008, we recommend opening Xcelsius 2008 first, then opening
the Excel spreadsheets you need by navigating to them using the Windows
explorer and double-clicking on them. Do not open the files by using File >
Open in the Excel menu.
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Why does the look of my component change when I
copy it into a new visualization?

Some component customization will carry over into a new visualization.
Themes will not carry over into a new visualization, but other customizations
can effect the appearance properties in the new visualization:

• If you have not customized the component, it will take on the properties
of the components in the new visualization.

• If you have customized the component the properties will carry over.

Whydoesn'tmyvisualizationdisplaymy spreadsheet
customization?

Some Excel functions (conditional formatting and macros, for example) that
are available in the embedded spreadsheet are not supported in Xcelsius
2008 models and will not display properly in your visualization.

LiveOffice questions

Why do all of the spreadsheet columns refresh, instead of just the selected
columns?

When specific columns are selected for refresh in a XLF file that connects
to a Live Office View, all the columns are refreshed in the SWF file, not just
the ones indicated in the XLF. This is because all columns are refreshed
regardless of the column selection. You can, however, select individual rows
to refresh.
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Language questions

How to I change the language in Xcelsius 2008?

Go to File > Preferences > Languages and select the desired language from
the dropdown menu. Only languages that were selected during installation
will be available in the dropdown menu.

What if the language I want is not listed in Preferences?

Languages are only available in the Preferences drop-down if they were
selected when Xcelsius was installed. To add languages available under
File > Preferences > Languages, you must uninstall Xcelsius 2008 and
re-install the program. During the installation process, you will be asked
which languages you would like to install; the languages you select to install
wil be available in the Preferences drop-down

Microsoft Excel questions

Can I re-import an Excel file with a renamed
spreadsheet?

You can re-import spreadsheets with renamed sheets, but any bindings to
cells in the renamed sheet will be lost.

Why does my table look different than my Excel
spreadsheet?

The Table component only supports the Verdana font. Your Excel
spreadsheets may be using a different font which will result in minor visual
differences between the spreadsheet and your tables. To match your views,
change the spreadsheet font to Verdana.
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Why does my VLOOKUP formula calculate a value
while in Preview mode that is different from the
value calculated in the embedded spreadsheet?

This error can occur if the VLOOKUP formula used in the spreadsheet has
the following conditions: a “range_lookup” of TRUE; the first column of the
“table_array” is sorted in ascending order; and there are sequential duplicate
entries in the in the first column of the “table_array”. This error is caused by
differences in the way Xcelsius and Excel calculate some functions in the
Lookup & Reference category, some of these being VLOOKUP, HLOOKUP,
LOOKUP and MATCH. With the above conditions, Xcelsius will calculate
and return the first matching value in the case of duplicates; Excel will return
the second matching value in the case of duplicates. This is a known issue
with Excel and is addressed by article 181201 on the Microsoft Support
website. To avoid this issue, when possible, it is recommended to use the
“range_lookup” of FALSE.

Microsoft PowerPoint questions

How can I embed an Xcelsius 2008 SWF file into an
existing PowerPoint presentation?

Within Xcelsius 2008 you can embed your current SWF file into a new
PowerPoint presentation using the Export to PowerPoint options. You can
then cut and paste your SWF into another presentation. See Exporting your
visualization to PowerPoint on page 136 for more information.
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Troubleshooting questions

Why doesn't my component show scientific
formatting?

The visual display of scientific formatted numbers is not supported at this
time. Calculations that are dependent upon scientific formatted numbers are
not affected.

Why doesn't my URL button work?

In order to reference web based content, your URL must include http:// for
it to function correctly.

What happened to the scenarios I saved?

If you are having trouble saving and loading scenarios with the Scenario
button, refer to How does the Local Scenario Button component work? on
page 120.

Why can't I dragmySlider,Dial, or other single value
component?

The values of single value components that are linked to cells with formulas
cannot be adjusted. This prevents inconsistencies in the visualization.

Why do I receive a Server Busy message?

The Server Busy message means that Excel has a pending operation or is
busy performing an instruction. Check Excel to make sure it is not in the
process of editing and then click Retry on the warning dialog box.
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Why do I receive the message "A script in this movie
is causing Flash Player to run slowly..."?

The Flash Player used to view Xcelsius 2008 visualizations displays this
message when a script has taken more than 60 seconds to run. Due to the
complexity of Xcelsius 2008 visualizations, larger visualizations running on
slow machines may cause this message to be shown, particularly at startup.
If you click No on the message dialog box, the visualization should load
properly.

Note: While in Preview mode, pressing Yes to abort the script causes the
preview to stop working. You will need to exit Preview, then return to Preview
mode, to properly preview the visualization.

Why does my visualization start in a strange state?

When a visualization is loaded, all selectors insert their default selection data
into their Destination ranges to populate other components with data. When
more than one selector inserts into the same range, the selector at the highest
layer inserts last. This overrides the default data inserted by the other
selectors.

You can use the Object Browser to view the order of the components and
change the order using the Layer Options.

WhyaremyURL-based images not visible inpreview
mode?

Relative paths

URL references to images that are relative paths do not display in preview
mode because the preview SWF file is generated in a temporary directory.

When you export the SWF file to a location that will make the relative paths
valid, the images will load properly.
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JPEG files on a web site

If you are referencing JPEG files on a web site, be sure that the JPEG files
are not progressive JPEGs. Progressive JPEGs load in stages, which allows
low-bandwidth users to see an image quickly and without having to wait for
the entire image to load.

Xcelsius 2008 cannot display progressive jpegs that are referenced by a
URL. If you select the embed option when you reference a progressive JPEG,
Xcelsius 2008 displays the progressive JPEG as expected.

Why isn't my visualization connecting with its
external data source?

Xcelsius 2008 requires Flash version 9. This version has security features
which may prevent your visualization from connecting with an external data
source. Without a policy file, SWF files from one domain cannot access data
on another domain or sub-domain. In addition, SWF files served over HTTP
cannot access data at an HTTPS location. Please refer to the online article
from Adobe regarding security restrictions for data loading for information
on creating a policy file to allow access to data in the cases above.

Why can't I openMicrosoftOffice fileswhile Xcelsius
is running?

When LiveOffice Compatibility Mode is enabled, Microsoft Office files may
not open or work correctly. We recommend using Compatibility Mode only
when you are working with LiveOffice-enabled spreadsheets.
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To turn Compatibility Mode off, select File > Preferences, then select Excel
Options. Clear the Enable box under Live Office Compatibility, click Apply
and then OK to exit.

Questions about supported features

What is themaximum limit of rows for a single range
selection?

There is no limit to the number of rows for a selection. However, the size of
your selection can affect the performance of your visualization.
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Does Xcelsius 2008 support Excel files that link to
other Excel files?

No, this feature is not supported by Xcelsius 2008.

How large can my Excel file be?

There is no limit to the size of a spreadsheet that can be used in Xcelsius
2008. There are a number of factors, however, which may affect the
performance of your visualization. These include:

• the number of components you have on the canvas

• the amount of data that is being changed during the visualization

• the complexity of the calculations being performed

The speed of the computer can also greatly affect performance, and should
be kept in mind when developing visualizations that will be distributed to
other users.

Which regional Excel formats does Xcelsius 2008
support?

Xcelsius 2008 automatically detects the regional formatting being used on
your machine and adjusts its output appropriately.

For example, if your regional settings use forward slash ( / ) for the date
separator, the date January 2, 2004 appears as 1/2/04 in your Xcelsius 2008
visualizations. If your regional settings use a hyphen or dash ( - ) for the date
separator, the date appears as 1-2-04 in the exported visualization.

These settings can be found under the Regional and Language Options of
the Windows Control Panel. The following items are automatically adjusted:

• decimal separator

• thousands separator

• general format name
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• month

• day

• year

• hour

• minute

• second

• time separator

• date separator

Why don't my Excel macros work?

Xcelsius 2008 does not support macros in Excel spreadsheets at this time.
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Overview
This section discusses Properties panel features that are common to most
components. Depending on the component that you are working with, some
of these features may be unavailable.

Common buttons
The buttons described in this section appear on the Properties panels for
most components.

Cell Selector button

The cell selector button lets you select a cell or a cell range in the
spreadsheet and link to various data values.

When you click a cell selector button, the Select a Range dialog box opens.
In the embedded spreadsheet, highlight the cell(s) to select. The location
number of the selected cell or cells appears in the dialog box.

Click OK in the Select a Range dialog box. The location of the selected cell
or range appears in the box adjacent to the cell selector button.

Color Selector button

The color selector button lets you select a custom color for part of the
component.

When you click a color selector button, the Color dialog box appears. Select
the desired color from the Theme Colors or Standard Colors, or click More
Colors to access more colors. Select a color or close the dialog box to return
to the Properties panel.

More Colors

There are two ways to select additional colors in the dialog:
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• Standard Tab

Select a color from the color wheel.

• Custom Tab

Select a color by clicking on the color with the mouse pointer. Use the
slider on the right to brighten or darken the color.

You can also manually enter RGB or HSL color values. Select the color
model type from the drop down and enter the values in the appropriate
boxes.

Manual Edit button

The Manual Edit button lets you manually enter text values for a
component instead of selecting the text values in the spreadsheet. When
you click the Manual Edit button, a dialog box appears. In the dialog box,
type the values directly into the cells to enter new text values or overwrite
the default values.

If you have not reached the maximum number of values for the list, you can
add a new text value by typing the new text value and clicking Add.

When you are finished adding or editing, click OK to close the dialog box
and return to the Properties panel.

Information button

The Information button provides information about how a feature on the
Properties panel works. When you click the Information button, a new window
opens, and an animated movie guides you through the way a feature works.
You can go to different pages in the movie, and click play or pause to find
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the information you need. When you are finished, close the window to return
to the Properties panel.

Appearance tab
The areas described in this section are common to most components, and
always contain the same features.

Layout tab

Thickness

The Thickness box determines how thick a line is. You can enter a value
from 1 to 100, with 1 being the thinnest line, and 100 being the thickest line.

Transparency

The Transparency box lets you set the transparency value for the component.
You can drag the slider or enter a value from 0 to 100, with 100 being
completely transparent, and 0 being completely solid.

Text tab

The Text tab lets you customize text elements for a component.

Show-Text selection box

The Show-Text selection box lists available text elements. Click the adjacent
checkbox to enable visibility of that element.
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Format Selected Text

The Format Selected Text area contains options for formatting the text
elements in the Show-Text selection box. The following options apply only
to the highlighted text element.

Font

By default, the font is set to Verdana. Select a font from the dropdown list to
change the font.

If you chose to use non-embedded fonts in the visualization, you can use
the font box to change the font for the component. For information about
changing the font, see Understanding fonts in Xcelsius 2008 on page 58.

Size

To set the font size, type a number in the box or select a number from 8 to
72 from the dropdown menu.

Bold

Click the bold button to make the text bold.

Italic

Click the italic button to italicize the text.
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Underline

Click the underline button to underline the text.

Alignment

Click one of the boxes to select a text alignment option: left, center, or right
aligned.

Color

Click the color selector button to customize the font color.

Position

The Position dropdown menu lets you specify the position of text. Depending
on the component that you are working with, some of the Position items
below may not be available:

• Top Center

• Top Left

• Top Right

• Left

• Right

• Center

• Bottom Left

• Bottom Center

• Bottom Right

Offset X

The Offset X (formerly Horizontal Offset) box lets you shift text horizontally
relative to the position you specified in the Position list. To enter the Offset
X value, type a numerical value in the box, or use the up and down arrows
adjacent to the Offset X box. Negative values shift the title left; positive values
shift the title right.
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Offset Y

The Offset Y (formerly Vertical Offset) box lets you shift text vertically relative
to the position you specified in the Position list. To enter the Offset Y value,
type a numerical value in the box, or use the up and down arrows adjacent
to the Offset Y box. Negative values shift the title downward; positive values
shift the title upward.

Number Format

Number Format lets you apply predefined formats to numerical data displayed
in the visualization. Some of the formats on the Number Format list provide
more options for customizing the appearance of numerical data.

General
The General format displays numeric data as it appears. This format has no
additional options for customization.

Numeric
The Numeric format provides the following options for customizing the format
of numeric values.

Negative Values

The Negative Values list lets you select a format for negative values:

• Minus Sign Prefix

• Red Text

• Parenthesis

• Red Text with Parenthesis

Decimal Places

The Decimal Places box lets you enter the number of decimal places to
display. You can enter a value from 0 to 20.
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Use 1000 Separator

When you select the Use 1000 Separator check box, Xcelsius 2008 inserts
commas into numerical values above 999.

Currency
The Currency format provides the following options for customizing the format
of currency values.

Negative Values

See Numeric on page 249.

Decimal Places

See Numeric on page 249.

Prefix

When you select the Prefix check box, Xcelsius 2008 precedes currency
values with a symbol. This symbol is set to "$" by default. To change the
symbol, enter the desired character(s) in the adjacent box.

Suffix

When you select the Suffix check box, Xcelsius 2008 adds a symbol to the
end of currency values. Enter the desired symbol in the adjacent Suffix box.

Percent
The Percent format provides the following option for customizing the
appearance of percentage values.

Decimal Places

See Numeric on page 249.

Date
The Date format provides the following option for customizing the appearance
of date values:
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Type

Select the desired date format from the Type list.

Time
The Time format provides the following option for customizing the appearance
of time values:

Type

Select the desired time format from the Type list.

Text
The Text format displays numerical values as plain text. This format has no
additional options for customization.

Behavior Tab

Common tab

Dynamic Visibility

The Dynamic Visibility area appears on the Common tab in the Behavior tab.
The features in the Dynamic Visibility area control the visibility behavior of
the component.

Status
Status lets you select a cell in the embedded spreadsheet to control the
visibility of the component. If the value in the Status cell equals the value of
the Key, the component will be displayed.
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Note: Do not link Status to a cell or range of cells that are already linked
within the same component (for example, Data ranges). The overlap will
cause those data sources in the component to not refresh if changed
dynamically.

Key
Key lets you specify the value that the Status must match for the component
to become visible.

Enter the value in the box or use the cell selector to bind the value to a cell
in the embedded spreadsheet.

Note: The Key is not available unless Status has been set.

Animations and Effects tab

Entry Effect

In this area you can set how the component will initially appear, or re-appear
using Dynamic Visibility, in the visualization and enable any available
animation.

• Effect Type
• None

The component has no entry effect.

• Fade-in

The component appears in a semi-transparent state and gradually
becomes solid.

• Wipe Right

The component appears gradually, first appearing at its full height,
and then growing to its full width.

• Wipe Right Down

The component appears gradually until it reaches its full size.
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• Duration (Seconds)

The Duration box is available only if you selected Fade-in, Grow, or Grow
X First on the Entry Effect list, and lets you determine how long the effect
lasts. You can enter a value from 0 to 10, with 0 being the shortest
duration, and 10 being the longest duration.

Alerts Tab
Alerts let the user know that a predefined value has been reached. The
settings on the Alerts tab control how alerts behave for a component when
the visualization is run. Depending on the component that you are working
with, some of the settings described in this section may be unavailable.

Note: Not all components are able to display alerts. These components do
not have an Alerts tab.

Enable Alerts

The Enable Alerts check box controls whether alerts are enabled for the
component.

Click one of the following options to define the alert method for the
component:

• Alert Values

Use the cell selector to choose the data values. (Icon component only)

• As Percent of Max Value

The alerts use percentages of the largest value.

• As Percent of Target

The alerts use percentages of the value in a selected cell. Use the cell
selector button to select a cell in the embedded spreadsheet.

Use the Manual Edit button to manually enter the target value.
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Note: Xcelsius 2008 supports the use of separate target values for
multiple data points. The maximum number of target values is limited to
the number of data points.

• By Value

The alerts use values that you specify in the Alert Thresholds area.

Alert Variable

The Alert Variable dropdown menu lets you specify whether you want to use
X-axis values or Y-axis values to trigger alerts.

Note: This setting is only available for XY Charts and Bubble Charts.

Alert Thresholds

Alert Thresholds specify where the alert levels will be by value or by
percentage. In the Alert Thresholds area you set the level for each threshold
as well as the color for each level. Alert Thresholds appears only if you have
enabled alerts.

Check the Use a Range button to select the threshold levels from cells in
the spreadsheet.

Alternatively, enter a desired threshold value in the text box; click the Add
button to see it automatically placed in the alert levels list. You can also edit
the existing alert levels by clicking either the From or To values. Alert levels
can be deleted from the list by clicking the Delete [X] button.

Note: When Enable Auto Colors is checked, the color selector buttons for
each alert level are unavailable. To customize an alert level color, clear the
check box.
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Enable Auto Colors

Enable Auto Colors automatically picks alert colors from a range of
colors. If you add or remove alert thresholds, Xcelsius 2008 will automatically
adjust the colors along the selected color gradient.

To select a new color range, click the Enable Auto Colors icon, then select
a color gradient from the dialog.

Note: You can edit custom gradients by right-clicking on them and editing
the colors.

Select Create new gradient to create a custom gradient.
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Select the number of base colors and use the buttons to customize the fill
and font colors.

Fill Color

The down arrow button opens the dialog where you can customize the
corresponding fill colors.

Font Color

The down arrow button opens the Color dialog box where you can customize
the corresponding color of the text in the Alert Thresholds.

No Data Color

The down arrow button adjacent to No Data Color lets you customize the
color for parts of the component which have no alert data.
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Color Order

You can click one of the following options in the Color Order area to define
the ideal value type for the component:

• Low Values are Good

Use this option when the ideal value type is lower than the target value.
For example, select Low Values are Good when you set alerts for
expenses, and you want the expense values to be as low as possible.

• Middle Values are Good

Middle Values are Good is unavailable if you clicked By Value in the Alert
Method area. Use this option when the ideal value type is as close as
possible to the target value. For example, select Middle Values are Good
when you set alerts for inventory, and you want the inventory quantities
to be as accurate as possible

• High Values are Good

Use this option when the ideal value type is higher than the target value.
For example, select High Values are Good when you set alerts for
revenue, and you want the revenue values to be as high as possible.

Alert Location

The three check boxes in the Alert Location area let you customize how
alerts are displayed:

• Background

Select this to display the alert colors in the background of the component.

• Value

Select this to display the alert color on the value.

• Marker

Select this to display the alert color on the marker.

Xcelsius 2008 User Guide 257

13General Properties Panel Reference
Alerts Tab



Note: The Alert Location area is only available for some single value
components.
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Overview
This section discusses the Properties panel features for Chart components.

This section discusses the Properties panel features for Chart components.
The following Chart components are available in all versions of Xcelsius
2008:

• Pie Chart
• OHLC Chart
• Candlestick Chart
• Column Chart
• Stacked Column Chart
• Bar Chart
• Stacked Bar Chart
• Combination Chart
• Bubble Chart
• XY Chart
• Area Chart
• Stacked Area Chart
• Radar Chart
• Filled Radar Chart
• Tree Map

For more information about Chart components, see Using the Chart
components on page 76.

General tab

Titles

The options in this area set the various titles for the selected chart component.

Chart

Type in the text box or click the adjacent cell selector button to set the title
for the chart.
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Subtitle

Type in the text box or click the adjacent cell selector button to set the subtitle
for the chart.

Category (X) Axis

Type in the text box or click the adjacent cell selector button to set the X-axis
title for the chart.

Value (Y) Axis

Type in the text box or click the adjacent cell selector button to set the Y-axis
title for the chart.

Secondary Value Axis

Type in the text box or click the adjacent cell selector button to set the
Secondary Axis title for the chart.

Note:

• This option applies only to the X- or Y-axis, depending on which axis the
chart is plotted on.

• This option is not available for all charts.
• This option only applies if you selected Secondary Axis for the plot series

in the Data area.

Data

The options in this area select the ranges of Excel data that contain all of
the data for the selected chart.

By Range

Click By Range to enable the options in this area.

Click the adjacent cell selector button to select a range of data from the
spreadsheet.

• Data in Rows
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Click this option to indicate that the series information is organized by
rows in the selected range.

• Data in Columns

Click this option to indicate that the series information is organized by
columns in the selected range.

By Series

Click By Series to enable the options in this section.

The options in this area edit individual series settings.

The Name, Y Values, and Plot Series On parameters all apply to the series
name that is highlighted in the Series box.

Click a series in the list box to edit the data for that series.

• Add

Click the add button to add a new series to the chart.

• Remove

Click the remove button to remove a series from the chart.

• Move up

Click the directional arrow to move a series higher in the Series box.

• Move down

Click the directional arrow to move a series lower in the Series box.

• Name

Type in the Name box or click the adjacent cell selector button to set the
name of the selected series.

• Values

Click the cell selector button adjacent to the Values box to select the X
(or Y) data points for the selected series.

• Values (Sizes)
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Click the cell selector button adjacent to the Sizes box to set the size
value for the selected series.

Note: This option applies only to the Bubble Chart and Tree Map
components.

• Values (Color Intensity)

Click the cell selector button adjacent to the Color Intensity box to set the
color intensity value for the selected series.

Note: This option applies only to the Tree Map component.

• Plot Series On

If a chart has more than one series of data, you can choose the axis that
each series is plotted on.

• Primary Axis

Select this option to plot the series on the Primary Axis.

• Secondary Axis

Select this option to plot the series on the Secondary Axis

Note: This option is only available for Line, Column, Bar, Area, and
Combination charts.

• Category Axis Labels

Click the cell selector button adjacent to the Category Axis Labels box to
select the category axis labels for the selected series.

The following options are available only in the OHLC and Candlestick Chart
components:

• Open

Click the cell selector button adjacent to the Open box to select the values
for the open series.

• High

Click the cell selector button adjacent to the High box to select the values
for the high series.
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• Low

Click the cell selector button adjacent to the Low box to select the values
for the low series.

• Close

Click the cell selector button adjacent to the Close box to select the values
for the close series.

Drill Down tab

Enable Drill Down

Click Enable Drill down to enable the options on this tab.

Note:

• This tab does not apply to the Area, Stacked Area, Radar, and Filled
Radar Chart components.

• The options on this tab are available only if a series has been added to
the chart on the General Tab.

Chart Drill-Down Options

The options in this area define how the Chart component will behave when
a selection is made. The following options are available:

• Series Name Destination

Click the Series Name Destination cell selector button to select the cell
into which the currently selected series name will be inserted.

• Insertion Type

Click an option on the Insertion Type list to determine the structure of the
data that is inserted when a selection is made. The following options are
available:

• Position

A target cell is linked to the Chart component. When a series is
selected in the Chart component, the position of the value within the
series is entered in the target cell.
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• Value

A target cell is linked to the Chart component. When a selection is
made on the Chart component the source data value of the selection
is entered in the target cell.

• Row

A target row is linked to the Chart component. When a selection is
made on the Chart component the row of source data values
corresponding to the selection are entered in the target row.

• Column

A target column is linked to the Chart component. When a selection
is made on the Chart component the column of source data values
corresponding to the selection are entered in the target column.

• Status List

A target range of cells is linked to the Chart component. When a
selection is made on the Chart component a value of 1 is entered in
the cell in the range representing that selection and a value of 0 is
entered in the other cells of the target range

• Series

Click a series from the list to configure. All series for the chart must be
configured individually.

• Source Data

Click the cell selector button adjacent to the Source Data box to select
the data that is inserted when a selection is made on the component.

Note: This option is enabled only when Rows or Columns is selected on
the Insert Option list.

• Value Set

Select a value set from the list.

Note:

• The Value Set list is enabled only when Value is selected on the
Insertion Type list.

• This option is only available in Bubble and XY Charts.
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• Destination

Click the cell selector button adjacent to the Destination box to select the
cells(s) that the data is inserted in.

Note: The Destination cells must be blank or the data inserted may be
compromized.

Interaction Options

The selections in this area determine how the component recognizes that a
selection has been made.

Click an option on the Insert On list to define the recognition method of the
component. The following options are available:

• Mouse Click. The user must click on an item to select it.

• Mouse Over. An item is selected when the pointer passes over it.

Default Selection

The options in this area set the default status of the component. The following
options are available:

• Series

Click an option from the list to select the Series that will configure the
default value.

• Item

Click a value from the Item list to select which data point of the series will
be selected by default when the visualization is loaded. This option also
determines which default data is inserted into the Destination cells when
the visualization is loaded.
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Behavior tab

Common tab

Ignore Blank Cells

The options in this area control how the chart handles blank cells at the end
of range data. For more information, see Ignore End Blanks for variable
length ranges on page 152.
• In Series

Click In Series to prevent all of the empty series past the last non-empty
series in a range from being displayed in the Chart component. This option
allows a variable number of series to be displayed in the Chart component.

Note:

• Although the component may not be displaying all of the data within
the Data range, the performance of the visualization is affected by the
size of the range.

• This option does not apply to the Pie Chart component.
• In Values

Click In Values to prevent all of the empty values past the last non-empty
value in a series from being displayed in the Chart component. This allows
a variable amount of series data to be displayed in the Chart component.

Note: Although the Chart component may not be displaying all of the
data within the Data range, the performance of the Xcelsius 2008
visualization is affected by the size of the range.

Enable Run-Time Tools

The options in this area control the visibility of optional tools that appear on
the chart in the generated SWF file. These options let the end-user modify
the Scale Behavior of Chart components during run time in the visualization.
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Note: If one or more of the Run-Time Tools are enabled, the run time icon
appears on the chart in the visualization.

When the pointer passes over the run time icon, the runtime menu will appear,
depending on the tools enabled.

Show Focus Button

Click Show Focus Button to display the Focus Chart Data button on
the run time menu when the visualization is run. Clicking on the Focus Chart
Data button forces the chart to rescale the chart axes based on the current
data.

Show Reset Scale Button

Click Show Reset Scale Button to display the Reset Chart Scale button
on the run time menu when the visualization is run. Clicking on the Reset
Chart Scale button forces the chart to rescale the chart axes to the scale
that the chart had when it first loaded.

Show Scale Behavior Options

Click Show Scale Behavior Options to display the scale behavior buttons on
the run time configuration menu. Clicking on the scale behavior buttons
changes the scaling behavior of the Chart component; the chart axes will
scale based on the new setting the next time the chart data changes. The
Scale Behavior Options menu has the following options available:

• Click Grow to set the scaling behavior to Auto Zoom Out.

• Click Off to set the scaling behavior to Manual Scale.

• Click Auto to set the scaling behavior to Auto Scale.

Dynamic Visibility

For information on the options available in the Dynamic Visibility area see
Dynamic Visibility on page 251.
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Scale tab

Scale

The options in this area control how the chart axes scale as data changes.

Note: The options in this area do not apply to the Pie Chart component.

Note: There are two scale tabs (one each for Primary and Secondary axis)
for Line, Column, Bar, Area, and Combination charts that have two axes.

Manual Axis

ClickManual Axis to set the scaling behavior. The axis scale will not change
as data changes. The minimum and maximum axis values are fixed at design
time.

• Minimum Limit

Type in the Minimum Limit box or click the adjacent cell selector button
to select a value to determine the minimum value that can be displayed
on the primary axis of the Chart component.

• Maximum Limit

Type in the Maximum Limit box or click the adjacent cell selector button
to select a value to determine the maximum value that can be displayed
on the primary axis of the Chart component.

Auto Axis

Click Auto Axis to set the scaling behavior to grow and shrink as data
changes.
• Allow Zoom Out Only

Click Allow Zoom Out Only to set the scaling behavior to grow as data
changes, but not shrink. This option is recommended when a chart will
be used in an animation. Setting the scale to Zoom Out Only minimizes
chart rescaling.

• Zoom Sensitivity
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The slider tunes the scaling behavior for the Chart component. The setting
determines how much an axis scale will grow as the data changes.

Moving the slider to the left results in the axis scale increasing by a small
factor when the chart scale changes. Moving the slider to the right results
in the axis scale increasing by a larger factor when the chart scale
changes.

Axis Scale

Click an option on the Axis Scale list to select the format of the primary axis
for the Chart component. The following options are available:

• Linear

Click Linear to plot the axis values on a linear scale. Values plotted on
a linear scale appear at evenly spaced intervals in the chart component.

• Logarithmic

Click Logarithmic to plot the axis values on a logarithmic scale. Values
plotted on a logarithmic scale appear at unevenly spaced intervals in the
chart component. Smaller values have larger space intervals; larger values
have smaller space intervals. Equal percentage changes are represented
by equal distances.

Fixed Label Size

Click Fixed Label Size to lock the width of the axis labels so they will not be
resized if the scale changes.

• Label Abbreviations

Click the Label Abbreviations Manual Edit button to display the Label Unit
Abbreviations dialog box.

• Label Unit Abbreviations dialog

Edit the unit abbreviations that appear on the axes labels.
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Animations and Effects tab

Chart Animation Enabled

Click Enable Data Animation to add animation to the chart components
when the visualization is run. In chart components with bars, the bars grow
and shrink when the data changes and the visualization is run. In point-based
chart components the points grow to full size when the visualization is run.

Note: This option does not apply to Tree Map component.

Entry Effect
For information about Entry Effects, see Animations and Effects tab on
page 252.

Appearance tab

Layout tab

Chart Area

The options in this area configure the background and border appearance
for the Chart component. The following options are available:

• Show Chart Background

Click Show Chart Background to display a background behind the Chart
component.

• Margin

Enter or adjust the value in the Margin box to control the amount of space
between the perimiter of the plot area and the perimiter of the chart border.

Plot Area

The options in this area configure the plot area for the Chart component.
The following options are available:
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• Show Fill

Click Show Fill to display a background with a solid fill color within the
plot area.

• Fill Color

Click the color selector button adjacent to Show Fill to set the background
fill color.

• Show Border

Click Show Border to display a border around the plot area.

• Border Color

Click the color selector button adjacent to Show Border to customize the
border color.

• Border Thickness

Adjust the value in the Border Thickness box to customize the border
thickness.

Note: This option does not apply to the Pie Chart component.

Title Area

The options in this area configure the area behind the title for the Chart
component. The following options are available:

• Show Fill

Click Show Fill to display a background with a solid fill color within the
title area.

• Fill Color

Click the color selector button adjacent to Show Fill to set the background
fill color.

• Show Border

Click Show Border to display a border around the title area.

• Border Color

Click the color selector button adjacent to Show Border to customize the
border color.
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• Border Thickness

Adjust the value in the Border Thickness box to customize the border
thickness.

Enable Legend

Select the Enable Legend box to display the chart Legend. The selections
in this area configure the Legend area of the selected chart. The following
selections are available:

• Position

Click a selection on the Position list to set the location of the Legend in
the Chart component. The following options are available:

• Top

• Left

• Right

• Bottom

• Vertical Offset

Note: Vertical Offset is available only if Left or Right is chosen from the
Position dropdown menu.

For information on Vertical Offset see Offset Y on page 249.

• Horizontal Offset

Note: Horizontal Offset is available only if Top or Bottom is chosen from
the Position dropdown menu.

For information on Horizontal Offset see Offset X on page 248.

• Show Fill

Click Show Fill to display a background with a solid fill color behind the
Legend area.

• Fill Color

Click the color selector button adjacent to Show Fill to set the background
fill color.

• Show Border
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Click Show Border to display a border around the Legend area.

• Border Color

Click the color selector button adjacent to Show Border to customize the
border color.

• Border Thickness

Adjust the value in the Border Thickness box to customize the border
thickness.

Series tab

Note: The options on this tab do not apply to the Area, Stacked Area, and
Filled Radar Chart components.

• Series

Select a series from the list to modify.

• Shape

Click a marker format from the Shape list to set the marker symbol
displayed on the series data points. The following options are available:

• Circle

• Diamond

• Star

• Triangle

• X

Note: The Shape option applies only to the Line and Radar Chart
components.

• Line Color

Click the color selector button in the Line column to customize the
appearance of the lines connecting the data points.

Note: This option applies only to the Line and Radar Chart components.
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• Fill Color

Click the color selector button in the Fill column to customize the
appearance of the data point markers.

• Line Thickness

This option controls the thickness of the connecting lines. Adjust the value
in the thickness box to customize the line thickness.

• Enable Series Markers

Click Enable Series Markers to display data point markers on the Series.

Note: This option applies only to the Line, Combination, and Radar Chart
components.

• Marker Size

Adjust the value in the Marker Size box to set the size of the data point
markers.

Note: This option applies only to the Line, Combination, and Radar Chart
components.

• Transparency

For information on Transparency see Transparency on page 246.

Specific to OHLC and Candlestick Chart components

The options in this area customize the markers displayed on the Chart
components. The following options are available.

• Positive Color

Click the color selector button adjacent to Positive Color to customize the
color for a series in which the close value is higher than the open value.

• Negative Color

Click the color selector button adjacent to Negative Color to customize
the color for a series in which the close value is lower than the open value.
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Specific to the Pie Chart component

Data Point selection box
The options in this area configure the appearance of the pie slices for the
Pie Chart component.

• Data Point

Click a Data Point in the list to select the slice to be customized.

• Fill

Click the color selector button of the highlighted Data Point to customize
the color of the slice selected.

• Show Lines

Check the Show Lines box to display a line between each pie slice.

Click the adjacent color selector button to customize the line color.

Specific to the Combination Chart component

Type

Click an option from the Type list to select the type of markers to represent
the selected Series.

Specific to the Tree Map component

• High Color

Click the color selector button in the High Color column to customize the
appearance of the high intensity color of the Series.

• Low Color

Click the color selector button in the Low Color column to customize the
appearance of the low intensity color of the Series.
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Axes tab

Enable Vertical Axis

Click Enable Vertical Axis to display the vertical axis for the Chart component.
Use the options in this section to configure the appearance of the vertical
axis.

• Line Color

Click the color selector button adjacent to Line Color to set the axis color.

• Thickness

Thickness controls the width of the axis. Enter or adjust the value in the
adjacent box to set the axis thickness.

• Show Major Ticks

Click Show Major Ticks to display horizontal tick marks where the major
grid lines intersect the vertical axis.

Note: This option does not apply to the Bar Chart component.

• Show Minor Ticks

Click Show Minor Ticks to display horizontal tick marks where the minor
grid lines intersect the vertical axis.

Note: This option does not apply to the Bar Chart component.

Enable Horizontal Axis

• Line Color

Click the color selector button adjacent to Line Color to set the axis color.

• Thickness

Thickness controls the width of the axis. Enter or adjust the value in the
adjacent box to set the axis thickness.
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Horizontal Gridlines

Note: The options in this area do not apply to the Pie Chart component.

The options in this area control the display of horizontal grid lines in the plot
area of the Chart component. The following options are available:

• Show Major Gridlines

Click Show Major Gridlines to display major horizontal grid lines in the
plot area of the Chart component.

• Major Gridlines Color

Click the color selector button adjacent to Show Major Gridlines to
customize the color of the major gridlines.

• Major Gridlines Thickness

Adjust the value in the Thickness box to customize the thickness of the
major gridlines.

• Show Minor Gridlines

Click Show Minor Gridlines to display minor horizontal grid lines in the
plot area of the Chart component.

• Minor Gridlines Color

Click the color selector button adjacent to Show Minor Gridlines to
customize the color of the minor gridlines.

• Minor Gridlines Thickness

Adjust the value in the Thickness box to customize the thickness of the
minor gridlines.

Text tab

For information about text settings, see Text tab on page 246.
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Color tab

Use the color selector buttons to customize the appearance of the component.
The parts of the component that can be customized vary depending on the
component you are working with. The following options may be available:

Background Color

Series
• Line
• Fill
• Positive Color
• Negative Color
• High Color

Slices
• Fill Color

Title Area
• Fill
• Border

Plot Area
• Fill
• Border

Legend Area
• Fill
• Border

Axes and Gridlines
• Vertical Axis
• Vertical Major Gridlines
• Vertical Minor Gridlines
• Horizontal Axis
• Horizontal Major Gridlines
• Horizontal Minor Gridlines

Xcelsius 2008 User Guide 279

14Chart Components Reference
Appearance tab



Alerts Tab
Note: The Chart Alerts Tab applies only to the Line, Column, Stacked
Column, Bar, Stacked Bar, Combination, Bubble, XY, and Radar Chart
components.

For information on Alerts, see Alerts Tab on page 253.
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Reference
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Overview
This section discusses the Properties panel features for the Container
components. The Container components available are:

• Panel Container
• Panel Container 2
• Tab Set

Note: The Tab Set component uses a sub-component labeled Canvas.
This component has a Properties panel separate from the Tab Set
Properties panel. Each tab in the Tab Set has its own canvas. Click the
Plus sign adjacent to the Tab Set in the Object Browser to expand the
list of Canvases.

For more information about Container components, seeUsing the Container
components on page 87.

General tab
The settings on the General tab let you specify the basic settings for the
component.

Title

Type a title for the component or click the adjacent cell selector button to
select a title from the spreadsheet.

Tab Alignment

Click the drop-down menu to select an alignment option for the tabs in the
component.

Note: This option is only available for the Tab Set component.

Label

Type a label for the component or click the adjacent cell selector button to
select a label from the spreadsheet.

Note: This option is only available for the Canvas sub-component.
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Behavior tab
The settings on the Behavior tab let you customize how the component will
behave when the visualization is run.

Common tab

Scroll Bar options
• Horizontal Scroll Bar

Click the drop down menu to select one of the following options for
displaying the horizontal scroll bar:
• Off
• On
• Auto (default)

• Vertical Scroll Bar

Click the drop down menu to select one of the following options for
displaying the vertical scroll bar:
• Off
• On
• Auto (default)

Note: This setting is not available for the Tab Set component.

Selected Item

Click the Item drop-down menu to select the default Tab that will be loaded
when the visualization is run.

Note: This setting is only available for the Tab Set component.

Dynamic Visibility

For information on the options available in the Dynamic Visibility area see
Dynamic Visibility on page 251.

Note: This setting is not available for the Canvas sub-component.
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Appearance tab
The features on the Appearance tab let you customize the appearance of
the Container components.

Text tab

For more information about the settings on the Text tab, see Text tab on
page 246.

Note: This tab is not available for the Canvas sub-component.

Color tab

Use this area to customize the color of various parts of the component. The
available elements will be listed with an adjacent color selector button; click
this button to customize the color of the element.

The following elements may be available, depending on the component:

• Background Color
• Panel Color
• Scroll bar

• Track Color
• Thumb Color
• Button Color
• Button Symbol Color

• Tab Backgrounds
• Default Color
• Over Color
• Selected Color

• Labels
• Default Color
• Over Color
• Selected Color
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Overview
This section discusses the Properties panel features for the Container
components. The Container components available are:

• Panel Container
• Panel Container 2
• Tab Set

Note: The Tab Set component uses a sub-component labeled Canvas.
This component has a Properties panel separate from the Tab Set
Properties panel. Each tab in the Tab Set has its own canvas. Click the
Plus sign adjacent to the Tab Set in the Object Browser to expand the
list of Canvases.

For more information about Container components, seeUsing the Container
components on page 87.

General tab
The settings on the General tab let you specify the basic settings for the
component.

Title

Type a title for the component or click the adjacent cell selector button to
select a title from the spreadsheet.

Tab Alignment

Click the drop-down menu to select an alignment option for the tabs in the
component.

Note: This option is only available for the Tab Set component.

Label

Type a label for the component or click the adjacent cell selector button to
select a label from the spreadsheet.

Note: This option is only available for the Canvas sub-component.
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Behavior tab
The settings on the Behavior tab let you customize how the component will
behave when the visualization is run.

Common tab

Scroll Bar options
• Horizontal Scroll Bar

Click the drop down menu to select one of the following options for
displaying the horizontal scroll bar:
• Off
• On
• Auto (default)

• Vertical Scroll Bar

Click the drop down menu to select one of the following options for
displaying the vertical scroll bar:
• Off
• On
• Auto (default)

Note: This setting is not available for the Tab Set component.

Selected Item

Click the Item drop-down menu to select the default Tab that will be loaded
when the visualization is run.

Note: This setting is only available for the Tab Set component.

Dynamic Visibility

For information on the options available in the Dynamic Visibility area see
Dynamic Visibility on page 251.

Note: This setting is not available for the Canvas sub-component.
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Animations and Effects tab

For information about the features in the Animations and Effects tab, see
Animations and Effects tab on page 252.

Appearance tab
The features on the Appearance tab let you customize the appearance of
the Container components.

Text tab

For more information about the settings on the Text tab, see Text tab on
page 246.

Note: This tab is not available for the Canvas sub-component.

Color tab

Use this area to customize the color of various parts of the component. The
available elements will be listed with an adjacent color selector button; click
this button to customize the color of the element.

The following elements may be available, depending on the component:

• Background Color
• Panel Color
• Scroll bar

• Track Color
• Thumb Color
• Button Color
• Button Symbol Color

• Tab Backgrounds
• Default Color
• Over Color
• Selected Color

• Labels
• Default Color
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• Over Color
• Selected Color
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Overview
This section discusses the Properties panel features for Selector components.
The following Selector components are available in all versions of Xcelsius
2008:

• Check Box
• Combo Box
• Fisheye Picture Menu
• Icon
• Label Based Menu
• List Box
• Radio Button
• Toggle Button
• Spreadsheet Table

In addition, Xcelsius Engage versions also have the following components:

• Accordion Menu
• Filter
• Sliding Picture Menu
• List View
• List Builder
• Ticker
• Play Selector

For more information about Selector components, see Using the Selector
components on page 91.

General tab

Title

Type in the Title box or click the adjacent cell selector button to select the
title for the component.

Note: This option is not available for Icon, Toggle Button, Spreadsheet Table,
and Play Selector components.
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Labels

Click the Manual Edit button adjacent to the Labels box to manually enter
the labels, or click the adjacent cell selector button to select the labels from
the spreadsheet.

Note: The Labels options are not available for the following components:

• Accordion Menu

• Check Box

• List View

• Spreadsheet Table

• Play Selector

• Filter

Note: The Labels Manual Edit button is not available for the Icon component.

Value Labels

Click the cell selector button adjacent to the Value Labels box to select the
values that will be displayed as labels on the Ticker component.

Note: This option applies only to the Ticker component.

Display Data

Click the cell selector button adjacent to the Display Data box to select the
range of data that is displayed on the component.

Note: The Display Data area applies only to the Spreadsheet Table and List
View components.

Display Value

Enter the value or click the cell selector button adjacent to the Display Value
box to select a cell containing the value. The value is displayed when the
pointer hovers over the component.

Note:
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• The value must be numeric. If the value is non-numeric, a zero will be
displayed.

• This option is only available for the Icon component.

Images

The options in this section set the image files used in the selector.

Embedded

Select Embedded to embed the image files in the selected component. The
selected files will become a part of the exported visualization.
1. Click Import to open the Import Thumbnail dialog box.
2. Click the Click to Add Images button to launch the Open File dialog box.
3. Navigate to the image file you want to embed, then click OK.
4. Click OK to return to the Properties panel.

By URL

Click By URL to manually enter the image file locations. Click the Manual
Edit button to type the URL of the images or use the cell selector button to
link to a cell in the spreadsheet.

Note: The Images options apply only to Fisheye Picture Menu and Sliding
Picture Menu components.

Data Insertion

The options in this area define the data for the Selector components and
how the components will behave when a selection is made.

Note: The Ticker component can be used as a display component or a
selector component. Select the Enable Data Insertion check box to enable
data insertion options for the Ticker component.
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Insertion Type

The options on this list determine the structure of the data that is inserted
when a selection is made. There are six options:

• Position

A target cell is linked to the selector component. When a selection is
made on the selector component the position value of the selection is
entered in the target cell.

For example, if the second item in the list is selected, the number two (2)
will be inserted in the target cell.

• Label

A target cell is linked to the selector component. When a selection is
made on the selector component the label of the selection is entered in
the target cell.

For example, if the user selects B from options A, B, and C, the label B
will be inserted into the target cell.

• Value

A target cell is linked to the selector component. The selector labels are
each associated with a value in the spreadsheet. When a selection is
made on the selector component the source data value of the selection
is entered in the target cell.

• Row

A target row is linked to the selector component. The selector labels are
associated with a range of data organized in rows. When a selection is
made on the selector component, the corresponding row of data values
is entered in the target row.

• Column

A target column is linked to the selector component. The selector labels
are associated with a range of data organized in columns. When a
selection is made on the selector component, the corresponding column
of data values is entered in the target column.

• Filtered Rows

A target range of cells is linked to the selector component. The selector
labels are associated with a range of data organized in rows. When the
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label is selected on the selector component, only the rows that correspond
with that label are inserted in the target rage. For this option, each label
may have more than one row of corresponding data.

• Status List

A target range of cells is linked to the selector component. When a
selection is made on the selector component a value of 1 is entered in
the cell of the target range representing that selection, and a value of 0
is entered in the other target cells in the range.

For example, if the second of three options is selected, the values 0, 1,
and 0 will be inserted into the target range.

Note: The destination cells must be empty.

Source Data

Click the cell selector button adjacent to the Source Data box to select the
source data range that the selector will insert into the Destination range.

Note: For Check Box, Icon, and Toggle Button components, click the Manual
Edit button to enter the Source Data values manually, or to modify the default
values.

Destination

Click the cell selector button adjacent to the Destination box to select the
target cell or range of cells into which the selected source data is inserted.

Note: The required size of the Destination range will vary according to the
Insertion Type selected. For Insertion Types that use columns or rows of
data, be sure to select a Destination range that is large enough to contain
your largest column or row of data.

Orientation

Select an orientation for the selector:
• Horizontal

• Vertical
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Note: The Orientation option is only available for Label Based Menu and
Radio Button components.

Specific to the Filter component

Display Options

This area controls the number of combo boxes displayed for the selected
Filter component.

Number of Filters

Adjust the value displayed in the Number of Filters box to adjust the number
of filters displayed on the Filter component.

Specific to the List Builder component

Source List

Type in the Source List box or click the adjacent cell selector button to select
the title to be displayed above the list of items that can be selected.

Destination List

Type in the Destination List box or click the adjacent cell selector button to
select the title to be displayed above the list of items that have been selected.

Labels

Click the Manual Edit button adjacent to the Labels box to manually enter
the labels, or click the adjacent cell selector button to select the labels that
will populate the source list.

Add Button

Type in the Add Button box or click the adjacent cell selector button to select
the label displayed on the Add button in the List Builder component.
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When the user clicks the Add button, the highlighted item is moved from the
Source list to the Destination list.

Remove Button

Type in the Remove Button box or click the adjacent cell selector button to
select the label displayed on the Remove Button.

When the user clicks the Remove button, the highlighted item is moved from
the Destination list to the Source list.

Update Button

Type in the Update Button box or click the adjacent cell selector button to
select the label displayed on the Update Button.

When the user clicks the Update Button, the selections in the Destination
list and their corresponding data are inserted in the spreadsheet.

Specific to the Accordion Menu component

Categories

Select a category to edit from the list. Click the plus or minus buttons to add
or delete a Category in the list. Click the up or down arrow to change the
Category's position in the list.
• Name

Enter a name for the highlighted Category or use the adjacent cell selector
button to select a cell from the spreadsheet.

• Labels

Click the cell selector button to select the labels within the highlighted
category from the spreadsheet.

• Source Data

Click the cell selector button to select the range of data that corresponds
to the Labels within the highlighted Category.

• Category Label Destination
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Click the cell selector button to select the destination cell for the Category
Name.

Behavior tab
The features in the Behavior tab determine how the selector component
behaves when the visualization is run.

Common tab

Interaction Options

The options in this section determine how the component behaves when the
user interacts with it. Not all options are available for all components.

Insert On

The options on this list define how the component recognizes that a selection
has been made. The following options are available:

• Mouse Click

Data is displayed when the user clicks on the selector component.

• Mouse Over

Data is displayed when the user moves the pointer over the selector
component.

Selected Item

Use the Selected Item list to designate the default selection for the component
when the visualization is run.

• Category

Select the category from the drop-down menu.

This option is only available in the Accordion Menu component.
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• Item

Select an item from the list or click the cell selector button to link to a
dynamically updated item.

Note: This option is not available in the Filter or List Builder components.

Ignore Blank Cells

Ignore Blank Cells prevents the cells past the last non-empty Label from
being shown in the component. This option is useful when you need the
number of selections within the component to be variable.

Note: Ignore End Blanks does not apply to Check Box, Icon, Toggle Button,
or List Builder components. For more information, see Ignore End Blanks
for variable length ranges on page 152.

Dynamic Visibility

For information on the features available in the Dynamic Visibility area, see
Dynamic Visibility on page 251.

Animations and Effects tab

For information about the features in the Animations and Effects tab, see
Animations and Effects tab on page 252.

Specific to the Label Based Menu component

Always Expanded

Check Always Expanded to statically display all of the selections contained
on the menu. If this option is not selected, the Insert On option is disabled
and several other options are enabled.
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Expand On

This option defines the action that will trigger the component to expand:
• Mouse Click
• Mouse Over

Expand Direction

This option defines the direction the menu will expand once it is opened.

Note: Expand Direction options are only available when Orientation is
selected on the General tab.

When the Orientation is Horizontal, the following options are available on
the Expand Direction list:

• Left

• Right

When the Orientation is Vertical the following options are available on the
Expand Direction list:

• Center Down

• Left Down

• Right Down

• Center Up

• Left Up

• Right Up

Open Animation

Use Open Animation to animate the opening of the component.
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Specific to the Sliding Picture Menu component

Slider method

The options on this list control how the Sliding Picture Menu scrolls through
the thumbnails. The following are the available options:

• Buttons

The user must click on the buttons to scroll through the thumbnails.

• Mouse

The Sliding Picture Menu will scroll through the thumbnails as the user
moves the mouse.

Slider amount

The options on this list control the scrolling behavior of the Sliding Picture
Menu. The following are the available options:

• One

The Sliding Picture Menu will scroll through the thumbnails one at a time.

• Page

The Sliding Picture Menu will scroll through the thumbnails a page at a
time. The number of thumbnails per page is determined by the width of
the component.

Scroll Speed

Adjust the Scroll Speed slider to control the speed of the slide behavior as
the user scrolls through the Sliding Picture Menu thumbnails.
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Specific to the Spreadsheet Table component

Row selectability

The options in this area configure whether the rows of a Spreadsheet Table
component are selectable.

Row

Check the box adjacent to Row to enable row selection for all rows of the
table. Clear the box to prevent all rows from being selected.

Check the box adjacent to each row to enable row selection for the row
highlighted.

Specific to the Ticker Component

Item Separator

Enter a character in the Item Separator box to change the separator between
each item.

Scroll Direction

Click the Scroll Direction list to set the direction the scroll will move:

• Left

• Right

Scroll Speed

Adjust the Scroll Speed slider to change the speed of the scroll.
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Specific to the Accordion Menu component

Slide Speed

Adjust the Slide Speed slider to customize how fast the Categories expand
when clicked.

Specific to the Play Selector Component

Play Time

Adjust the value in the Play Time box to control the length of time the
sequence will play.

Auto Play

Click Auto Play to have the component automatically play when the
visualization is loaded.

Auto Rewind

Click Auto Rewind to have the sequence automatically rewind after playing.

Auto Replay

Click Auto Replay to have the sequence automatically replayed after playing.

Specific to the Fisheye Picture Menu component

Zoom Size

Adjust the Zoom Size slider to change the size of the fisheye popup effect
on mouse-over.
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Zoom Speed

Adjust the Zoom Speed slider to configure the speed of the fisheye popup
effect on mouse-over.

Appearance tab
The features on the Apperanace tab let you customize the appearance of
the Selector component.

Layout Tab

The options in this section configure the layout of component properties.

Note: The Layout tab is not available in the Accordion Menu, List Builder,
or Check Box components.

Image Sizing

The options in this area apply only to the Fish-Eye Picture and Sliding Picture
Menu components.

The following options configure the image sizing behavior of the thumbnail
images for the menu:

• Sizing Method

Click an option from the list to set the sizing method of the thumbnail
images for the menu. The following options are available:

• Scale

The image will scale down to fit into the thumbnail area. The aspect
ratio of the image will be preserved.

• Stretch

The image will be sized to fit inside of the thumbnail area.

• Height

Enter or adjust the value in the Height box to set the height of the
thumbnail images.
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• Width

Enter or adjust the value in the Width box to set the width of the thumbnail
images.

Thumbnails

The options in this area apply only to the Fish-Eye Picture Menu and Sliding
Picture Menu components.

The following options are available:

• Horizontal Margin

Adjust the value in the Horizontal Margin box to set the horizontal spacing
between thumbnail images.

• Vertical Margin

Adjust the value in the Vertical Margin box to set the vertical spacing
between thumbnail images and the area border.

Number of Labels Displayed

Enter or adjust the value in the Number of Labels Displayed box to control
the number of labels that appear in the drop-down list.

Note: This option applies only to the Combo Box and Filter components.

Transparency

For more information on Transparency, see Transparency on page 246.

Filter Gap

Adjust the value in the Filter Gap box to set the amount of space displayed
between the dropdowns on the Filter component.

Note: This option applies only to the Filter component.

Markers

Marker options are only available for the Radio Button component. The
following can be adjusted:
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• Marker Size

Enter or adjust the value in the Marker Size box to specify the size of the
radio button markers.

• Horizontal Margin

Enter or adjust the value in the Horizontal Margin box to control the amount
of space between the left and right edges of the background and the radio
buttons and labels.

• Vertical Margin

Enter or adjust the value in the Vertical Margin box to control the amount
of space between the top and bottom edges of the background and the
radio buttons and labels.

Enable Background

Select the Enable Background box to display the background of the
component.

Note: This option applies only to the Radio Button component.

Show Ticker Background

Select the Show Ticker Background box to display the ticker background..

This option applies only to the Ticker component.

Button Separation

Enter or adjust the value in the Button Separation box to control the amount
of space between buttons.

Note: This option applies only to the Label Based Menu component.

Auto Replay

Click the box adjacent to each play selector element you want to display:

• Show Background
• Show Progress Indicator
• Show Rew/Fwd
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• Show Prev/Next

Note: Auto Replay is only available for the Play Selector component.

Show Gridlines

Click Show Gridlines to enable the grid display.

Note: Selecting the Show Gridlines option only displays a grid for cells that
do not have a cell border or a cell pattern specified in the spreadsheet.

Note: This option available only for the Spreadsheet Table component.

Gridlines

• Click Show Vertical Gridlines to display vertical gridlines.

Use the adjacent color selector to customize the color of the vertical
gridlines.

• Click Show Horizontal Gridlines to display horizontal gridlines.

Use the adjacent color selector to customize the color of the horizontal
gridlines.

Note: This option is available only for the List View component.

Custom Column Widths

Click Custom Column Widths to set the width of columns.

Note: This option is available only for the List View component.

Text tab

Show-Text selection box

Select the box in the Show column next to a text element to display that
element on the component. One or more of these elements may be available,
depending on the component type:
• Title
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• Source List Title
• Source List Labels
• Destination List Labels
• Destination List Title
• Destination List Labels
• Button Labels
• Header
• Category Names
• Labels
• Display Value

The following parameters apply to the text element that is selected, indicated
by a blue highlight in the Show Text selection box.

• Text Settings

For information about text settings, including font, size, alignment, and
color, see Format Selected Text on page 247.

• Position

For information about the Position list, see Position on page 248.

• Offset X

For information about the Offset X box, see Offset X on page 248.

• Offset Y

For information about the Offset Y box, see Offset Y on page 249.

• Number Format

For information about the features in the Number Format area, see
Number Format on page 249.

Color tab

Use the color selector buttons to customize the appearance of the component.
The parts of the component that can be customized vary depending on the
component you are working with. The following options may be available:
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Note: Color selector buttons are disabled for the Icon component when
Alerts are enabled.

Buttons

• Button Color

• Symbol Color

• Pressed Button Color

• Pressed Symbol Color

The following apply only to the Accordion and Sliding Picture Menu
components:
• Disabled Symbol Color

• Disabled Button Color

The following apply only to the List Builder component:
• Button Label Color

• Pressed Button Label Color

The following apply only to the Toggle Button component:
• On Color

• Off Color

Category Background

These options apply only to the Accordion Menu component.
• Default Color

• Over Color

• Selected Color

Category Names

These options apply only to the Accordion Menu component.
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• Default Color

• Over Color

• Selected Color

Destination List Labels

These options apply only to the List Builder component.
• Default Color

• Over Color

• Selected Color

Destination List Labels Backgrounds

These options apply only to the List Builder component.
• Default Color

• Over Color

• Selected Color

Display Values

These options apply only to the Ticker component.
• Default Color

• Order Color

• Selected Color

Drop-Down Button

• Button Color

• Arrow Color

• Selected Button Color

• Selected Arrow Color
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Header Background

These options apply only to the List View component.
• Default Color

• Over Color

• Selected Color

Header Labels

These options apply only to the List View component.
• Default Color

• Over Color

• Selected Color

Label

• Default Color

• Mouse Over Color

• Selected Color

The following options only to the Toggle Button component:
• On Color

• Off Color

Label Backgrounds

• Default Color

• Over Color

• Selected Color

Marker

These options apply only to the Radio Button component.
• Default Color
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• Selected Color

Progress Indicator

These options apply only to the Play Selector.
• Marker Color

• Track Color

Rows

These options apply only to the Spreadsheet Table component.
• Over Color

• Selected Color

Scroll Bar

• Track Color

• Thumb Color

• Button Color

• Button Symbol Color

Source List Backgrounds

These options apply only to the List Builder component.
• Default Color

• Over Color

• Selected Color

Source List Labels

These options apply only to the List Builder component.
• Default Color

• Over Color
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• Selected Color

Sort Symbol

This option applies only to the Ticker component.
• Symbol Color

Thumbnails

These options apply only to the Fish-Eye Picture Menu and Sliding Picture
Menu.
• Default Color

• Over Color

• Selected Color

Other

• Gridline Color

• Vertical Gridlines

• Horizontal Gridlines

• Unchecked Color

• Checked Color

• Background Color

• Label Header Color

Alerts tab
For information on the features available on the Alerts Tab, see Alerts Tab
on page 253.

Note: The Alerts Tab applies only to the following Selector components:

• Ticker

• Label Based Menu
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• Combo Box
• List Box
• List Builder
• Icon
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Overview
This section discusses the Properties panel features for Single Value
components. The following Single Value components are available in all
versions of Xcelsius 2008:
• All Dials
• All Gauges
• All Sliders
• All Progress Bars
• Play Control
• Spinner
• Value

For more information about Single Value components, see Using the Single
Value components on page 109.

General tab
The features on the General tab let you link the single value component to
data.

Title

To give the single value component a title, type the desired title in the Title
text box. Alternatively, you can click the Title cell selector button, and select
a title in the spreadsheet.

Data

To provide the single value component with data, you can enter the value
manually in the Data box. Alternatively, you can click the Data cell selector
button to link the single value component to a cell in the embedded
spreadsheet.
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Specific to Dual Slider components

This section applies only to the Dual Slider components.

Low Value
Low Value lets you specify the default value for the left pointer on the Dual
Slider component. To enter the low data value manually, type the desired
value in the Low Value box. Alternatively, you can click the Low Value cell
selector button to select the value in the spreadsheet.

High Value
High Value lets you specify the default value for the right pointer on the Dual
Slider component. To enter the high data value manually, type the desired
value in the High Value box. Alternatively, you can click the High Value cell
selector button to select the value in the spreadsheet.

Scale

The Scale area provides several methods for setting upper and lower limits
in single value components, and ensuring that the initial values are within
the limits. Depending on the component that you are working with, some of
these options may be unavailable:

Manual

Select Manual to enter the limits manually.

Enter the minimum and maximum limits in the boxes, or use the cell selector
button to link the values to cells in the spreadsheet.

Auto

Select Auto to have the minimum and maximum limits automatically calculated
based on one of the following selections:

Note: This option is unavailable for Play Control, Spinner, Dual Slider, and
Value components. Limits for these components must be entered manually.

• Value Based
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The limits comprise a range around the value.

• Zero Based

The limits comprise a range that uses the value as the upper limit and
zero as the lower limit.

• Zero Centered

The limits comprise a range that includes the value and its negative, with
zero at the centerpoint.

• Alert Based

The limits comprise a range based on the selected Alert method..

Behavior tab
The features on the Behavior tab determine how the Single Value component
behaves when the visualization is run.

Common tab

The features in this section appear on the Common tab of the Behavior tab
for single value components. Depending on the component that you are
working with, some of these features may be unavailable.

Movement

You can control the movement of sliders, needles and progress bars. There
are three options for controlling movement:

• Increment

Use the Increment box to restrict values to a determined increment. Enter
the desired increment in the Increment box, or click the Increment cell
selector button to bind the value to a cell in the embedded spreadsheet.

Note: Increment is the only setting available in this section for the Spinner,
Value and Play Control components.

318 Xcelsius 2008 User Guide

Single Value Components Reference17 Behavior tab



• Major Ticks

Select this option to have progress move incrementally only on major
ticks.

• Major and Minor Ticks

Select this option to have progress move incrementally on major and
minor ticks

Limits

The Minimum Limit and Maximum Limit lists each provide three options for
setting the behavior of the minimum and maximum values on the single value
component. Depending on the component that you are working with, some
of these options may be unavailable:

• Fixed

The user cannot set the value to a number less than the minimum value
or greater than the maximum value.

• Adjustable

The user can adjust the value limits when the visualization is run. This
option is available for all components except the Value component.

• Open

The user can set the value to any number that does not conflict with the
specified minimum or maximum value.

Note: Limit behavior options are not available for the Play Control component.

Interaction Options

The features in this section determine how the end user can interact with
the visualization.

Note: The settings in this area do not apply to Slider or Progress Bar
components.
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Auto Resize
Select the Auto Resize check box to enable the component to automatically
resize and fit the number displayed.

Note: The Auto Resize check box is available for Value components, and
is the only setting available in this section for Spinner components.

Mouse Sensitivity
The Mouse Sensitivity slider determines how sensitive the value of the
component is to pointer movements. When the setting is high, small pointer
movements can change the value by large increments. When the setting is
low, pointer movements change the value by small increments.

Note: The Mouse Sensitivity slider is available for Value, Gauge, and Dial
components.

Object Elasticity
The Object Elasticity slider determines the elasticity of the movement of the
needle. If you select Less elasticity, the needle will snap to the new value.
If you select More elasticity, the needle will bounce around the new value
and finally settle in place.

Note: This option is only available for Gauge components.

Mouse Tracking
Click one of the options under Mouse Tracking to specify the direction that
the user must drag the pointer to change the value on a component:

• Vertical

The user must move the pointer vertically (up or down) to change the
value.

• Radial

The user must move the pointer in a circular motion to change the value.

Note: The Mouse Tracking options are available for Gauge and Dial
components only.
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Scroll Behavior
The Scroll Behavior determines the action the user must perform to change
the value.

• Manual

The user must drag the pointer above or below the component to change
the value. For each increment of change, the user must continue to drag
the pointer,

• Auto

The user can drag the pointer and place it above or below the value
component to change the value. The value will automatically continue to
change while the mouse button is held, without requiring further pointer
movement.

Note: This option is only available for Value components.

Enable Play Button

The Enable Play Button check box controls the visibility of the play button
for the component. When the user clicks the Play Button in the visualization,
the component will sequence from the minimum value to the maxium value,
at the increments set for the component.

Click the check box to enable the Play Button and make the following
configuration options available:

Note:

• These options are not available for Dual Slider or Spinner components.
• These options are automatically enabled for the Play Control component.

Auto Play

The Auto Play check box controls whether the play sequence for the
component automatically plays when the visualization is loaded.

Note: This option is only available for the Play Control component.
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Play Time

The Play Time box lets you set the duration of the play sequence in seconds.
You can enter a value from 1 to 100, with 1 being the shortest duration, and
100 being the longest duration.

Auto Rewind

The Auto Rewind check box controls whether the play sequence for the
component automatically rewinds to the minimum value.

Auto Replay

The Auto Replay check box controls whether the play sequence for the
component automatically replays.

Dynamic Visibility

For information about the features in the Dynamic Visibility area, seeDynamic
Visibility on page 251.

Animations and Effects tab

For information about the features in the Animations and Effects tab, see
Animations and Effects tab on page 252.

Appearance tab
The features on the Appearance tab let you customize the appearance of
the Single Value component.

Layout tab

The features in this section control how the tick marks and other layout
options will appear in the visualization.
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Enable Ticks

The Enable Ticks check box controls the visibility of ticks (the small markers
that indicate values) for the component. When you select Enable Ticks, the
following options for customizing the appearance of the ticks are available:

• Auto Scale

Select this option to automatically scale the ticks according to the data.

• Manual

Select this option to manually set the appearance of ticks:
• Number of Ticks

• Major

The Major box lets you specify the number of large ticks displayed
for the component. You can enter a value from 2 to 21 or use the
cell selector to link the value to a cell in the spreadsheet.

• Minor

The Minor Ticks box lets you specify the number of small ticks
displayed between the large ticks. You can enter a value from 0 to
21 or use the cell selector to link the value to a cell in the
spreadsheet.

• Size of Divisions

• Major

The Major box lets you specify the size of the distance between
the large ticks displayed for the component. You can enter a value
from 0 to 100 or use the cell selector to link the value to a cell in
the spreadsheet. Higher values will result in larger distances
between ticks.

• Minor

The Minor box lets you specify the size of the distance between
the small ticks displayed for the component. You can enter a value
from 0 to 100 or use the cell selector to link the value to a cell in
the spreadsheet. Higher values will result in larger distances
between ticks.
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Note: The size of the Minor Divisions is not dependant on the size of the
Major Divisions.

Radial Definition

This section applies to Dial and Gauge components only.
• Minimum Angle

The Minimum Angle box lets you specify the minimum angle the needle
can rotate to.

Note: Minimum Angle is unavailable if you chose Open from the Minimum
Limit dropdown on the Behavior tab.

• Maximum Angle

This option is available for gauge and dial components only. The Maximum
Angle box lets you specify the maximum angle the needle can rotate to.

Note: Maximum Angle is unavailable if you chose Open from the Minimum
Limit dropdown on the Behavior tab .

Show Background

Check this box to display fill the background of the component.

Note: This option is available only for the Value component.

Layout Options

Select the checkbox next to each component part you want to display:
• Show Rew/Fwd

• Show Prev/Next

• Show Slider

Note: The options in this section apply only to the Play Control component.
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Text Tab

Show-Text selection box

Select the box in the Show column adjacent to each text element you want
to display on the component. The following text elements are available:

• Title

• Value

• Limits

Note: The Limits text element is not available for Spinner, Play Control, or
Value components.

Format Selected Text

The following parameters apply to the text element that is highlighted in the
Show-Text selection box.

• Text Settings

For information about text settings, including font, size, alignment, and
color, see Format Selected Text on page 247.

• Position

For information about the Position list, see Position on page 248.

• Offset X

For information about the Offset X box, see Offset X on page 248.

• Offset Y

For information about the Offset Y box, see Offset Y on page 249.

• Number Format

For information about the features in the Number Format area, see
Number Format on page 249.
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Color tab

The following are items that may be available for color customization,
depending on the component you are working with. Click the color selector
button adjacent to the item to change its color.

• Low Marker Color

• High Marker Color

• Track Color

• Background Color

• Up Button/Down Button

• Button Color

• Symbol Color

• Pressed Button Color

• Pressed Symbol Color

• Play Button Color

• Play Symbol Color

• Marker Color

• Limits Background

• Needle Color

• Frame Color

• Center Color

• Tick Color

• Grip Color

Alerts tab
For information about the features on the Alerts tab, see Alerts Tab on
page 253.
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Overview
This section outlines Properties panel features for Map Components. The
following Map components are available in all versions of Xcelsius 2008:

Continents

• Africa by Country
• Asia by Country
• Asia Pacific by Country
• Oceania by Country
• Australia by region
• Central America by Country
• Europe by Country
• European Union by Country
• North America by Country
• South America by Country

Asia Pacific Countries

• Cambodia
• China
• Indonesia
• Japan
• Kazakhstan
• Kyrgystan
• Laos
• Malaysia
• Mongolia
• Myanmar
• New Zealand
• North Korea
• Papua New Guinea
• Phillipines
• South Korea
• Thailand
• Turkmenistan
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• Uzbekistan
• Vietnam

European Countries

• Albania
• Andorra
• Armenia
• Austria
• Azerbaijan
• Belarus
• Bosnia And Herzegovina
• Bulgaria
• Croatia
• Cyprus by District
• Czech Republic
• Denmark
• England
• Estonia
• Faroe Islands
• Finland
• France
• Georgia
• Germany
• Gibraltar
• Greece
• Hungary
• Iceland
• Ireland
• Italy
• Latvia
• Liechtenstein
• Lithuania
• Luxembourg
• Macedonia
• Malta
• Moldova
• Monaco
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• Netherlands
• Northern Ireland
• Norway
• Poland
• Portugal
• Romania
• Russia
• San Marino
• Scotland
• Serbia and Montenegro
• Slovakia
• Slovenia
• Spain
• Sweden
• Switzerland
• Turkey
• Ukraine
• United Kingdom
• Vatican City
• Wales

North American Countries

• Canada
• USA

Other

• World by Continent
• California (US State) by County

For more information, see Using the Map components on page 113.

General tab
The features on the General tab link the map component to data in the
spreadsheet.
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Title

To give the map component a title, type the title in the Title box. Alternatively,
you can click the Title cell selector button and select a title in the spreadsheet.

Region Keys

Region Keys defines the codes used for each region in the map component.
These codes are used by Display Data, Source Data, and Destination Data
to associate values to the appropriate region parameters. You can specify
region codes in one of the following ways:

• If you want to use region codes from the embedded spreadsheet, click
the Region Keys cell selector button and select the cells that contain the
region codes.

• If you want to manually enter region codes, click the Region Keys Manual
Edit button. In the Region Key column of the Region Keys dialog box,
type the region codes.

Display Data

The Display Data cell selector button lets you select the display data for the
map component in the spreadsheet. When a user selects a region on the
map component, the relevant data is displayed.

Depending on the layout of the Display Data range, Xcelsius 2008 searches
for the region codes specified in Region Keys in the following ways:

• If the data range has two columns and more than two rows, Xcelsius 2008
searches for the codes in the first column of the range.

• If the data range has two rows and more than two columns, Xcelsius 2008
searches for the codes in the first row of the range.

• If the data range has two columns and two rows, Xcelsius 2008 searches
the first row and the first column to determine which one has the most
region codes. Xcelsius 2008 then uses either the first row or the first
column for region codes.
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Depending on the location of the region codes, Xcelsius 2008 retrieves
relevant Display Data in the following ways:

• If the region codes are in the first column, Xcelsius 2008 interprets the
data to the right of the region codes as the display data.

• If the region codes are in the first row, Xcelsius 2008 interprets the data
below the region codes as the display data.

Insertion Type

The items on the Insertion Type list determine how Xcelsius 2008 inserts
data for a selected region:

• Rows

Xcelsius 2008 inserts the relevant data into a row of empty cells.

• Columns

Xcelsius 2008 inserts the relevant data into a column of empty cells.

Source Data

The Source Data cell selector button lets you link the source data in the
spreadsheet to the map component.

Destination

The Destination Cell Selector button lets you select a range of empty cells
in the spreadsheet for Xcelsius 2008 to insert data into. When a user selects
a region on the map component, the relevant data is inserted into the empty
cells.

If you chose Rows from the Insertion Type list, you must select a row of
empty cells with the same number of cells as a row in the source data range.
If you chose Columns from the Insertion Type list, you must select a column
of empty cells with the same number of cells as the largest column in the
source data range.
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Behavior tab
The features on the Behavior tab control how the map component behaves
in its interactive format.

Common tab

• Interaction Options

Select from the dropdown to set how the user will make a data selection:
• Mouse Click

• Mouse Over

• Default Selected Region

Select a region from the drop-down menu. This region will be selected
by default when the visualization runs.

• Dynamic Visibility

For information on the options available in the Dynamic Visibility area,
see Dynamic Visibility on page 251

Animations and Effects tab

For information on the options available on the Animations and Effects tab,
see Animations and Effects tab on page 252

Appearance tab
The features on the Appearance tab let you customize the appearance of
the map component.
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Layout Tab

Transparency

Use the slider to set the transparency of the component. A value of 100
means the component is 100% transparent.

Text Tab

Show-Text selection box

Select the box in the Show column next to a text element to display that
element on the component. The following parameters apply to the text
element that is highlighted in the Show-Text selection box.

• Text Settings

For information about text settings, see Text tab on page 246.

• Position

For information about the Position list, see Position on page 248.

• Offset X

For information about the Offset X box, see Offset X on page 248.

• Offset Y

For information about the Offset Ybox, see Offset Y on page 249.

• Number Format

For information about the features in the Number Format area, see
Number Format on page 249

Color Tab

Use the Color Selector button adjacent to each of the options listed here to
change its color:
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• Default Color

The default color for unselected regions and for regions which have no
source data.

• Over Color

The color for regions when the mouse pointer is placed over them.

• Selected Color

The color for selected regions.

• Selectable Color

The color for selectable regions and for regions which have source data.

• Border Color

The color for region borders.

Alerts tab
For information about the features on the Alerts tab, see Alerts Tab on
page 253.
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Overview
This section discusses the Properties panel features for Art and Background
components. The following Art and Background components are available
in all versions of Xcelsius 2008:

• All Backgrounds
• Image Component
• Rectangle
• Ellipse
• Horizontal Line
• Vertical Line

For more information about Art and Background components, see Using
the Art and Background components on page 129.

General tab
The features in this section apply to specific component types.

Common to some components

This section applies to the Background and Image components.

Block Mouse Events

The Block Mouse Events check box uses the background component to
prevent users from interacting with other components. This feature only
works if, in the design view, the background component has been layered
on top of the other components.

If you select Block Mouse Events, any actions that users perform on the
underlying components with their pointers have no effect.

If you clear Block Mouse Events, users can interact with the underlying
components.
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Note: Block Mouse Events is enabled for imported SWF files even if it is
cleared on the General tab.

Specific to Background components

The features in this section apply to the Background components:

Border Scale

The Border Scale slider lets you adjust the width of the background
component's border. When you drag the pointer to the right, the border
becomes thicker. When you drag the pointer to the left, the border becomes
thinner.

Specific to Shape components

The features in this section apply to the following components:

• Ellipse

• Rectangle

Enable Border

Selecting the Enable Border check box makes the shape component border
visible, and provides the following options for customizing the appearance
of the border:

• Color. Click the color selector button to choose a border color.

• Thickness. Type or edit the value in the Thickness box to set the width
of the border.

• Transparency. Use the slider to set the Transparency of the border.

For information about the Transparency box, see Transparency on
page 246.
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Fill

The items on the Type list determine the fill color and shading of the shape
component:

• None. The shape component has no fill.

• Solid. The fill is a solid color.

• Linear (gradient). The fill changes colors as you move from one side of
the shape component to the other.

• Radial (gradient). The fill changes colors as you move from the center of
the shape component to the edge.

Fill Settings

Selecting Linear, Radial, or Solid from the Type list provides the following
options for customizing the appearance of the fill:

• Color

The color selector button lets you select the fill color.

Note: The fill color is also the gradient color.

• Transparency

Use the slider to set the Transparency of the solid fill color or the active
gradient color.

For information on Transparency, refer to Transparency on page 246.

• Gradient Preview

The Gradient Preview determines how the gradient transitions between
two or more colors. It is available only if you selected Linear or Radial
from the Type list.

The default gradient uses with the fill color on the left, then transitions to
black on the right. Move the gradient color markers (indicated by a black
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triangle on the marker below the gradient color) to change where the
gradient begins and ends in the component.

Change a gradient color's properties by selecting its marker and modifying
the Fill and Transparency.

To add a gradient color, hover the mouse over Gradient Preview where
you would like to add the new color, then click on the plus sign that
appears.

To remove a gradient color, drag its marker down and away from Gradient
Preview.

• Rotation

The Rotation box is available only if you selected Linear from the Type
list. You can enter a value from 0 to 360 in the Rotation box to determine
the position of the gradient axis.

Specific to Line components

The features in this section apply to the following components:

• Vertical Line

• Horizontal Line

Line Color

The color selector button adjacent to Line Color lets you select the color of
the line component.

Specific to the Image component

The features in this section apply to the image component only. For more
information, see How to use the Image component on page 130.

Note: The image component supports JPEG and SWF files, as well as
Xcelsius 2008 models. However, it does not support these file types:
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• Progressive JPEG

• JPEG with CMYK coloring

• Nested SWF files

Import

The Import button lets you browse for an image file. When you select an
image file to import, the file name appears in the Filename box.

Resize Image to Component

When you check the Resize Image to Component check box, Xcelsius 2008
scales the imported file to the size of the image component on the canvas.
When you clear this check box, the JPG or SWF file you import appears in
its actual size.

Embed File

The Embed File check box lets you embed a copy of the image file in the
Xcelsius 2008 model. If you select Embed File, the image file becomes part
of the Xcelsius 2008 model. If you clear Embed File, Xcelsius 2008 loads
the image file when the model is viewed in its interactive format.

Hide SWF Background Color

The Hide SWF Background Color check box is available only if you imported
a SWF file. This check box controls whether the background of the SWF file
is displayed in the image component. Selecting Hide SWF Background Color
makes the SWF file background invisible.

Behavior tab

Common tab
• Dynamic Visibility
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For information about the features in the Dynamic Visibility area, see
Dynamic Visibility on page 251.

Animations and Effects tab

For information on Animations and Effects, see Animations and Effects tab
on page 252.
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Overview
This section discusses the Properties panel features for Text components.
The following Text components are available in all versions of Xcelsius 2008:

• Input Text Area
• Input Text
• Label

For more information, see Using the Text components on page 116.

General tab

Default Text

Link to Cell

Use the Link to Cell cell Selector button to link the label to a cell in the
spreadsheet. Any change to the value of this cell will be reflected in the
component.

Enter Text

Use this option to manually enter the default text that will appear when the
visualization is run.

Enable HTML Formatting

This option applies only to the Label and Input Text Area components.

Check this box to enable the use of HTML code for text formatting.

The following HTML tags are supported by:

• Anchor tag (<a>)

• Bold tag (<b>)
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• Break tag (<br>)

• Font tag (<font>)

• Image tag (<img>)

• Italic tag (<i>)

• List item tag (<li>)

• Paragraph tag (<p>)

• Text format tag (<textformat>)

• Underline tag (<u>)

Data Insertion

Insert Data on Load

This option applies only to Input Text and Input Text Area components:

Select the Insert Data on Load check box to insert the default text into the
Destination cell once the generated application is loaded.

Destination

This option applies only to Input Text and Input Text Area components:

Use the cell selector button to select the spreadsheet cell into which the text
will be inserted.

Specific to Label

Use Spreadsheet Formatting

Check this box to display the label with the formatting that has been applied
in the spreadsheet.
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Behavior tab

Common tab

Input Options

Enable Password Protection
Select the Enable Password Protection check box to display typed characters
as asterisks (*). This feature can be used to prevent passwords or other
sensitive information from being displayed on screen.

Note: This option is only available for the Input Text component.

Maximum Number of Characters
When the Maximum Number of Characters check box is enabled, this value
sets the maximum number of characters that a user can enter into the label.
Enter the desired value in the text box, or use the up/down arrows to adjust
the maximum number of characters.

Note: This option is not available for the Label component.

Characters Allowed
Use this field to prevent users from entering certain characters into the label.
All characters will be allowed if the field is left blank. You can manually enter
the characters allowed in the Characters Allowed box or you can click the
cell selector button to select the values in the spreadsheet.

The simplest expression is a single character, such as "a", which will allow
users to enter the letter "a" into the label. Multiple expressions may be
concatenated to create larger groups of allowed or not allowed characters.
For example, the expression "abc" will allow the letters "a", "b", and "c" to
be entered into the label by users.

The dash (-) can also be used to define a range of characters. The expression
"a-z", for example, defines all lowercase letters.

When there are only a few characters that you do not want to be allowed, it
is easier to specify those characters instead of all of the allowed characters.
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This can be done by prefixing the entire field with the caret (^). Every
character other than those specified in the field is then allowed.

For example, to prevent users from entering numbers, the field could be set
to "^0-9".

The caret can also be used throughout the string to switch between allowing
and excluding characters. The first time it appears in the field, the characters
defined by the expressions that follow it will not be allowed until another caret
appears. When a second caret appears, the characters defined by the
expressions that follow it will be allowed until another caret appears.

For example, ^0-9^abc^def defines the following:

• numbers are not allowed

• a, b, and c, are allowed

• d, e, and f are not allowed

Because the dash and caret have special meanings, there is a specific way
to specify the actual dash and caret as part of the character set.

To specify a dash or carat as part of the character set, place a backslash (\)
before the special character. for example, a dash is specified by typing "\-"
and a caret is specified by typing "\^".

Because the backslash also has a special meaning, a backslash must also
be represented by placing a backslash before it.

A few common characters sets are shown below:

• Whole Numbers (123): "\-0-9"

• Real Numbers (1.5): "\-0-9."

• Fractions (1/2): "\-/0-9"

• Positive Whole Numbers: "0-9"

• Positive Decimal Numbers: "0-9."

• Letters: "a-zA-Z"

• Numbers and Letters: "0-9a-zA-Z"

Note: This option is only available for the Input Text component.
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Scroll Bar Options

Horizontal Scroll Bar
This section lets you define the behavior of the horizontal scroll bar. A
horizontal scroll bar can be used to quickly navigate horizontally through text
and is useful for displaying long lines of text within a narrow text area.

• On

Select this option to attach a horizontal scroll bar to the text area. This
scroll bar will always be shown.

• Off

Select this option when a horizontal scroll bar is unnecessary or not
preferred.

• Auto

Select this option to attach a horizontal scroll bar to the text area. This
scroll bar will automatically hide itself when the length of each line fits
within the width of the text area.

Note: This option is not available for the Input Text component.

Vertical Scroll Bar
This section lets you define the behavior of the vertical scroll bar. A vertical
scroll bar can be used to quickly navigate vertically through text and is useful
for displaying several lines of text within a short text area.

• On

Select this option when a vertical scroll bar is unnecessary or not
preferred.

• Off

Select this option to attach a vertical scroll bar to the text area. This scroll
bar will automatically hide itself when the height of all the lines of text fit
within the height of the text area.

• Auto
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Select this option to attach a vertical scroll bar to the text area. The scroll
bar will automatically hide itself when the height of all the lines of text fit
within the height of the text area.

Note: This option is not available for the Input Text component.

Dynamic Visibility

For information about dynamic visibility, see Dynamic Visibility on page 251.

Animations and Effects tab

For information about the features in the Animations and Effects tab, see
Animations and Effects tab on page 252.

Appearance tab

Layout tab

Wrap Text

Select the Wrap Text check box to cause lines of text that are longer than
the component width to wrap to the next line of the label.

Note: This option does not apply to the Input Text component.

Transparency

For information about Transparency, see Transparency on page 246.

Note: This option is not available for the Label component.
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Text tab

Format Selected Text

For information about the text settings, see Text tab on page 246.

Number Format

For information about the features in the Number Format area, see Number
Format on page 249.

Note: This option is available only in the Label component.

Color tab

Click the cell selector button adjacent to an element to customize its color.
The following options are available for customizing colors in the text
component:

• Background Color

You can customize the color of the text component background.

• Scroll Bar options

• Track Color

You can customize the color of the scroll bar track.

• Thumb Color

You can customize the color of the thumb piece in the scroll bar.

• Button Color

You can customize the color of the scroll buttons.

• Button Symbol Color

You can customize the color of the arrows in the scroll buttons.

Note: These options are not available for the Input Text component.
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Specific to Label

Numeric Format

For more information about the Numeric Format list, see Number Format on
page 249.

Background

Use the following options to configure the appearance of the label background
and borders:

• Draw Border On

Use this option to specify which sides of the border are currently being
adjusted by the Show Border and Border Thickness options. The four
sides of the label border - Top, Bottom, Left, and Right - can be adjusted
independently by selecting the appropriate side. All four sides can be
adjusted simultaneously by selecting All Sides.

• Show Border

Select Show Border to display a border on the label, at the side specified
by the Border list. To customize the border color, click the adjacent color
selector button.

• Border Thickness

For information about the Border Thickess box, see Thickness on page 246.

• Show Fill

Select the Show Fill check box to display a colored background behind
the label. To customize the fill color, click the adjacent color selector
button.
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Overview
This section discusses the Properties panel features for Web Connectivity
components. The following Web Connectivity components are available in
all versions of Xcelsius 2008:

• URL Button

Xcelsius Engage versions have the following additional components:

• Slide Show
• Connection Refresh Button

Xcelsius Engage Server and BusinessObjects Xcelsius Enterprise have all
of the components listed above, as well as the following additional component:

• Reporting Services Button

For more information about Web Connectivity components, seeUsing the
Web Connectivity components on page 132.

General Tab

Common to most components

Label

Use this option to set the text that will appear on the button. Type in the Label
box, or click the adjacent cell selector button to select the label for the
component.

Note: This option does not apply to the Slide Show component.
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URL

Use this option to enter the Uniform Resource Locator (URL) link for the
button. A URL is also referred to as a Web address. Type in the URL box or
click the adjacent cell selector button to select the URL from the spreadsheet.

In the generated visualization, the URL associated with the button will update
if the URL in the linked cell changes. This allows the URL to change
dynamically, thereby allowing several different pages or files to be used by
one component in the visualization.

Note:

• "http://" or "https://" is required for all URLs.
• This option does not apply to the Connection Refresh Button component.

Specific to the Slide Show component

URL (JPEG or SWF file)

Type in the URL box or click on the URL cell selector button to select the
URL for the slide show. When the URL is bound to a spreadsheet cell,
changes to the value of the cell will cause the Slide Show to load the image
at the URL specified in the cell.

Once the image file has been loaded, the Slide Show will transition to the
image using the transition parameters defined in the Behavior tab.

Note: Progressive JPEGs and JPEGs with CMYK coloring (as opposed to
the standard RGB coloring) are not supported.
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Specific to URL Button component

Window Options

Use the options in this section to choose where the link should be opened
when the URL button is clicked.

New Window

Select this option to open the link in a new browser window.

This Window

Select this option to open the link in the same browser window. The current
contents of the window will be replaced.

Specific to theConnectionRefreshButton component

Available Connections

Select the connections that will be refreshed when the user clicks the
Connection Refresh Button.

• Connections list box

In the connections list box, select the checkbox adjacent to each
connection that you want to be refreshed.

To select all connections, select the checkbox at the top of the column.

Launch Data Manager

Click this button to launch the Data Manager to add or configure external
connections. See Using the Data Manager on page 162.
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Specific to Reporting Services Button

Label

Type the text to be displayed on the Button or click the cell selector button
to select a cell from the spreadsheet.

Reporting Services

Click the Select Report button to launch the Select Report dialog box:

• Select Report dialog box
• Xcelsius for Reporting Services URL

Type the URL or select from the dropdown menu. Click the Submit
button to display the reports available at the selected URL.

• Reports
• Select Source Report:

This area displays the file directory at selected URL.

• Report Parameters:

This area lists the Name and the Type of data for the parameters in
the selected report.

• Launch Report in Web Browser button

Click this button to preview the selected report in your default web browser.

• Reports list box

This area will display the raw data contained in the report in columns by
parameters.

Click OK or Cancel to return to the Properties panel.

Reporting Parameters

• Display Parameters at Run Time
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Check this box to display the report parameters when the visualization is
run.

• Reporting Parameters list box

This area displays the report parameters to be configured.

• Use Service Values

Click Use Service Values for the highlighted parameter to use values in
the report. Select the values to be used from the dropdown menu.

• Link to Cell

Click the Link to Cell use values from the spreadsheet. Click the adjacent
cell selector button to select a range of cells.

Data Mapping
• Default

Click Default to use the default data maps.

• Advanced

Click Advanced to use specific ranges other than the defaults.
• Mapped Ranges

This area lists ranges that have been mapped. Click the plus and
minus buttons to add or delete ranges from the list.

• Selected Columns

This area lists the columns for the selected Range. Click the up and
down arrows to change the sort order of the highlighted Column. Click
the "X" button to remove a column from the list.

• Name

Type a name for the selected Range.

• Range

Click the Range cell selector button to select a range where the report
data will be inserted.
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History
• Use Report History

Check this box to enable use of the report's history.

Behavior tab

Common tab

Trigger behavior

Trigger Cell
Use this option to select a cell from the spreadsheet that can trigger a web
connection or connection refresh. This feature allows another action within
the visualization, such as a List Box selection, to trigger the component - as
if the component itself was clicked. The component is triggered according
to the trigger behavior selected.

There are three behavior options for triggering the component:

• When Cell Updates

The data is refreshed anytime the Trigger Cell updates.

• When Value Changes

The data is refreshed when the value in the Trigger Cell changes.

• When Value Equals

The data is refreshed when the value in the Trigger Cell is equal to a
target value.

Enter the target value or use the cell selector to bind to a cell in the
spreadsheet.
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Dynamic Visibility

For detailed information about Dynamic Visibility, see Dynamic Visibility on
page 251.

Specific to Slide Show component

Transition Behavior
Use the parameters in this section to control the timing and style of the
transition.

Transition Type

Use this option to set the style of the transition between each slide.

Easing Type

Use this option to set the behavior of the transition. The following options
are available:

• Slow In

The transition will begin slowly and accelerate as it progresses.

• Slow Out

The transition will begin quickly and slow down as it progresses.

• Slow In and Out

The transition will begin slowly and increase in speed until the middle of
the transition. The transition will then decelerate until it is finished.

Transition Time

Use this option to set the amount of time for the transition between each
slide. Enter the desired value in the text box, or use the up/down arrows to
adjust the time.

Note: A smaller number is better for smoother transitions, while a larger
number may be better for performance.
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Smoothness

Use the slider to set the smoothness of the transition.

Specific to Reporting Services Button

Common Tab

• Refresh Options
• Refresh On Load

Check this box to refresh the data when the visualization is run.

• Refresh Every

Check this box to refresh the data at a set interval.

Type or use the up/down arrows to set the interval integer.

Click the dropdown menu to select the interval timeframe: Seconds,
Minutes, or Hours.

• Load Status
• Loading Message

Type or use the cell selector to select a message that will be displayed
while the data connection is loading.

• Idle Message

Type or use the cell selector to select a message that will be displayed
while the data connection is idle.

• Insert In

Use the cell selector button to select a cell where the Loading and Idle
Messages will be inserted.

• Enable Load Cursor

Check this box to display a special cursor while the data connection
is loading.

• Disable Mouse Input on Load
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Check this box to disable user interaction while the data connection
is loading.

• Trigger Behavior

Trigger Cell

Use this option to select a cell from the spreadsheet that can trigger a
web connection or connection refresh. This feature allows another action
within the visualization to trigger the component - as if the component
itself was clicked. The component is triggered according to the trigger
behavior selected.

There are three behavior options for triggering the component:

• When Cell Updates

The data is refreshed anytime the Trigger Cell updates.

• When Value Changes

The data is refreshed when the value in the Trigger Cell changes.

• When Value Equals

The data is refreshed when the value in the Trigger Cell is equal to a
target value. Enter the target value or use the cell selector to bind to
a cell in the spreadsheet.

• Dynamic Visibility

For detailed information about Dynamic Visibility, see Dynamic Visibility
on page 251.

Animations and Effects tab

For information about the features in the Animations and Effects tab, see
Animations and Effects tab on page 252.
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Appearance tab

Layout tab

Show Button Background

Select the Show Background check box to show a background in the button.
By clearing the Show Background check box, you can create a text-only link.
You can also clear the check box and place the transparent button over an
imported image to create a custom button.

Note: This option is not available in the Slide Show and Reporting Services
Button components.

Transparency

For detailed information about this option, see Transparency on page 246.

Note: This option does not apply to the URL Button component.

Text tab

For detailed information about the settings on the Text tab, see Text tab on
page 246.

Note: This tab does not apply to the Slide Show component.

Color tab

Use this area to customize the color of various parts of a component.

Note: This tab is not available for the Slide Show component.
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Button

Default Color

Click the Default color selector button to change the background color of the
button in its default state.

Pressed Color

Click the Pressed color selector button to change the background color of
the button when it is clicked.

Label

Default Color

Click the Default color selector button to change the text color of the label
when the button is in its default state.

Pressed Color

Click the Pressed color selector button to change the text color of the label
when the button is clicked.

Specific to Slide Show component

Image Options

Sizing Method
Use this option to define how images are sized within the bounds of the Slide
Show.

• Original Size

The image is shown at its actual size. Areas of the image that extend
outside of the Slide Show are not shown.
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• Stretch

The image is stretched to fit the bounds of the Slide Show.

• Scale

The image is sized to the extents of the Slide Show bounds while still
maintaining its aspect ratio.

Horizontal Alignment
Use this option to define how images are horizontally aligned to the bounds
of the Slide Show. Choose from the following options:

• Center

The image is centered horizontally within the Slide Show.

• Left

The image is aligned to the left edge of the Slide Show.

• Right

The image is aligned to the right edge of the Slide Show.

Vertical Alignment
Use this option to define how images are vertically aligned to the bounds of
the Slide Show. Choose from the following:

• Middle

The image is centered vertically within the Slide Show.

• Top

The image is aligned to the top edge of the Slide Show.

• Bottom

The image is aligned to the bottom edge of the Slide Show.
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Overview
This section discusses the Properties panel features for Other components.
The following Other components are available in all versions of Xcelsius
2008:

• Local Scenario Button

• Trend Icon

• Print Button

• Reset Button

Xcelsius Engage versions have the following additional components:

• Calendar

• History

• Panel Set

• Source Data

• Trend Analyzer

• Grid

General tab

Common to some components

Title

Use the Title box to manually enter the title for the component or click the
cell selector button to select the title from the spreadsheet. When the title is
bound to the spreadsheet, changes to the value of the underlying spreadsheet
cell will be reflected in the button label.

Note: This option applies only to the Calendar and Panel Set components
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Label

Use the Label text box to manually enter the button label or click the Label
cell selector button to select the button label from the spreadsheet. When
the label is bound to the spreadsheet, changes to the value of the
spreadsheet cell will be reflected in the label.

Note: This option applies only to the Local Scenario Button, Print Button,
and Reset Button components.

Specific to the Trend Analyzer component

Data

Use the cell selector button to select the range of cells that contains the data
you want to analyze.

Trend/Regression Type
• Use Best Fit

Use this option to have Xcelsius 2008 determine the appropriate analysis
type.

• Select a Type

Use this option to select the analysis type:
• Linear
• Logarithmic
• Polynomial
• Power
• Exponential
• Order

This option is only available when the Trend Type: Polynomial is
selected. Type a value between two (2) and six (6) in the box, click
the up/down arrows to adjust the value, or click the cell selector button
to select a value in the spreadsheet.
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Insertion Options
• Analyzed Data Destination

Use the cell selector button to select the spreadsheet destination range
for the analyzed data. The spreadsheet cells must be empty.

• More Options

Use these options to insert additional analysis information in the
spreadsheet:
• Equation Type Destination

This inserts into the destination cell the type of equation that was used
to analyze the data

• Equation Destination

This inserts into the destination cell the equation that was used to
analyze the data.

• R2 Value Destination

This inserts into the destination cell the R2 value of the analysis.

• F Value Destination

This inserts into the destination cell the F value of the analysis.

Specific to the Calendar component

Data Insertion

Use the options in this section to define how the Calendar component will
behave when a selection is made.

Insert Type

Use this option to specify the type of data (Day or Date) that is inserted when
a selection is made.
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Destination

Use this option to select the cell into which the Day or Date from the calendar
will be inserted.

Month Destination / Year Destination

Click the cell selector button to select a cell for the Month and/or Year of the
date selected on the Calendar to be inserted into.

Specific to the Grid component

Data

Use this option to select the range of data for the grid from the spreadsheet.
The grid displays a value for each cell selected, and arranges them in the
same order as the selection. Any change to the values in these cells is
reflected in the corresponding grid values. Similarly, any change to the grid
values is inserted into the corresponding cells and will be reflected across
all other components linked to the corresponding cells.

Scale

Use the options in this section to define the data value lower and upper limits.
These limits are applied to every value in the grid.

Minimum Limit

Minimum Limit is the lowest allowable value. Enter the value in the box, or
use the cell selector button to select a value from the spreadsheet.

Maximum Limit

Maximum Limit is the lowest allowable value. Enter the value in the text box,
or use the cell selector button to select a value from the spreadsheet .
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Specific to Trend Icon component

Data

The value of the Data parameter determines which icon is displayed for the
component:

• If the value of Data is greater than 0, the component displays an up arrow.

• If the value of Data is less than 0, the component displays a down arrow.

• If the value of Data is equal to 0, the component displays a neutral symbol.

Use the Data box to manually enter the data value for the component or click
the cell selector button to select the data value from the spreadsheet.

Colors

Click the color selector button adjacent to an attribute to customize the color.
The following options for customizing colors are available:

• Positive Value Color

You can customize the color the trend icon changes to when its data
value is greater than zero.

• Zero Value Color

You can customize the color the trend icon changes to when its data
value is equal to zero.

• Negative Value Color

You can customize the color the trend icon changes to when its data
value is less than zero.
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Specific to the Panel Set component

Panel Titles

You can use the Manual Edit button or the cell selector button to indicate
what title you want to appear for each frame on the Panel. If you use the
Manual Edit button you can type in the title manually. If you select the cell
selector button, you can link the title to a cell in your spreadsheet.

Layout

Use the Layout option to select what you would like your panel to look like.
There are a variety of layouts to choose from.

Content

Panels

Use the Panels list to select a panel to link content to. The options selected
in the Content section will apply only to the highlighted Panel in the Panels
list.

Content Type
• Embedded JPEG or SWF

Use the Embedded option to link SWF files or JPEGs to the Panel directly
from your computer or a network location. Click the Import Button to open
a dialog box for the Panel, click the Click to Add Images button to open
a second dialog box which allows you to navigate to the desired file that
will be embedded in the component.

• By URL

Use the By URL option to enter the URL location for the JPEG or SWF
files that you want to link to the panel.
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The URLs box is only available if the Content Type selected is By URL.
You can use the manual edit button or the cell selector button to point
the component to one or more URLs. Click the manual edit button to type
in the URLs manually. Click the cell selector button to link the URLs to
cells in the spreadsheet.

• None

Use this option to leave the selected panel empty.

• Drop-Down Menu Labels

Use Drop-Down Menu Labels to add labels to the content in the selected
Panel. If you use the manual edit button you can type in the labels
manually. If you select the cell selector button, you can link the labels to
cells in your spreadsheet.

Specific to the History component

Data

Use the cell selector button to select the cell that contains the data you want
to track.

Insertion Options

• Data Destination. Use the cell selector button to specify the cell(s) that
the history data will be inserted into.

Note: The number of cells in the Data Destination range will determine
the number of data changes retained by the component. Once the limit
is reached, the oldest data change will drop off. If the range is a single
column with multiple rows, the newest data is inserted in the bottom cell
bumping older data up one row. If the range is a single row with multiple
columns, the newest data is inserted in the right-most cell bumping older
data left one column. If the range has multiple rows and multiple columns,
the newest data will be inserted in the right-most column’s bottom cell;
older data is then bumped left to the limit of the range and then up one
row to the right most column in a zigzag pattern.

• Select the freqency of the cell tracking:
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When Value Changes. The cell history will be recorded each time the
value in the cell changes.

•

• On Interval. The cell history will be recorded at scheduled intervals.

Enter the interval duration in the Duration (seconds) box.

Specific to the Source Data component

Insertion Type

Select the Insertion Type from the dropdown list.

• Value

Select this option to have the selected item’s value inserted in the target
cell

• Row

Select this option to have the selected item’s corresponding row data
inserted in the target range

• Column

Select this option to have the selected item’s corresponding column data
inserted in the target range

Behavior tab

Common tab

Dynamic Visibility

For detailed information about Dynamic Visibility, see Dynamic Visibility on
page 251.
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Note: This option is not available for the History, Source Data and Trend
Analyzer components. These components are not displayed in the
visualization.

Specific to the Calendar component

These settings control the default date and date range for the Calendar
component.

Default Date
• Use Current Date

Click this option to control the default date for the Calendar component.
Selecting this option means that the Calendar component will always load
with the current date.

• Use Custom Date

Click this option to set the default date to a specific date. Selecting this
option makes the Day, Month and Year entry fields available. For each
field type the number value or click the cell selector button to select a
value from the spreadsheet.

• Default Day

Use this option to specify the default Day for the Calendar component.

• Default Month

Use this option to specify the default Month for the Calendar
component.

• Default Year

Use this option to specify the default Year for the Calendar component.

Enable Calendar Limits

Check this box to control the date range for the Calendar component.
Selecting this option requires you to specify the Start Month, Start Year, End
Month and End Year. Unselecting this option means that the Calendar
component will allow the user to scroll through all dates.
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• Start Month

Use this option to specify the Start Month for the Calendar component.

• Start Year

Use this option to specify the Start Year for the Calendar component.

• End Month

Use this option to specify the End Month for the Calendar component.

• End Year

Use this option to specify the End Year for the Calendar component.

Specific to the Grid component

Increment

Grid item values that are manually set are rounded to the Increment number,
allowing restricted input for quantities that require specific increments, such
as dozens.

Numbers can also be made more readable by using the Increment to round
to a specific digit. Enter the desired value in the text box, or use the cell
selector button to select a value from the spreadsheet.

Limits

Minimum Limit

Use this option to set the Minimum Limit behavior for the component. Choose
from the following:

• Open - The user can set the grid items to any value that does not conflict
with the Scale Maximum Limit.

• Fixed - The user cannot set the grid items to values less than the Scale
Minimum Value.

Xcelsius 2008 User Guide 379

22Other Components Reference
Behavior tab



Maximum Limit

Use this option to set the Maximum Limit behavior for the component. Choose
from the following:

• Open - The user can set the grid items to any value that does not conflict
with the Scale Minimum Limit.

• Fixed - The user cannot set the grid items to values greater than the
Scale Maximum Limit

Interaction

Enable Interaction

Check Enable Interaction to enable runtime manipulation of the values in
the grid.

Note: Regardless of this option, input is disabled for all grid items linked to
cells with formulas.

Mouse Sensitivity

Use this setting to determine how sensitive the value of the component is to
pointer movements. Higher sensitivity settings are beneficial when the value
of the component needs to span a large range, while lower settings permit
more granular manipulation of the value.

Scroll Behavior

Use the Scroll Behavior options to specify how users will adjust the values
of the component.

• Auto: The value of the cells will be controlled by dragging and holding the
pointer above or below the cell. The value will automatically and continually
be adjusted as long as the mouse button remains down. If the pointer is
above the cell, the value increases. If the pointer is below the cell, the
value decreases. The farther away the pointer is from the value display,
the faster the value will change.

• Manual: The value of the cells will be controlled by manually dragging
the pointer. When the pointer is dragged up or down, the value is adjusted
by an amount approximate to the distance dragged. Dragging up increases
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the value of the component. Dragging down decreases the value of the
component.

Specific to the Panel Set component

Panel Behavior

Enable Maximize Button

Select this option to allow the user to expand a single Panel so that it covers
the other panels and then minimize it again so it returns to its original size.
This feature is useful when you want to emphasize different sets of data at
different times during a presentation.

Zoom Speed

Use the slider to set the speed of the window animation faster or slower.

Selected Item

Panel

Select which panel you want to set as the default when the visualization is
run.

Item

Select which content you want to appear in the default panel when the
visualization is launched.
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Ignore Blank Cells

In Values

Check In Values to prevent all of the empty values past the last non-empty
value from being displayed in the Panel set component. This allows a variable
amount of data to be displayed in the Panel Set component.

Specific to the Print Button component

Print Scale
• Scale To:

Enter a value in the text box to manually set the scale.

• Scale to Fit Page:

Select this option to scale the print version of the visualization to the paper
size.

Specific to the Source Data Component

Selected Item Index

Enter the value or use the cell selector button to select a value from the
spreadsheet.

Animations and Effects tab

For information about the features in the Animations and Effects tab, see
Animations and Effects tab on page 252.
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Specific to the Calendar component

Enable Sound

Check the Enable Sound box to enable sound for the selected component
when the visualization is run. A sound effect will be played when the
component is interacted with.

Appearance tab

Layout tab

Show button background

This option controls the visibility of the title for the selected component. When
you select the Show Title check box, the following options for customizing
the appearance of the title become available:

Note: This is applicable only to the Local Scenario Button, Print Button, and
Reset Button components.

Transparency

For detailed information on Transparency, see Transparency on page 246

Specific to the Panel Set component

Show Panel Headers

Check the Show Panel Headers box to display the header with the title,
maximize and dropdown menu for each Panel.
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Number of Panels Displayed

Enter a value or use the up/down arrows to adjust the value. This option will
determine the number of labels displayed by default in the drop-down menu
of the panels.

Background Transparency

Use the slider or enter a value to adjust the transparency of the Panel Set’s
background. A value closer to 100% will display a lighter colored background.
This setting does not affect the content of the component.

Specific to the Grid component

Vertical Margin

Enter a value or use the up/down arrows to adjust the value. This setting
modifies the amount of space between each column of items in the Grid
component.

Horizontal Margin

Enter a value or use the up/down arrows to adjust the value. This setting
modifies the amount of space between each row of items in the Grid
component.

Text tab

Select the box in the Show column adjacent to each text element you want
to display on the component.

Format Selected Text

The following parameters apply to the text element that is highlighted in the
Show-Text selection box.

• Font Settings

For information about font settings, see Text tab on page 246.

• Position
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For information about the Position list, see Position on page 248.

• X (Horizontal) Offset

For information about the Offset X box, see Offset X on page 248.

• Y (Vertical) Offset

For information about the Offset Y box, see Offset Y on page 249.

• Number Format

For information about the features in the Number Format area, see
Number Format on page 249

Color tab

You can customize the color of component parts. The items available depend
on the component you are working with. Click the color selector button
adjacent to the item to change its color.

Alerts tab
For information on the features available on the Alerts Tab, see Alerts Tab
on page 253.
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Supported Excel Functions
This chapter contains a list of the Microsoft Excel functions that Xcelsius
2008 supports.

ACOSHACOSABS

ASINHASINAND

ATAN2ATANASSIGN

AVERAGEAVEDEVATANH

CEILINGBETADISTAVERAGEA

CONCATENATECOMBINCHOOSE

COUNTCOSHCOS

DATECOUNTIFCOUNTA

DAYDAVERAGEDATEVALUE

DCOUNTDBDAYS360

DEGREESDDBDCOUNTA

DIVIDEDGETDEVSQ

DOLLARDMINDMAX

DSSTDEVPDSTDEVDPRODUCT

DVARPDVARDSUM

EVENEOMONTHEDATE

EXPONDISTEXPEXACT

FINDFALSEFACT

FIXEDFISHERINVFISHER

FVFORECASTFLOOR

GTGEOMEANGE

HOURHLOOKUPHARMEAN

INTINDEXIF
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IRRIPMTINTERCEPT

ISNUMBERISNAISBLANK

LELARGEKURT

LNLENLEFT

LOOKUPLOG10LOG

MAXMATCHLOWER

MINMIDMEDIAN

MIRRMINUTEMINUS

MONTHMODEMOD

NETWORKDAYSNEN

NORMSINVNORMINVNORMDIST

NPERNOWNOT

OROFFSETNPV

POWERPMTPI

PVPRODUCTPPMT

RANDRADIANSQUOTIENT

RATERANKRANGE_COLON

RIGHTREPTREPLACE

ROUNDUPROUNDDOWNROUND

SINSIGNSECOND

SMALLSLNSINH

STDEVSTANDARDIZESQRT

SUMPRODUCTSUMIFSUM

SUMX2PY2SUMX2MY2SUMSQ

TANSYDSUMXMY2

TIMETEXTTANH

TRUETODAYTIMEVALUE

VALUEUPPERTRUNC
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VLOOKUPVDBVAR

WORKDAYWEEKNUMWEEKDAY

YEARFRACYEAR
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Online documentation library

Business Objects offers a full documentation set covering all products and
their deployment. The online documentation library has the most up-to-date
version of the Business Objects product documentation. You can browse
the library contents, do full-text searches, read guides on line, and download
PDF versions. The library is updated regularly with new content as it becomes
available.

http://support.businessobjects.com/documentation/product_guides/

Additional developer resources

http://devlibrary.businessobjects.com

Online customer support

The Business Objects Customer Support web site contains information about
Customer Support programs and services. It also has links to a wide range
of technical information including knowledgebase articles, downloads, and
support forums.

http://www.businessobjects.com/support/

Looking for the best deployment solution for your company?

Business Objects consultants can accompany you from the initial analysis
stage to the delivery of your deployment project. Expertise is available in
relational and multidimensional databases, in connectivities, database design
tools, customized embedding technology, and more.

For more information, contact your local sales office, or contact us at:

http://www.businessobjects.com/services/consulting/

Looking for training options?

From traditional classroom learning to targeted e-learning seminars, we can
offer a training package to suit your learning needs and preferred learning
style. Find more information on the Business Objects Education web site:

http://www.businessobjects.com/services/training
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Send us your feedback

Do you have a suggestion on how we can improve our documentation? Is
there something you particularly like or have found useful? Drop us a line,
and we will do our best to ensure that your suggestion is included in the next
release of our documentation:

mailto:documentation@businessobjects.com

Note: If your issue concerns a Business Objects product and not the
documentation, please contact our Customer Support experts. For information
about Customer Support visit: http://www.businessobjects.com/support/.

Business Objects product information

For information about the full range of Business Objects products, visit:
http://www.businessobjects.com.
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Accordion Menu component 91
Accordion Menu, sample visualization 101
addresults.aspx 177, 181
Adobe PDF, exporting visualizations to 137
alerts 154

Alerts tab
chart components 280
features on 253
map components 335
selector components 312

Appearance tab 271
chart components 271
map components 333
other components 383
selector components 303
text components 351
web connectivity components 365

area chart 76
art and background components 129

B
background components 129

Behavior tab 342
General tab 338

bar chart 76
Behavior tab 342

background components 342
chart components 267
Dynamic Visibility 251
map components 333
other components 377
selector components 297

Behavior tab (continued)
text components 348
web connectivity components 361

Browse button 245
bubble chart 76
BusinessObjects Enterprise 216, 217

exporting SWF files 217
opening XLF files 217
refreshing SWF files 221
rights 224
saving XLF files 216
viewing SWF files 219

BusinessObjects Enterprise, exporting
visualizations to 140

C
candlestick chart 76
canvas 44

fitting to components 44
placing components on 43
resizing 44

Cell Selector button 244
changing 44

canvas size 44
global styles 61

chart components 76
Alerts tab 280
Appearance tab 271
Behavior tab 267
creating 81
Drill Down tab 264
General tab 260
types 76

Check Box component 91
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Color Selector button 244
column chart 76
combination chart 76
Combo Box component 91
components 51

hiding with Object Browser 51
selecting with Object Browser 50

Components Explorer 40
configuring

XML Data Button component 176
creating

charts 81
global styles 63
templates 157, 162
visualizations

importing Excel files 70
selecting data sources 70

Crystal Reports Server 217
exporting SWF files 217
opening XLF files 217
refreshing SWF files 221
rights 224
saving XLF files 216
viewing SWF files 219

Crystal Reports Server, exporting visualizations
to 140

Crystal reports, unmanaged 211
Crystal Xcelsius

how it works 36
importing XLF files from previous versions

33
new features 24
using XML maps in 198

Crystal Xcelsius 2008
tools 40

D
data comparison presentation, example 39
data sources

selecting 70
updating 72

deleting components 52
dial component 109
display status, sample visualization 150
drill down chart, sample visualization 84
Drill Down tab, chart components 264
Dynamic Visibility 251

functionality 148
sample visualization 148

E
ellipse component 129
emailing visualizations 138
embedded fonts 58
Enterprise 217

exporting SWF files 217
opening XLF files 217
refreshing SWF files 221
rights 224
saving XLF files 216
viewing SWF files 219

Excel 234
frequently asked questions 234
linked Excel files 240
macros 241
regional formats, supported 240
Server Busy message 236

Excel files
linked 240
maximum size of 240
XML maps 198

Export Settings 72
exporting visualizations 137

to Adobe PDF 137
to BusinessObjects Enterprise 140
to Crystal Reports Server 140
to Flash 139
to HTML 140
to PowerPoint 136, 235
to Word 138
with Outlook 138
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external files 130
embedding 130
nested 131

F
Filter component 91
Filter component, sample visualization 97
Fish-Eye Picture Menu component 91
fit canvas to components 44
fit canvas to window 44
Flash 139

exporting visualizations to 139
slow run time 237

Flash Player settings 120
Font Options 58
Font Settings 246
fonts

understanding 58
format 240

regional 240
scientific 236
table component vs. spreadsheet 234

Format menu 56
Align 56
Center in Document 57
Make Same Size 57
other commands 57
Space Evenly 57

FS command button 116

G
gauge component 109
General tab 338

background components 338
chart components 260
map components 330
other components 370
text components 346
web connectivity components 356

global styles 60
changing 61
creating 63
transferring 64

grid component 116
sample visualization 123

grid tool 45
grouping components, with Object Browser 51

H
hiding components, with Object Browser 51
horizontal line component 129
HTML, exporting visualizations to 140

I
Icon component 91
ignore end blanks 152
image component 129

embedding external files 130
how to use 130
nested external files 131

Import Model 55, 56, 70
importing Excel files 70
Information button 245
InfoView 219

refreshing outside 223
refreshing SWF files 221
viewing SWF files 219

input text area component 116
installation, frequently asked questions 232
interactive calendar 116
interface, Crystal Xcelsius 2008 40

L
Label Based Menu component 91
label component 116
line chart 76
linking data sources 70
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List Box component 91
List Builder component 91
List Builder, sample visualization 98
List View component 91
Live Office 215

parameters 215
Xcelsius visualization data source 212

LiveOffice connector 132
LiveOffice Connector 212

making a refreshable visualization 212
passing parameters to Excel 215
updating web service setting 225

load selection, XML Data Button component
180

LoadPreview.xml 181
local scenario buttons component 116

using 120

M
Macromedia Flash, installation 232
map components 113

Alerts tab 335
Appearance tab 333
as display component 113
as selector components 113
Behavior tab 333
General tab 330
how they work 113
sample visualization 114

maximum rows 239

N
nested external files 131
non-embedded fonts 58
Numeric Format list 249

O
Object Browser 49

context menu 50
deleting components with 52
grouping components in 51
hiding components 51
renaming components in 53
selecting components in 50

OHLC chart 76
opening Properties panel 52
other components 116

Appearance tab 383
Behavior tab 377
General tab 370

Outlook, emailing visualizations with 138

P
panel set 116
parameters, from Crystal Xcelsius 2008 to Live

Office 215
pie chart 76
play button 109
Play Selector component 91
Position list 248
PowerPoint 136

exporting visualizations to 136
frequently asked questions 235

previewing visualizations 64, 71
progress bar 109
Properties panel 47

for multiple components 49
opening 52
tabs 47

publishing visualizations. See exporting
visualizations 139

R
radar chart 76
Radio Button component 91
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receive selection, XML Data Button component
177

rectangle component 129
refresh 222

manual 222
on interval 222
on load 221
on trigger behavior 222
SWF files inside Infoview 221
SWF files outside InfoView 223

renamed spreadsheets, re-importing 232, 234
renaming components, with Object Browser 53
Reporting Services 204

S
sample visualizations 101

accordion menu component 101
display status 150
drill down chart 84
Dynamic Visibility 148
filter component 97
grid component 123
list builder component 98
map component 114
sliding picture menu 102
status list 150
value component 111
viewing in Xcelsius 65
XML Data Button component 175

saved scenarios, location of 236
selecting data sources 70
selector components 91

Alerts tab 312
Appearance tab 303
Behavior tab 297

send data, XML Data Button component 181
send selection, XML Data Button component

176
SendPreview.xml 177
Server Busy message 236

Sharepoint 189, 191, 205
deploy Crystal Xcelsius 2008 visualizations

205
Sharepoint Param Component 189
Sharepoint Provider Component 191
Xcelsius Client 189

single value components 109
fixed 236

skins 60
slider component 109
Sliding Picture Menu component 91
Sliding Picture Menu, sample visualization 102
snapshots 144
Source Data component 91
spinner component 109
spreadsheets. See Excel files 70
SQL Server Reporting Services 204
stacked charts, types 76
starting visualizations, troubleshooting 237
status list, sample visualization 150
supported features

regional formats 240

T
Table component 91
templates 66

creating 157, 162
text components 116

Appearance tab 351
Behavior tab 348
General tab 346

Ticker component 91
Toggle Button component 91
tools 40

Components Explorer 40
Object Browser 49
Properties panel 47

transferring global styles 64
Transparency box 246
trend icon 116
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troubleshooting
Excel 236
fixed single value components 236
frequently asked questions 236
location of scenarios 236
slow run time 237
starting visualizations 237
upgrading Microsoft Office 232
URL button component 236
URL-based images 237

U
Unicode font options 58
unmanaged Crystal reports 211
unmanaged environment 211
updating data 72
URL link button 132

troubleshooting 236
URL-based images 237

V
value component 109

sample visualization 111
variable length ranges, ignore end blanks 152
vertical line component 129
visualizations

creating 70
examples 37
previewing 64
taking snapshots 144

visualizations (continued)
updating data for 72

W
web connectivity components 132

Appearance tab 365
Behavior tab 361
General tab 356

web service connector component 132
Weight box 246
what-if-presentation 37
Word, exporting visualizations to 138

X
X Shift box 248
XLF files

importing from Xcelsius 3.0/3.5 33
XML Data Button component 132, 170

configuring 176
load selection 180
receive selection 177
send data 181
send selection 176

XML maps 198
XY chart 76

Y
Y Shift box 249
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